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About this guide

) ‘ CAUTION! ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard types specified in
&~ procedures may be abbreviated in this document. For the complete safety information, see the
“Safety” appendix in this document.

IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix
in this document.

Each part in this guide provides instructions for performing experiments on the QuantStudio™ 12K Flex
Real-Time PCR System using OpenArray™ Plate formats. The following parts are provided in this guide.

* “QuantStudio™ 12K Flex OpenArray™ Gene Expression Starter Kit” on page 12 —Prepare samples,
prepare the sample plate, run and analyze a gene expression experiment.

¢ “QuantStudio™ 12K Flex OpenArray™ Genotyping Starter Kit” on page 88 —Prepare samples,
prepare the sample plate, run and analyze a genotyping experiment.

* “Custom miRNA OpenArray™ panels” on page 165—Prepare samples, prepare the sample plate,
run and analyze a microRNA experiment.

* Appendix A, “Ordering information”

* Appendix B, “Plate information”

* Appendix C, “PCR good laboratory practices”

* Appendix D, “Safety”

* Appendix E, “Documentation and support”
The instructions for gene expression experiments and genotyping experiments are specific to the starter
kits. We recommend that you use the starter kits to familiarize yourself with the QuantStudio™ 12K Flex
Real-Time PCR System. After performing the starter kit experiments, you can follow the instructions

in this guide to perform your own experiments. Tips for running your own experiments are provided at
various points in this guide.
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Chapter 1

Fﬁ’- -unﬁ

QuantStudio™ 12K Flex OpenArray™ Gene Expression Starter Kit

QuantStudio™ 12K Flex OpenArray™ Gene Expression

Starter Kit

The QuantStudio™ 12K Flex OpenArray™ Gene Expression Starter Kit contains materials that are
required to perform two experiments on the QuantStudio™ 12K Flex Real-Time PCR System, from
sample preparation to data analysis, unless otherwise shown in Table 1 on page 14. The materials
include TrueMark™ OpenArray™ Plate formats, reagents, and accessories. The components allow for a
typical setup for two gene expression experiments.

Table 1 Components of the QuantStudio™ 12K Flex OpenArray™ Gene Expression Starter Kit.

Flex OpenArray™
Accessories Starter
Kit

OpenArray™ Plugs (6 plugs)

OpenArray™ Carriers (1 or 2 carriers)
QuantStudio™ Immersion Fluid(6 syringes)
OpenArray™ Immersion Fluid Tip

OpenArray™ AccuFill™ System Tips (1 box
of 384 tips)

OpenArray™ 384-well Sample Plate (10
plates)

OpenArray™ 384-Well Plate Seals (10 seals)

Component Cat. No. Kit contents Description
QuantStudio™ 12K | 4469604 TagMan™ OpenArray™ Real-Time PCR Contains reagents to conduct
Flex OpenArray™ Master Mix, 2X, 1.5 mL two gene expression experiments
Gene EXpreSSiOﬂ TaqMan”" ()per]ArrayTM Human Endogenous on the QuantStudio™ 12K Flex
Starter Kit Control Panels (2 plates) Real-Time PCR System, using

Human cDNA controls (brain, liver, lung, the TagMan™ OpenArray™ Human
Endogenous Control Panels as an

and placenta)
example.

QuantStudio™ 12K Flex OpenArray™ o _

Accessories Starter Kit (Cat. No. 4469586) | 1his kit contains human cDNA
control samples.

QuantStudio™ 12K | 4469586 OpenArray™ Case Lid (6 lids) Contains accessories to

assemble TrueMark™ OpenArray™
Plate formats for a single
experiment starter kit. Each
experiment starter kit contains
this accessories starter kit.

This kit does not contain samples.

Plates

The instructions in this document use three types of plates. The plates are listed described in detail in
Appendix B, “Plate information”.

* MicroAmp™ Optical 96-Well Reaction Plate (96-well plate)
A non-optical 96-well reaction plate can also be used.

* OpenArray™ 384-well Sample Plate (384-well plate, for QuantStudio™ 12K Flex OpenArray™

AccuFill™ System)

* TrueMark™ OpenArray™ Plate (OpenArray™ Plate)

14

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide


https://www.thermofisher.com/order/catalog/product/4469604

Chapter 1 [958

N
File formats

File formats

The files are used to track your assays and samples. The QuantStudio™ 12K Flex Software (included
with the QuantStudio™ 12K Flex Real-Time PCR System) contains example files for each starter kit
experiment type.

The instructions in this guide use four types of files.

* Sample information file (CSV)—Contains the sample layout information for the plate. Allows input of
Sample IDs. See page 15.

* Transcript plate file (TPF)— Contains the information for gene expression runs. Allows input of
Assay IDs and thermal cycling protocol. See page 16.

* Template file (EDT)—Includes complete setup information (samples, assays, and cycling protocol)
saved as a template. See page 17.

* Experiment file or data file (EDS)—A complete data file. See page 18.

Additional files (AIF, TXT) are available for selection if you use the batch experiment setup in the
software to create and run your own experiments.

Sample information file (CSV)

We recommend that you create or use a comma-delimited file (CSV) to track your cDNA or gDNA
samples. Use a sample information file to perform these tasks.

* Track where samples and controls are located in the 96-well plate. See Chapter 2, “Prepare the
nucleic acid samples”.
* Map the sample locations, depending on the TrueMark™ OpenArray™ Plate format being used.
— Map the sample locations from the 96-well plate to the appropriate locations in the 384-well
plate. See Chapter 3, “Prepare the OpenArray™ 384-well Sample Plate”.
— Map the sample locations from the 384-well plate areas to the appropriate locations in each
TrueMark™ OpenArray™ Plate. See Chapter 4, “Prepare the TrueMark™ OpenArray™ Plate”.

* Associate information about the samples with the data results to normalize data or compute
standard curves and calculate concentrations.

IMPORTANT! To enable accurate results, you must correctly track sample information from plate to
plate.

For OpenArray™ AccuFill™ Software v2.0, all sample tracking and mapping features are available in this
software. The OpenArray™ Sample Tracker Software is not used for OpenArray™ AccuFill™ Software
v2.0.

* OpenArray™ 384-well Sample Plate —Integrate this file with a plate setup file in the OpenArray™
AccuFill™ Software. See “Prepare the plate setup files” on page 36.

* TrueMark™ OpenArray™ Plate—Import this file directly into the QuantStudio™ 12K Flex Software
before starting a run (see “Start a run from the software” on page 51), or after the run is complete.

Note: To track sample information for the starter kit experiments, use the example CSV files supplied
with the QuantStudio™ 12K Flex Software.

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 15
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Plate setup file (TPF)
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Use an OpenArray™ Plate setup file
Plate setup files (TPF) contain the assay information for individual OpenArray™ Plate formats, including
the gene symbol, gene name, assay ID, and location of each assay on the plate.

* Use the OpenArray™ AccuFill™ Software to integrate the sample information from a 384-well plate
file (CSV) with the assay information in the plate setup file. See “Prepare the plate setup files” on
page 36).

* Upload the assay information in the plate setup file directly into the QuantStudio™ 12K Flex
Software to create and run an experiment (EDS file). See “Start a run from the software” on
page 51).

Access the starter kit plate setup files
1. Go to thermofisher.com/OA-platefiles.
2. In the Select your product dropdown list, select TagMan OpenArray Inventoried.
3. Enter the serial numbers, then click Download.

Download your own plate setup files

To process a TrueMark™ OpenArray™ Plate on the QuantStudio™ 12K Flex Real-Time PCR System,
you must download the specific plate files that correspond to your plate and experiment type. Gene
expression experiments use transcript plate files (TPF).

Note:

. The OpenArray™ AccuFill™ Software v2.0 includes a feature to download the TPF files. The computer
running the software must be connected to the internet.

. The OpenArray™ AccuFill™ Software v2.0 includes a feature to create a TPF file from a template.

. For more information about these features, see QuantStudio™ 12K Flex OpenArray™ AccuFill™ System
User Guide (Pub. No. MAN0025669).

1. Go to thermofisher.com/OA-platefiles.

2. Select one of the following options.

e Custom

* |nventoried

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide


http://www.thermofisher.com/OA-platefiles
http://www.thermofisher.com/OA-platefiles

Chapter 1 [#%%

File formats

3. Enter the following information.

Product Information

Custom a. Enter the Lot number or Batch number.

b. Enter one Serial number from the lot.

Only one serial number is required. The serial number is used to confirm the lot
number or batch number. All of the files in the lot or batch are downloaded.

Inventoried | Enter the list of Serial numbers or Barcodes. Separate more than one serial number or
barcode with a comma or a line break.

The serial number or barcode entered corresponds to the file that is downloaded. Enter a
serial number or barcode for each file to download.

4. (Custom gene expression plates only) Select a target name option.

* With microbial target names
* Without microbial target names

The microbial target name selection is not displayed if inventoried products are selected.
5. Click Download.

The downloaded files are in a compressed ZIP folder.

Template file (EDT)

An experiment document template file (EDT) contains predefined experiment setup information, such as
experiment type, assay names, and run method.

You can access a template to create a new experiment from the two locations.

* QuantStudio™ 12K Flex Instrument touchscreen. See “Start a run from the instrument touchscreen”
on page 55.

* QuantStudio™ 12K Flex Software. See “Start a run from the software” on page 51.
To create and run the starter kit experiments, use the example template files supplied with the
QuantStudio™ 12K Flex Software.
The example template files are at <..>:\Program Files (x86)\Applied
Biosystems\QuantStudio 12K Flex Software\templates\OpenArray, wWhere <..>is the
installation drive. The default installation drive is C: if the software is installed by the customer. The
default installation drive is D: if the software is installed by a Thermo Fisher Scientific field service
engineer.
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Experiment file (EDS)

An experiment document single file (EDS) is an electronic record used by the QuantStudio™ 12K Flex
Software that contains information about a particular TrueMark™ OpenArray™ Plate that was run on the
QuantStudio™ 12K Flex Instrument. The EDS file includes the following information.

* Metadata
- Name
— Barcode
— Comments
* Experiment setup
— Well contents
— Assay definitions
* Run method (thermal cycling protocol)
* Run results
* Analysis protocol
* Analysis results
¢ Audit records
® Other plate-specific data

Use an EDS file to perform these tasks.

* Create and run an experiment using the QuantStudio™ 12K Flex Software (see “Start a run from the
software” on page 51).
To create and run the starter kit experiments, use the example template files (EDT, see “Template
file (EDT)” on page 17) supplied with the software.

¢ Create and run an experiment using the QuantStudio™ 12K Flex Instrument touchscreen (see “Start
a run from the instrument touchscreen” on page 55).

* Analyze the experiment results in the QuantStudio™ 12K Flex Software (see Chapter 6, “Analyze the
experiment results”).
To view and analyze results for the starter kit experiments, use the example experiment files
supplied with the QuantStudio™ 12K Flex Software.
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Starter kit data files

Use the example files supplied with the QuantStudio™ 12K Flex Software to perform the tasks that are
described in this guide.

Table 2 QuantStudio™ 12K Flex OpenArray™ Gene Expression Starter Kit data files referenced in this guide

i Description File name Locationl'] Used in
type

TPF | Transcript — Download (see “Access the starter kit plate Chapter 3,
plate file setup files” on page 16) “Prepare the

OpenArray™ 384-
well Sample
Plate”

CSV | 96-well - These files can be generated in the OpenArray™ | Chapter 3,
sample AccuFill™ Software v2.0. “Prepare the
information file OpenArray™ 384-

well Sample
Plate”

EDT | Experiment TagMan Gene <.>:\Program Files (x86)\Applied Chapter 5,

template Expression.edt Biosystems\QuantStudio 12K Flex “Perform the
Software\templates\OpenArray instrument run”

EDS |Experiment Gene Expression |<.>:\Program Files (x86) \Applied Chapter 6,

data file Starter Kit Biosystems\QuantStudio 12K Flex “Analyze the
Example.eds Software\examples\Gene Expression |experiment
results”

U]

installation drive is D : if the software is installed by a Thermo Fisher Scientific field service engineer.
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Workflow

QuantStudio™ 12K Flex OpenArray™ Gene Expression Starter Kit

Prepare the nucleic acid samples (page 21)

The workflow for sample preparation varies, depending on starting from the MicroAmp™ Optical
96-Well Reaction Plate using cDNA or your own DNA.

Prepare the OpenArray™ 384-well Sample Plate (page 28)

Track the samples, prepare the PCR mix, and transfer the samples to the OpenArray™ 384-well
Sample Plate.

Prepare the TrueMark™ OpenArray™ Plate (page 33)

Prepare for sample transfer using 384-well plates.

Transfer the samples from 384-well plates to OpenArray™ plates using OpenArray™ AccuFill™
Software.

Seal the OpenArray™ plates.
Complete sample transfer for the remaining OpenArray™ plates.

Perform the instrument run (page 47)

Prepare the QuantStudio™ 12K Flex Software.

Load the OpenArray™ plates into the instrument.

Perform the instrument run.

(Optional) Monitor the experiment run.

Unload the OpenArray™ plates from the instrument.
(Optional) Transfer the experiment results to the computer.

Analyze the experiment results (page 63)

20
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In this chapter, you prepare the nucleic acid samples for your QuantStudio™ 12K Flex OpenArray™ Gene
Expression Starter Kit experiment.

Perform the starter kit experiment

When you perform the gene expression starter kit experiment, use the human cDNA control samples
(brain, liver, lung, and placenta) provided in the QuantStudio™ 12K Flex OpenArray™ Gene Expression
Starter Kit (see Table 1 on page 14).

Workflow

Prepare nucleic acid samples for starter kit experiment

Obtain human cDNA control samples from the starter kit (see
Required materials (page 21))

(Optional) Transfer the cDNA samples to a 96-well reaction plate
(page 22)

Required materials

IMPORTANT! For the SDS of any chemical not distributed by Thermo Fisher Scientific, contact the
chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer,
and observe all relevant precautions.
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Perform the starter kit experiment

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

Item Cat. No.
Starting material: Human cDNA control samples (brain, liver, lung, and placenta) from the | Included in the kit
starter kit
MicroAmp™ Optical 96-Well Reaction Plate 4316813

(Optional) Transfer the cDNA samples to a 96-well reaction plate

To load cDNA samples and controls into a TrueMark™ OpenArray™ Plate, pipet the samples into a
96-well reaction plate.

Enter sample information for the 96-well reaction plate directly into the OpenArray™ AccuFill™ Software
v2.0. See “Track the samples” on page 29.

Use the following cDNA samples and controls.

1 2 3 4 5 6

NTC HB HLiv HLun HP NTC

* HB = Human Brain

® HLiv =Human Liver

* HLun = Human Lung

¢ HP = Human Placenta

®* NTC = No Template Control

1. Prepare the PCR reaction mix with each of the four cDNA samples in strip cap tubes or in one row
of a MicroAmp™ Optical 96-Well Reaction Plate.

There is 10 pL per sample of excess volume.

R Volume per subarray per | Number of subarrays Total volume
sample per sample
TagMan™ OpenArray™ Real-Time 2.5 L 8 25.0 uL
PCR Master Mix (2X)
Water 1.3 L 8 13.0 L
cDNA 1.2 L 8 12.0 L
Total volume 5.0 yL - 50.0 yL
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Perform your own experiments with cDNA

2. Prepare the PCR reaction mix with two no template controls (NTCs) in strip cap tubes or in one row
of a MicroAmp™ Optical 96-Well Reaction Plate.

Component Volume per subarray per | Number of subarrays Total volume
sample per sample
TagMan™ OpenArray™ Real-Time 2.5l 8 25.0 uL
PCR Master Mix (2X)
Water 2.5uL 8 25.0 uL
Total volume 5.0 uL — 50.0 uL

Proceed to Chapter 3, “Prepare the OpenArray™ 384-well Sample Plate”.

Perform your own experiments with cDNA

When you prepare cDNA samples for your own gene expression experiments, note the items described
in the following sections.

Workflow

Prepare nucleic acid samples for cDNA experiment

- Prepare cDNA samples (see Reverse transcribe the RNA (page 25))

(Optional) Transfer the cDNA samples to a 96-well reaction plate
(page 26)

Required materials

IMPORTANT! For the SDS of any chemical not distributed by Thermo Fisher Scientific, contact the
chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer,
and observe all relevant precautions.
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Chapter 2
Perform your own experiments with cDNA

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

Item Source

Starting material: Total RNA User-supplied
One of the following kits: * 4368813
* (Recommended) High-Capacity cDNA Reverse Transcription Kit * 4374967

¢ High-Capacity cDNA Reverse Transcription Kit with RNase Inhibitor

RNase-free water MLS
Incubator or thermal cycler MLS
MicroAmp™ Optical 96-Well Reaction Plate 4316813
MicroAmp™ Clear Adhesive Film 4306311
RNA quantity

The recommended quantity of starting material (total RNA, for preparing cDNA) is 10 yL at a
concentration of 200 ng/pL (2 pg total). To prepare cDNA from RNA, see “Reverse transcribe the RNA”
on page 25.

Guidelines for RNA quality

RNA that is used for gene expression experiments should have these characteristics.
* |s extracted from the raw material of interest using an optimized protocol.
* Does not contain PCR inhibitors.
® Has an Ayggo3g ratio between 2.0 and 2.4.
* Has an Aogg/ogp ratio between 1.8 and 2.1.
* Has an RNA Integrity Number (RIN) that is between 6.5 and 10.
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Perform your own experiments with cDNA

For other reverse transcription kits, see the documentation for the kit.

1. Thaw the reverse transcription kit components and the total RNA on ice.

2. Combine the following components to prepare a 2X reverse transcription mix.

Volume for Stock Final .
Component . . concentration
1 reaction concentration :
(2X mix)
High-Capacity cDNA 10X RT Buffer 2.0pL 10X 2X
Eﬁverse Transcription 10X RT Random 2.0 L 10X 2X
Primers
25X dNTP Mix 1.0 L 25X 2X
MultiScribe™ Reverse 1.0pL 50 U/pL 5 U/pL
Transcriptase,
50 U/uL
RNase-free water 4.0 uyL — —
Total volume of 2X reverse transcription mix 10.0 uL — —

3. Transfer 10 pL of reverse transcription mix to each well of the MicroAmp™ Optical 96-Well Reaction

Plate.

4. Add 10 pL of total RNA to each well of the MicroAmp™ Optical 96-Well Reaction Plate.
The total volume per reaction is 20 pL.

5. Seal the plate with MicroAmp™ Clear Adhesive Film, then incubate at room temperature for

10 minutes.

6. Incubate at 37°C for 2 hours.

7. Place on ice for 5 minutes, then centrifuge briefly.

8. Incubate at 75°C for 10 minutes.

9. Place on ice for 5 minutes, then centrifuge briefly.

cDNA can be stored at —20°C for up to 2 months.

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide
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(Optional) Transfer the cDNA samples to a 96-well reaction plate

* Transfer 2.0 pL of the prepared cDNA into the appropriate number of wells of a MicroAmp™ Optical
96-Well Reaction Plate, depending on the TrueMark™ OpenArray™ Plate format being used.

* (Recommended) Create a sample information file (CSV) to track where the samples are in the
96-well sample plate. For OpenArray™ AccuFill™ Software v2.0, samples are mapped in the
OpenArray™ AccuFill™ Software. See QuantStudio™ 12K Flex OpenArray™ AccufFill™ System User
Guide (Pub. No. MAN0025669).

* Proceed to Chapter 3, “Prepare the OpenArray™ 384-well Sample Plate”.

Perform your own experiments with DNA

When you prepare DNA samples (genomic or plasmid) for your own real-time PCR experiments, note
items described in the following sections.

Workflow

Prepare nucleic acid samples for a DNA experiment

- Prepare DNA samples (see Required materials (page 26))

Transfer the DNA samples to a 96-well reaction plate (page 27))

Required materials

IMPORTANT! For the SDS of any chemical not distributed by Thermo Fisher Scientific, contact the
chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer,
and observe all relevant precautions.

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

ltem Source
Starting material: gDNA or plasmid DNA User-supplied
MicroAmp™ Optical 96-Well Reaction Plate 4316813
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DNA quality

DNA that is used for real-time PCR experiments should have the following characteristics.

* |s extracted from the raw material that you are testing with an optimized protocol; salting out
procedures and crude lysates are not recommended.

* Does not contain PCR inhibitors.

* Has an Aygg a0 ratio between 1.7 and 1.9.

* Has an Ayggogp ratio between 1.7 and 1.9.

* |sintact as visualized by gel electrophoresis.

* Has no nucleases present; is stabilized for storage.
* Has good gel image.

DNA quantity

We recommend that you quantify the amount of gDNA in the samples.

* The recommended quantity of starting material (cDNA, gDNA or plasmid DNA) is 10 pL at a
concentration of approximately 100 ng/pL.

* For accurate results, it is important to normalize all DNA samples in an experiment so that each
through-hole receives the same input quantity of sample.

Transfer the DNA samples to a 96-well reaction plate

¢ Transfer 5.0 pL of the DNA samples into the appropriate number of wells of a MicroAmp™ Optical
96-Well Reaction Plate, depending on the TrueMark™ OpenArray™ Plate format being used.

See Appendix B, “Plate information”.

* (Recommended) Create a sample information file (CSV) to track where the samples are in the
96-well sample plate. For OpenArray™ AccuFill™ Software v2.0, samples are mapped in the
OpenArray™ AccuFill™ Software. See QuantStudio™ 12K Flex OpenArray™ AccufFill™ System User
Guide (Pub. No. MAN0025669).

* Proceed to Chapter 3, “Prepare the OpenArray™ 384-well Sample Plate”.
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In this chapter, you use an 8- or 12—channel pipette to transfer the nucleic acid samples from the
96-well reaction plates to the OpenArray™ 384-well Sample Plate. The plates are described in detail in
Appendix B, “Plate information”.

You track the sample locations from the 96-well reaction plates to the appropriate locations in the
OpenArray™ 384-well Sample Plate. The workflow for preparing the OpenArray™ 384-well Sample Plate
varies, depending on the starter kit or the experiment type in use.

Workflow

Prepare the OpenArray™ 384-well Sample Plate

- Track the samples (page 29)

- Prepare the PCR Reaction Mix (page 31)

Transfer the samples to the OpenArray™ 384-well Sample Plate and
add the PCR mix (page 31)
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Required materials

Required materials

IMPORTANT! For the SDS of any chemical not distributed by Thermo Fisher Scientific, contact the
chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer,
and observe all relevant precautions.

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

ltem Source
96-well reaction plates, containing prepared cDNA samples User-supplied
TagMan™ OpenArray™ Real-Time PCR Master Mix (2X), 1.5 mL 4462159M1]
OpenArray™ 384-well Sample Plates 440694711
OpenArray™ 384-Well Plate Seals 44698761
RT-PCR Grade Water AM9935[?]
Fine-tip marker MLS

' Provided in the starter kit.
@' Not provided in the starter kit.

Track the samples

Track the samples from the 96-well reaction plates to the 384-well sample plates. For OpenArray™
AccuFill™ Software v2.0, samples are tracked in the OpenArray™ AccuFill™ Software. The samples are
tracked in the Map Plates tab.

For more information about OpenArray™ AccuFill™ Software v2.0, see QuantStudio™ 12K Flex
OpenArray™ AccuFill™ System User Guide (Pub. No. MAN0025669).

Navigate to the Full Run screen.

1. In the Configure design pane, in the Experiment type section, select Gene expression.

2. In the Plate format section, select a format for your experiment.

Experiment type Format
Starter kit experiments Gene Expression—56
Your own experiments * Gene Expression—18

* Gene Expression—56
* Gene Expression—112
* Gene Expression—168

* Gene Expression—224
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Track the samples

3. In the Pipettor section, select a type of pipette.
* Fixed
¢ Adjustable

The number of OpenArray™ Plate formats displayed in the Add your OpenArray plate serial
numbers section depends on the selections made in the previous steps.

4. Inthe Add your OpenArray Plate serial numbers section, click Choose File, navigate to the
location of the TPF file, then select the file.

Repeat for each TPF file.

5. In the Add your sample plates - optional section, click Choose File, navigate to the location of
the CSV file, then select the file.

If the sample plate file is not imported, the samples must be added manually.
The file must be a CSV file for a 96-well format.

The format of the sample plate file is validated. For information about the required format, see
QuantStudio™ 12K Flex OpenArray™ AccufFill™ System User Guide (Pub. No. MAN0025669).

The name of the file is displayed in the Select file field.
6. Repeat step 5 for each CSV file.

7. Click Next.
The Map plates pane is displayed.

8. (Optional) Add or edit the sample name.

9. Label the OpenArray™ 384-well Sample Plate with a fine-tip marker.

Based on the tracking information on the Map plates pane, mark the sections of the OpenArray™
384-well Sample Plate to transfer samples from the 96-well reaction plates.

10. Click Next.

The Start run pane is displayed.

Set up the samples in the OpenArray™ 384-well Sample Plate, then prepare to load the OpenArray™
Plate formats in the QuantStudio™ 12K Flex OpenArray™ AccuFill™ System.
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Prepare the PCR Reaction Mix

Prepare the PCR Reaction Mix

1. Gently invert the tube of TagMan™ OpenArray™ Real-Time PCR Master Mix several times.

2. Combine the following components to prepare the PCR Reaction Mix.

Volume for 1 area of the 384-well sample
Component 1
platel'l
TagMan™ OpenArray™ Real-Time PCR Master Mix 132.0 L
@X)
RT-PCR Grade Water 68.6 pL
Total volume of PCR Reaction Mix 200.6 pL

[l One area of a 384-well sample plate corresponds to a single OpenArray™ Plate. See Appendix B, “Plate information”.

3. Mix well by pipetting up and down.

Transfer the samples to the OpenArray™ 384-well Sample
Plate and add the PCR mix

Thaw the cDNA samples at room temperature.

1. Vortex the cDNA samples to mix, then centrifuge for 1 minute at 1,000 x g to collect the contents at
the bottom of the tube.

2. Review the concentration of the normalized samples. The recommended starting concentration for
human cDNA, gDNA, and plasmid DNA samples is approximately 100 ng/uL.

Note: For optimal results, normalize all cDNA, gDNA, and plasmid DNA samples in an experiment.
For example, if you use 200 ng/pL total RNA starting material and assume 100% efficiency in the
reverse transcription reaction, you should obtain a human cDNA concentration of approximately
100 ng/pL equivalent to the total RNA.

3. Load the OpenArray™ 384-well Sample Plate based on the plate layout.
See “Track the samples” on page 29.

a. Add 5 pL of each PCR sample to the 384-well sample plate (see “Prepare the PCR Reaction
Mix” on page 31).
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Transfer the samples to the OpenArray™ 384-well Sample Plate and add the PCR mix

b. Using 6 tips from an 8- or 12-channel pipette, transfer the normalized cDNA, gDNA, or
plasmid DNA samples from the 96-well reaction plate to the OpenArray™ 384-well Sample

Plate.
L ANNESS

o0 |w|(>
z|z|z|z
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z|z|z|z
EIGIGIG!
z|z|z|z
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z|z|z|z
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Volume per 384-well sample plate welll]
Component Format 56 (starter kit Format 18 (in triplicate) and
experiment) remaining formats

Prepared PCR mix 3.8 uL 3.8 uL
Normalized human cDNA, 1.2 L 1.2 L

gDNA, or plasmid DNA

samples

Total volume 5.0 yL 5.0 L

[ One well of a 384-well sample plate corresponds to one subarray of an TrueMark™ OpenArray™ Plate. The number
of subarrays required depends on the format of the TrueMark™ OpenArray™ Plate. For detailed information about the

TrueMark™ OpenArray™ Plate, see Appendix B, “Plate information”.

4. Seal the sample plate, vortex gently to mix, then centrifuge for 1 minute at 2,000 x g to eliminate

bubbles and to collect the contents at the bottom of the wells.
5. Place the sample plate on ice for up to 1 hour.

Proceed to Chapter 4, “Prepare the TrueMark™ OpenArray™ Plate”.
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In this chapter, you use the QuantStudio™ 12K Flex OpenArray™ AccuFill™ System to transfer the
nucleic acid samples from the OpenArray™ 384-well Sample Plate to the OpenArray™ Plate formats. The
workflow is the same for all OpenArray™ Plate formats.

Workflow

Prepare the TrueMark™ OpenArray™ Plate

- Prepare for sample transfer (page 35)

. Transfer the samples (page 37)

Seal the TrueMark™ OpenArray™ Plate (page 43)

Required materials

IMPORTANT! For the SDS of any chemical not distributed by Thermo Fisher Scientific, contact the
chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer,
and observe all relevant precautions.
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Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

ltem Source
TrueMark™ OpenArray™ Plate See Appendix A, “Ordering
information”.
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System 4471021
QuantStudio™ 12K Flex OpenArray™ Accessories Starter Kit 4469586

The accessories kit contains the following components:
* OpenArray™ Case Lid (6 lids)
* OpenArray™ Plugs (6 plugs)
* OpenArray™ Carriers (2 carriers)
* OpenArray™ Immersion Fluid (6 syringes)
* OpenArray™ Immersion Fluid Tip
* OpenArray™ AccuFill™ System Tips (1 box of 384 tips)
* OpenArray™ 384-well Sample Plate (10 plates)
* OpenArray™ 384-Well Plate Seals (10 seals)

QuantStudio™ 12K Flex OpenArray™ Plate Press 2.0 A24945
Foil seals MLS
Bleach (10%) MLS
Ethanol MLS
Fine-tip marker MLS
Razor blade MLS
Powder-free gloves MLS
Laboratory-grade wipes MLS
Safety glasses MLS
Tweezers or forceps (for removing foil sections from the 384-well sample plate) MLS
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Prepare for sample transfer

Storage conditions

ltem Condition Storage

OpenArray™ Plate Frozen, unopened | Store at —20°C until the expiration date provided on the
product label.

Thawed, unopened | Store at room temperature for up to 24 hours.

Thawed, opened | Store at room temperature for up to 1 hour.

Loaded and sealed, | Store at room temperature, protected from light, for up
pre-run to 1 hour.

OpenArray™ Immersion Fluid Unopened Store at room temperature until the expiration date
provided on the product label.

Opened Store at room temperature. Do not store any remaining
immersion fluid. Use the amount required, then discard
the remainder.

OpenArray™ AccuFill™ Unopened Store at room temperature until the expiration date
System Tips printed on the cardboard box.
Opened Store at room temperature. Use tips within one week.

Prepare for sample transfer

Guidelines for handling the OpenArray™ Plate

IMPORTANT! Wear powder-free gloves while preparing the OpenArray™ Plate.

¢ Hold the OpenArray™ Case by the edges.

¢ Do not touch the through-holes of the OpenArray™ Plate.

* Load and seal an OpenArray™ Plate within one hour after opening the package.

* |f you drop a loaded OpenArray™ Plate, discard it in the appropriate waste container.
¢ Do not reinsert an OpenArray™ Plate if it becomes dislodged from the case.

Prepare the equipment and plates

Ensure that the OpenArray™ 384-well Sample Plate, the OpenArray™ AccuFill™ System Tips, and
OpenArray™ Plate holder are completely clean and dry.

1. Remove an OpenArray™ Plate from the freezer, but do not open the packaging. Allow the plate to
thaw at room temperature (approximately 15 minutes).

2. Prepare a syringe containing OpenArray™ Immersion Fluid.
a. Remove the cap from the syringe containing OpenArray™ Immersion Fluid.
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b. Remove the cap and attach the tip to the syringe. Place the assembly on a clean surface.

@ OpenArray™ Immersion Fluid
@ Cap (remove)
@ Syringe tip (attach)

3. Score or cut the foil seal of the OpenArray™ 384-well Sample Plate into the 8 sections shown
below, then place the plate on ice to keep the samples cold.
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Prepare the plate setup files

* OpenArray™ AccuFill™ Software v2.0 allows the transfer of samples without a sample plate file. The
QuantStudio™ 12K Flex Instrument requires a sample plate file if the real-time PCR run is started
with a TPF file or an EDT file.

* For your own gene expression experiments, the following plate setup files can be used to transfer
samples with the OpenArray™ AccuFill™ Software

— OpenArray™ 384-well sample information file (CSV, see “Track the samples” on page 29)
— OpenArray™ plate setup file (TPF, see “Use an OpenArray™ Plate setup file” on page 16)

* (Optional) If you created a CSV file in the OpenArray™ AccuFill™ Software (see “Track the samples”
on page 29), you can import the sample information in this file directly into the QuantStudio™ 12K
Flex Software before starting the run, or after the run is complete.
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Transfer the samples

Transfer the samples

Start the system

Note: If the samples were tracked immediately before this section, the system might be on (see “Track
the samples” on page 29). The sample tracking and sample transfer functions are both done with
OpenArray™ AccuFill™ Software if OpenArray™ AccuFill™ Software v2.0 is used.

IMPORTANT! To safely operate the instrument, keep the deck clear and have enough room in the
waste bin to eject the used pipette tips. See “Set up the system” on page 37.

The instrument does not initiate a self-test immediately after starting the software. A self-test is initiated
the first time that one of the following items is clicked after starting the software:

¢ Full Run
* Quick Run
* Service » Diagnostics

The other features in the software can be accessed after starting the software without a self-test.
1. Ensure that the instrument door is closed.
2. Power on the instrument, if it is off.

3. Start the OpenArray™ AccuFill™ Software (|
The software checks the computer and connections as the system starts.

Proceed to set up the system (see “Set up the system” on page 37).

Set up the system

IMPORTANT! To safely operate the instrument, keep the deck clear and have enough room in the
waste bin to eject the used pipette tips.

1. Open the instrument door, empty the waste bin, then place the waste bin back on the instrument
deck.

CAUTION! Wear appropriate personal protective equipment while handling the waste bin.

2. Ensure that the sample plate holder and the OpenArray™ Plate holders are empty.

3. Place the sample plate in the sample plate holder on the instrument deck, with the notch to the
left. Do not stack sample plates.

4. Place each OpenArray™ Plate in an OpenArray™ Plate holder.
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5. Replace the tip boxes, if necessary.
Each tip box contains 384 tips, divided into 8 sections.

When setting up a run, the status of the tip boxes is confirmed in the software. A full tip box is
recommended when starting a run.

6. Remove the cover from each tip box.
Ensure that the tip box covers are removed from the instrument deck.

IMPORTANT!
. Do not reuse tips.

. Use tips within one week of opening the box.
. Discard any unused tips within one week.

7. Close the instrument door.

The system is ready to start a run. A self-test is initiated the first time that one of the following items is
clicked after starting the software:

¢ Full Run
¢ Quick Run
* Service » Diagnostics

Verify the run setup and start the run

1. Click each tip box section so that the status on the Verify and start run pane matches the
physical tip box in the instrument.
We recommend starting the run with full tip boxes. The instrument does not start the run if there
are not enough tips on the deck.

Update the state of the tip boxes
(1) Section of the tip box that is full.

@ Section of the tip box that is empty.

2. (Optional) Click Auto-fill tip boxes.
The status of all sections of the tips boxes is set to full.

3. Select the first section of the sample plate to be used to fill the OpenArray™ Plate.

Select the first section of the sample plate if multiple plates are filled during a run. The software
selects the total number of sections that correspond with the total number of plates.

In the following example, section 5 was selected. The group of sections 5, 6, 7, and 8 is highlighted
by the software because four plates are being filled.
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The position box displays the color that corresponds to the section of the sample plate.

Select the sample platelarea to begin

1

Oianrray plate name and position

EEEEEEEEEEEN FrB75

3 asmsssssmsss sessssssssss 4
ENEEEEEEEEEE EEEEEEEEEN FrB76
FTB77

@ Sample plate section (section 5, 6, 7, and 8 are highlighted).
(2 Corresponding plates.

4. Remove the foil from the appropriate sections of the sample plate, then click the checkbox to
confirm.

Remove the foil only from the sections of the sample plate that are used to load a single
OpenArray™ Plate.

Note: Do not remove the foil from all the sections of the sample plate at once.

5. Close the instrument door.

6. Click Start Run.
The run does not begin under any of these conditions.
* The waste bin is not in position.
* The sample plate is not in position.
* The plates are not in position.

* There are more plates on the instrument deck than are defined in the experiment setup.

The Deck screen is displayed.

For a description of the run progress, see QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User
Guide (Pub. No. MAN0025669).

IMPORTANT! Each OpenArray™ Plate must be prepared for PCR immediately after it is filled (see “Seal
the TrueMark™ OpenArray™ Plate” on page 43).
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Remove the OpenArray™ Plate from the OpenArray™ AccuFill™ Instrument

After an OpenArray™ Plate is filled, the Remove plate and foil dialog box is displayed (see Figure 1).

Remove plate & foil X
Step 1 Step 2
Remove OpenArray Plate 1 and promptly seal the plate Confirm foil is removed from highlighted plate

with the adhesive lid, and fill with immersion fluid.

(-]
E
3

I
N
sy}
~
2]

—
—

Figure 1 Remove plate and foil dialog box.

@ OpenArray™ Plate to remove from the instrument.
@ Confirm foil is removed from highlighted plate section checkbox.

Remove each OpenArray™ Plate immediately after it has been filled, even if the run was set up to fill
multiple plates.

After the last OpenArray™ Plate in the run is filled, the Remove plate dialog box is displayed (see
Figure 2).
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Remove plate X

Remove OpenArray Plate 2 and promptly seal the plate with
the adhesive lid, and fill with immersion fluid.

Figure 2 Remove plate dialog box

@ OpenArray™ Plate to remove from the instrument

1. Open the instrument door and remove the OpenArray™ Plate that is indicated by the blue box in
the dialog box.

IMPORTANT! Remove the OpenArray™ Plate immediately, to avoid evaporation within the plate.

One of the following dialog boxes is displayed:
* The Remove plate and foil dialog box.
* The Remove plate dialog box (after the last OpenArray™ Plate is filled).

2. Seal the case and fill the OpenArray™ Plate with immersion fluid.

3. (For Remove plate and foil dialog box only) Remove the foil seal from the next section of the
sample plate, then select the checkbox to confirm that the foil is removed from the section of the
plate that is highlighted.

Note: Remove the foil only from the next section of the sample plate. Do not remove the foil from
all sections of the sample plate.

4. Close the instrument door.
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5. Click Done.
The run does not proceed under any of the following conditions:
* The waste bin is not in position
* The sample plate is not in position
* The plates are not in position

* There are more plates on the instrument deck than are defined in the experiment setup
The instrument proceeds to load the next OpenArray™ Plate.
6. Repeat step 1 to step 5 for each OpenArray™ Plate to be loaded.
After all of the plates have been loaded, the Deck screen displays Run completed successfully.
Empty the waste bin before performing another run.

A loaded TPF is generated for each OpenArray™ Plate. The loaded TPF file corresponds to the original
TPF file that was imported for the run. The files are exported to the folder that was designed in the
Preferences.

Note: Some workflows might not generate a loaded TPF file. For more information about the workflows
available for the OpenArray™ AccuFill™ Software v2.0, see QuantStudio™ 12K Flex OpenArray™
AccufFill™ System User Guide (Pub. No. MAN0025669).
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Seal the TrueMark™ OpenArray™ Plate

IMPORTANT! Throughout this procedure, handle the OpenArray™ Plate and the OpenArray™ Case only
by the edges.

Note: The OpenArray™ Case consists of the sealed OpenArray™ Plate and the OpenArray™ Lid.

1.

Place the newly loaded OpenArray™ Plate in the QuantStudio™ 12K Flex OpenArray™ Plate Press
2.0.

Ensure that the barcode is facing left and the serial number is facing right.

From the OpenArray™ Lid, remove the clear protective film from the inside of the lid (D and the red
adhesive-protective strip ) from around the edge of the lid.

Figure 3 OpenArray™ Lid

@ Protective film on inside of the lid (remove before sealing)

@ Red adhesive-protective strip (remove before sealing)

@ Protective film on the outside of the lid (remove before running)
@ Notched end (align with serial number on plate)

Place the lid in the Plate Press using the alignment pins of the Plate Press for orientation.

IMPORTANT! The notched end of the case lid must be oriented towards the furthest back
right-side of the Plate Press.

@ OpenArray™ case lid
(® Notched end of lid
(3 Serial number of plate
@ OpenArray™ Plate

@ Barcode of plate

@ Alignment pins
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Seal the TrueMark™ OpenArray™ Plate

. Seat the lid on the OpenArray™ Plate with the lid adhesive against the plate.

. Engage the press mechanism until the green flashing light changes to a steady green light (after

20 seconds).
The status light turns solid green, indicating that the case is sealed.

Note: Do not apply additional pressure onto the Plate Press during its actuation.

- Disengage the press and carefully remove the OpenArray™ Case.

. Prepare the immersion fluid. Remove the cap, insert the accompanying syringe tip, and prime the

syringe by ejecting a small amount of immersion fluid onto a paper towel to ensure no air gap
remains in the newly attached pipette tip.

IMPORTANT! If the syringe is not primed, the direct burst of air and fluid can negatively affect the
assay(s) at the end of the array.

- While holding the case upright by its edges at a 15-30 degree angle so that the port is at the
highest point of the array, insert the prepared syringe tip into the port in the case.
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9. Slowly inject the OpenArray™ Immersion Fluid until the case is filled, which should take about 10
seconds to fill. Minimize the creation of additional air bubbles when you dispense the fluid. Leave a
small air bubble as shown below.

IMPORTANT! If injected too quickly, the fluid can flush out the samples that are suspended in the
through-holes.

Overfilling the array and/or not leaving a small bubble may cause a leak during the PCR run.

10. While holding the case vertically, remove the syringe tip, insert the screw end of the OpenArray™
plug into the port of the case, then rotate clockwise until the black handle breaks off.

Note: Ensure that you are screwing the plug in at the same angle the case base is at. If it is off, it
can cause the plug to break off prematurely.

IMPORTANT! To avoid leaking of immersion fluid, hold the case vertically and rotate the plug
slowly to avoid cross-threading.

If the plug handle breaks off prematurely, use a Phillips #0 screwdriver to complete this step. Do
not overtighten. If plastic or adhesive remains attached to the screw due to premature breakout of
the plug handle, remove it with forceps prior to loading it into the instrument.

11. If needed, clean the case with the lint-free cloth included with the OpenArray™ Plate or a laboratory
wipe that has been thoroughly sprayed with ethanol, then dry the case with a clean laboratory
wipe.

The plate is ready for PCR.
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For optimal efficiency during and after loading large numbers (more than 6) of OpenArray™ Plates, follow
these guidelines.

To help avoid mistakes when entering sample information in the OpenArray™ AccuFill™ Software,
load the OpenArray™ Plates in alphanumeric order (according to the OpenArray™ Plate serial
number).

Seal each OpenArray™ Plate immediately after loading is completed, while the other OpenArray™
Plates are loaded.

IMPORTANT! To avoid evaporation, seal the OpenArray™ Plate with the QuantStudio™ 12K Flex
OpenArray™ Plate Press 2.0, add the OpenArray™ Immersion Fluid, plug the case, then place the
case in a vertical position.

Use the OpenArray™ Carriers to transport up to four loaded OpenArray™ Plates to the QuantStudio™
12K Flex Instrument.

After loading is complete, you can use a large bin to properly discard any used OpenArray™
AccuFill™ System Tips.

For cleaning procedures, see QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User Guide
(Pub. No. MAN0025669).
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In this chapter, you run the OpenArray™ Plate formats on the QuantStudio™ 12K Flex Instrument. During
the run, the instrument performs thermal cycling (if the experiment includes amplification) and collects
fluorescence data. The workflow is the same for all OpenArray™ Plate formats.

Workflow

Perform the instrument run

- Prepare the QuantStudio™ 12K Flex Software (page 48)

Load the TrueMark™ OpenArray™ Plate into the instrument
(page 50)

- Run OpenArray™ Plate formats (page 50)

(Optional) Monitor experiments (page 56)

Unload the TrueMark™ OpenArray™ Plate from the instrument
(page 60)

(Optional) Transfer experiment results (page 60)
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Prepare the QuantStudio™ 12K Flex Software

(Optional) Select OpenArray™ block run preferences

Preferences provide user-access to the settings that govern how the QuantStudio™ 12K Flex Software
functions. This section summarizes only those preferences that apply to experiments with OpenArray™

Plate formats.

For detailed information about the preferences, see the QuantStudio™ 12K Flex Software Help (click €

or press F1).

1. Double-click El (QuantStudio™ 12K Flex Software shortcut) to start the software.

2. In the toolbar, click Tools » Preferences, then select the OpenArray tab.

3. Complete the tab, as needed.

Settings

Description

Setup Folder

Define the absolute path to the default folder from which the software imports
experiment setup files. The Import dialog box opens to the import folder when
invoked from the software.

Experiment Folder

Define the absolute path to the default folder to which the software reads or
writes experiment files. The Open and Save dialog boxes open to the data
folder when invoked from the software.

Passive Reference

Define the dye to use as the passive reference. The default is set to None.

While the software requires a selection, a passive reference dye is not used to
normalize fluorescence signals collected during OpenArray™ experiments.

Default Browse File
Type list

Define the file type that the Import, Open, and Save dialog boxes select by
default when invoked from the software.

Apply experiment
template (EDT)

to all OpenArray
experiment checkbox

If selected, the software applies the Run Method defined in the selected
experiment template (EDT) to all OpenArray™ experiments. For more
information about OpenArray™ experiment templates, see the software help.

4. Click OK to save your changes and close the Preferences dialog box.

IMPORTANT! You must restart the software for preference changes to take effect.

Access the Instrument Console

48

The Instrument Console displays every QuantStudio™ 12K Flex Real-Time PCR Instrument discovered
on a network, divided into groups. A group is a way to organize your instruments. By default, there are

two groups.

®* On the Network—All instruments available on the network.

¢ My Instruments—Instruments you have selected to monitor.

To start and monitor a run on an instrument, you must move the instrument from the On the Network
group to the My Instruments group or a custom group that you create.
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To access the Instrument Console and enable monitoring of a networked instrument:

1. Double-click [E

(QuantStudio™ 12K Flex Software shortcut) to start the software.

2. On the Home tab, from the Tools menu, select Instrument Console.
If you do not see an instrument, click Refresh in the Instrument Console toolbar.

@) rosmirasiLo2 (2]

Doy Group: PTCRNPRY ed by: DTN Tnstrument Status: READY

My In: ments (1) Group: My Instruments
Calibration Status ——————— (&)
7]
FOSMIRAIS1LO2 Backgr.... |09-01-201... [ADMINIST.... Expired
READY Uniform...[09-01-201... |ADMINIST... Expired
On the Network (4) Normal..
g @ 4 4@
28580002 285880026 SGAGUSANKIDOL spydercos ToalCresforBock o |
one oune o oune TomlDegreesforBock o |

Instrument Properties

Instrument Label Juo
Seral Number [FosMRAJS1L02
Tnstrument Frmware Ver...
TP Address 17228.1.136
Bock Type [384-Wel Block
Controlle Frmware Verson|0.20.2

Optics Fimware Verson _[65535
Thermal Block Frmware .. |25

Heated Cover Frmvare ... |25

3. If needed, move an instrument from the On the Network group to a group that can be monitored:

a. Click the instrument of interest, then click Assign to Group in the Instrument Console
toolbar.

b. Select the My Instruments group or a personal group in the drop-down list.

Note: Alternatively, you can select the icon of the instrument that you want to add to the My
Instruments list, then click Add to My Instruments. Similarly, click Remove from My Instruments

to remove an instrument from the My Instruments list. You can also drag and drop the instrument icon
into My Instruments or into the group created by you.

The instrument is now monitored. The status is indicated by an icon in the upper right corner. For
detailed information about the Instrument Console, see the QuantStudio™ 12K Flex Software Help
(click € or press F1).
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Enable or change the notification settings

You can configure the QuantStudio™ 12K Flex Software to alert you by email when the QuantStudio™
12K Flex Real-Time PCR Instrument begins and completes a run, or if an error occurs during a run.

Note: For details on using the notification settings feature, see QuantStudio™ 12K Flex Real-Time PCR
System v1.6 or later Maintenance and Administration Guide (Pub. No. MAN00O18832).

Load the TrueMark™ OpenArray™ Plate into the instrument

VAN CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the sample block
&= temperature can reach 100°C. Allow it to cool to room temperature before handling.

IMPORTANT! Wear powder-free gloves when you handle the OpenArray™ Plate.

IMPORTANT! The instrument should be loaded and unloaded only by operators who have been
warned of the moving parts hazard and who have been adequately trained.

1. Open the plate adapter on the instrument. Touch & on the QuantStudio™ 12K Flex Real-Time PCR
Instrument touchscreen, or click Open Door in the Instrument Console of the QuantStudio™ 12K
Flex Software, to allow the plate adapter to come out from the instrument side.

2. Remove the clear protective film from the outside of the OpenArray™ Case (sealed plate + lid).

3. Place the OpenArray™ Plate or plates on the plate adapter.
* Ensure that each plate is properly aligned in the plate adapter.
* Ensure that the plate barcode is facing up and toward the front of the instrument.

4. Close the plate adapter on the instrument. Touch & on the instrument touchscreen, or click
Close Door in the Instrument Console of the software, to retract the plate adapter back into the
instrument.

Run OpenArray™ Plate formats

You can run OpenArray™ Plate formats in one of these ways.
* From the QuantStudio™ 12K Flex Software. See “Start a run from the software” on page 51.

* From the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen. See “Start a run from the
instrument touchscreen” on page 55.

Note: The starter kit experiments in this guide run OpenArray™ Plate formats from the QuantStudio™
12K Flex Software.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the
QuantStudio™ 12K Flex Real-Time PCR Instrument is in operation.
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Start a run from the software

There are two ways to create and run an OpenArray™ experiment (EDS) from the QuantStudio™ 12K Flex
Software.

* For the starter kit experiments, use a template file (EDT). See “Use a template file” on page 51.
* For your own experiments:

— (Recommended) Use an OpenArray™ plate setup file (TPF). See “Use an OpenArray™ plate
setup file” on page 54.

— (Optional) Use a template file (EDT). See “Use a template file” on page 51.
— Use the Batch Experiment Setup Utility. See the QuantStudio™ 12K Flex Software Help (click

€ or press F1).
Use a template file

You can use a template file (EDT) to create a new OpenArray™ experiment, then import the sample
and assay information for the OpenArray™ Plate or plates before starting the run, or after the run is
complete.

1. Double-click [E}

(QuantStudio™ 12K Flex Software shortcut) to start the software.
2. On the Home tab, on the Experiment menu, select & Create From Template.

3. Navigate to and select the template file (EDT) that you want to use, then click Open.
A new experiment is created using the setup information from the template.

Note: To access the starter kit templates, navigate to the templates folder located at
<...>:\Program Files (x86)\Applied Biosystems\QuantStudio 12K Flex
Software\templates

where <. . .> is the installation drive. The default installation drive is C: if the software is installed
by the customer. The default installation drive is D: if the software is installed by a Thermo Fisher
Scientific field service engineer.

4. In the Experiment Properties screen, scan the OpenArray™ Plate barcode or type the OpenArray™
Plate serial number.

5. In the Samples screen, do either of the following:

* (Recommended) Click Import above the sample table, navigate to and select the OpenArray™
sample information file (CSV) that you want to use, then click Select File.

For the gene expression starter kit experiments, use the OpenArray™ CSV files that were
created in OpenArray™ AccuFill™ Software v2.0. See “Track the samples” on page 29.

* In the sample table, click in a cell in the Sample Name column, then enter a new name.
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6. From the open experiment, select File » Import Plate Setup.

a. Click Browse, navigate to and select the gene expression starter kit plate setup file that you
want to use.

Gene Expression Source File (TPF)—Corresponds to the plate setup file associated with gene
expression OpenArray™ Plate formats.

For the gene expression starter kit experiments and for your own experiments, download
the appropriate plate setup files from the Thermo Fisher Scientific website. See “Use an
OpenArray™ Plate setup file” on page 16.

b. Click Select, then click Start Import.

c. If your experiment already contains plate setup information, the software asks whether to
replace the plate setup information with the data from the file. Click Yes to replace the plate
setup information.

7. Select File » Save As, enter a file name, select a location for the experiment file (EDS), then click
Save.

Proceed to “Start the OpenArray™ run” on page 52.

Start the OpenArray™ run

Ensure that the default browse file type is set to EDS. See “(Optional) Select OpenArray™ block run
preferences” on page 48.

1. Double-click El

(QuantStudio™ 12K Flex Software shortcut) to start the software.

2. On the Home tab, from the Run menu, select # | OpenArray.

B

Load the the instrument. Select the setup files, €l
,, d 7]

Select Instrument

RunType: N/A
ReagentType: N/A

» Cancel

Note: Be sure to add an instrument to My Instruments in the Instrument Console before you run
an experiment. See “Access the Instrument Console” on page 48. If no instrument is selected, a
warning appears.
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i ) There are no instruments available.
\/ Go to the Instrument Console and add at least one instrument to My Instruments.

3. In the Select Instrument pane, select the instrument that you want to use to run the experiment.

4. Complete the Setup OpenArray Run pane.

¢ Click Get Plate IDs to import the barcode of the OpenArray™ Plate formats that you want to
run.

* (Optional) Click Confirm Plate Centers to view the center of the OpenArray™ Plate formats
that you want to run. For each plate image in the Confirm OA Plate Centers dialog box, click
Continue if the red box is aligned to the center of the plate. If the box is not in the center of
the plate, click OK, eject the carrier, rearrange the plates, then click Get Plate IDs.

* (Optional) Click Browse, then navigate on your computer to select the appropriate setup files.
The setup file was created in “Use a template file” on page 51.

Depending on the number of OpenArray™ Plate formats loaded in the instrument, the barcodes of
those plates are populated.

IMPORTANT! If the QuantStudio™ 12K Flex Real-Time PCR Instrument does not detect a
barcode, repeat the barcode read.

5. Click Start Run.
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Use an OpenArray™ plate setup file

The OpenArray™ AccuFill™ Software integrates the sample information into an OpenArray™ Plate setup
file (TPF). You can save the newly created Loaded_tpf files to the OpenArray™ Plate File Input Folder
that you selected in the Preferences dialog box of the OpenArray™ AccuFill™ Software. Configure this
location in the QuantStudio™ 12K Flex Software preferences to upload the integrated plate setup file
into the QuantStudio™ 12K Flex Software, then run the file.

Note: You can import a CSV file into the QuantStudio™ 12K Flex Software before starting the run, or
after the run is complete.

1. Double-click B (QuantStudio™ 12K Flex Software shortcut) to start the software.

2. On the Home tab, from the Run menu, select @ OpenArray.

x|

Load the the nstument the setp fes, 6
@ P (7]

Select Instrument

FOSMIRAJS1L02

Setup OpenArray Run
R RunTipe: WA
Reagent Type: N/A

OpenArmay 1: * Setup Fie : * Experiment File Location :
* Bxperi

File Name :

OpenArmay 2 * Setup Fie : * Experment File Location :
* Experiment File Name

OpenArmay 3: * Setup Fie : * Experment File Location :
* Experiment File Name

OpenArmay 4 : * Setup Fie : * Experment Fie Location :

* Experiment File Name

Note: Be sure to add an instrument to My Instruments in the Instrument Console before you run
an experiment. See “Access the Instrument Console” on page 48. If no instrument is selected, a
warning appears.

i There are no instruments available,
\) Go to the Instrument Console and add at least one instrument to My Instruments.

3. In the Select Instrument pane, select the instrument that you want to use to run the experiment.
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4. Complete the Setup OpenArray Run pane.

¢ Click Get Plate IDs to import the barcode of the OpenArray™ Plate formats that you want to
run.

* (Optional) Click Confirm Plate Centers to view the center of the OpenArray™ Plate formats
that you want to run. For each plate image in the Confirm OA Plate Centers dialog box, click
Continue if the red box is aligned to the center of the plate. If the box is not in the center of
the plate, click OK, eject the carrier, rearrange the plates, then click Get Plate IDs.

* (Optional) Click Browse, then navigate on your computer to select the appropriate
OpenArray™ Plate setup files (TPF).

Note: When the setup file is selected, the Experiment File Location and Experiment

File Name are populated. To set the default Experiment File Location, go to

Tools » Preferences » OpenArray » Experiment Folder. In the Setup OpenArray Run pane,
to select another location for the experiment file, click Browse. You can also enter an
experiment file name of your choice.

Depending on the number of OpenArray™ Plate formats loaded in the instrument, the barcodes of
those plates are populated.

IMPORTANT! If the QuantStudio™ 12K Flex Real-Time PCR Instrument does not detect a
barcode, repeat the barcode read.

5. Click Start Run.

Start a run from the instrument touchscreen

There are three ways to start a run from the QuantStudio™ 12K Flex Real-Time PCR Instrument
touchscreen.

e “Start a run on the instrument touchscreen from an existing experiment” on page 55
® “Start a run on the instrument touchscreen from a template” on page 56

® “Start a run on the instrument touchscreen from a shortcut” on page 56

The starter kit experiments in this guide start a run from the QuantStudio™ 12K Flex Software.

Start a run on the instrument touchscreen from an existing experiment

1. Touch the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen to activate it.
If the touchscreen is not at the Main Menu screen, touch EJ (Home).

2. In the Home screen, touch Run OpenArray Plates.
The instrument retrieves the barcodes and scans for existing experiments with the same barcodes.

3. If experiments with the same barcode cannot be found, touch Source Input to select a template to
use.
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4. Touch ki (Start Run Now) to start the run.

IMPORTANT! If the instrument does not detect a barcode, repeat the barcode read. If the
barcode is detected incorrectly, type the correct barcode number on the instrument touchscreen.
Do not proceed if a barcode is not detected by the instrument.

Start a run on the instrument touchscreen from a template

1. Touch the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen to activate it.

Note: If the touchscreen is not at the Main Menu screen, touch g (Home).

2. In the Home screen, touch (View Templates).

3. Inthe View Templates screen, touch & (Folders) to display the folders containing the template
files.

4. Touch any of the folders to display the templates in that folder.

5. In the View Templates screen, select the desired template, then touch .

The instrument retrieves the barcodes and creates new experiments based on the template for
each plate found.

6. Touch famaid to start the run.

Start a run on the instrument touchscreen from a shortcut

1. Touch the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen to activate it.
If the touchscreen is not at the Main Menu screen, touch EJ (Home).

2. In the Home screen, touch any of the shortcuts that have been set to an OpenArray™ template.

The instrument retrieves the barcodes and creates new experiments based on the template for
each plate found.

3. Touch kasiid (Start Run Now) to start the run.

(Optional) Monitor experiments

You can monitor an OpenArray™ experiment run in three ways.

* From the Run screen of the QuantStudio™ 12K Flex Software, while the experiment is in progress.
See “Monitor an experiment from the software Run screen” on page 57.

* From the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen, in the same way that you
run the experiment. See “Monitor an experiment from the instrument touchscreen” on page 58.

* From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor an experiment
started from another computer or from the QuantStudio™ 12K Flex Real-Time PCR Instrument
touchscreen). See “Monitor an experiment from the Instrument Console” on page 57.
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Note: If connection between the instrument and the QuantStudio™ 12K Flex Software is lost during an
experiment, remove and then add the instrument to the My Instruments list, or restart the software.
You can then resume monitoring the experiment.

Monitor an experiment from the software Run screen

To monitor the Amplification Plot of the experiment that you are running, in the QuantStudio™ 12K Flex
Software, from the Run Experiment Menu, click Amplification Plot.

Monitor an experiment from the Instrument Console

1. In the QuantStudio™ 12K Flex Software Home tab, from the Tools menu, click Instrument
Console.

2. In the Instrument Console, select the icon of the instrument that you are using to run the
experiment, then click Manage Instrument, or double-click the instrument icon.

You must add the instrument to a group that can be monitored before you can manage it (see
“Access the Instrument Console” on page 48).

3. In the Instrument Manager screen, click Monitor Run to access the Run screen.

You can view the progress of the run in real time from the Run screen. During the run, periodically view
the Amplification Plot (see “Monitor the Amplification Plot” on page 57) available from the software
for potential problems.

Task Action

To stop the run * In the QuantStudio™ 12K Flex Software, click STOP RUN.

* In the Stop Run dialog box, click one of the following:
— Stop Immediately to stop the run immediately.

— Stop after Current Cycle/Hold to stop the run after the current cycle or
hold.

— Cancel to continue the run.

To view amplification Select Amplification Plot.

data in real time See “Monitor the Amplification Plot” on page 57 below.

Monitor the Amplification Plot

To view data in the Amplification Plot, click Amplification Plot from the Run Experiment menu, select
the Plate Layout tab, then select the wells to view. You can view up to four OpenArray™ experiments
per run. Click the different tabs to view the Amplification Plot for each experiment.

Use the Amplification Plot to view sample amplification as the instrument collects fluorescence data
during a run. If a method is set up to collect real-time data, the Amplification Plot shows the data for
the wells selected in the Plate Layout tab. The plot contrasts normalized dye fluorescence (ARn) and
cycle number.
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The Amplification Plot is useful for identifying and examining abnormal amplification, including:
* Increased fluorescence in negative control wells.

* Absence of detectable fluorescence at an expected cycle (determined from previous similar
experiments run using the same reagents under the same conditions).

Note: If you notice abnormal amplification or a complete absence of signal, troubleshoot the error
as explained in the QuantStudio™ 12K Flex Software Help (click € or press F1).

Monitor an experiment from the instrument touchscreen

The QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen displays the barcodes (or Plate
IDs) of the TrueMark™ OpenArray™ Plate formats for the run, the date and time at which the run started,
the time remaining in the run, and other information.

Task Action

To display the experiment names in the run | Touch Experiment View.

To show the Amplification Plot for the run Touch the Plot View, then touch Experiment View to
return to the previous screen.

To display the time elapsed and the time Touch the (® Time View tab, then touch Experiment

remaining in the run View to return to the previous screen.
To stop the run Touch @ STOP to stop the run immediately.
View the Events Log Touch the status bar to display the events log.
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(¢} Time View Plot View Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 59.5 °C
Reaction Volume: 20 pL. Heated Cover (Set Point): 105.0 °C (105.0 °C)

Stage / Step / Cycle: 2/2/5

01:11:22

© Remaining Time Elapsed Time

December 082011 - 12:06AM o

Error occurred during run. Details: Holdtime 60 s exceeded. Actual Holdtim...

Plot view

The Plot View displays the Amplification Plot in real time.

@ Time View Plot View ]  Experiment View

E m m Linear W AR V¥ FAM v

Subarray: A1
2,000

1,500

1,000 -
©
<

500

0

-500 -

January 30 2012 - 10:15AM o

You can change the plot using the drop-down menus that are available on the Plot View tab.

Touch... To...
TR Change the data displayed on the y-axis. Select either R (reporter) or AR (baseline-
corrected reporter).
For OpenArray™ experiments, the data is not normalized.
FAM v | Change the reporter dye displayed in the plot. Only the dyes that are used in your
experiment are shown.
0 View the run events that occurred during the run. Touch € again to close the event list.
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Unload the TrueMark™ OpenArray™ Plate from the
instrument

About completed runs

After the run is complete, if you started the run from the QuantStudio™ 12K Flex Software, close the

run and reopen the EDS file to display the Amplification Plot. See Chapter 6, “Analyze the experiment
results”.

If you started the run from the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen, see
“(Optional) Transfer experiment results” on page 60.

Unload the instrument

When the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen displays the Home screen,
unload the TrueMark™ OpenArray™ Plate from the instrument.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the sample block
temperature can reach 100°C. Allow it to cool to room temperature before handling.

\

1. Touch & on the instrument touchscreen, or click Open Door in the Instrument Console of the
QuantStudio™ 12K Flex Software.

2. Remove the OpenArray™ Plate from the plate adapter.

3. Touch [ or click Close Door to retract the plate adapter back into the instrument.
If the instrument does not eject the plate, remove the plate.
a. Power off the instrument.

b. Wait for 15 minutes, then power on the instrument and eject the plate.

c. If the instrument does not eject the plate, power off and unplug the instrument, then open the
access door.

d. Wearing powder-free gloves, reach into the instrument and remove the plate from the heated
cover, then close the access door.

(Optional) Transfer experiment results

If you started a run from the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen, transfer
the experiment data to the computer for analysis after the run is complete. You can transfer the
experiment results in either of the following two ways.

* “Download the experiment from the instrument over the network” on page 61
* “Transfer the experiment from the instrument to the computer with a USB drive” on page 61
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Download the experiment from the instrument over the network

1.

2.

In the QuantStudio™ 12K Flex Software, select Instrument » Instrument Console.

From My Instruments list, select the instrument icon of the QuantStudio™ 12K Flex Real-Time
PCR Instrument that you just used to run the experiment.

Click Manage Instrument.
In the Instrument Manager, click Manage Files.
In the Experiments panel, select the experiment to download, then click Download.

In the Save dialog box, select the folder to hold the experiment results, then click Save, then
navigate to the experiments folder location.

<...>:\Applied Biosystems\QuantStudio 12K Flex Software\User
Files\experiments\

where <. . .> is the installation drive. The default installation drive is C: if the software is installed
by the customer. The default installation drive is D: if the software is installed by a Thermo Fisher
Scientific field service engineer.

Transfer the experiment from the instrument to the computer with a USB

drive

1.

2.

3.

4.

If not already connected to the QuantStudio™ 12K Flex Real-Time PCR Instrument, connect a USB
drive to the USB port.

Touch the instrument touchscreen to activate it.
If the touchscreen is not at the Main Menu, touch &3 (Home).

In the Main Menu, touch [&] (Collect Results) to save the data to the USB drive.
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5. Select one or multiple experiments (by touching them). Then touch g (Save to USB) to copy
selected experiments to the USB drive.

Note: If your instrument cannot find the USB drive, remove the USB drive, then try again. If the
instrument still does not recognize the USB drive, try another USB drive.

6. Touch EJ (Home) to return to the Main Menu.

7. Remove the USB drive from the instrument, then connect it to one of the USB ports on your
computer.

8. In the computer desktop, use the Windows™ Explorer to open the USB drive.

9. Copy the example experiment file to:
<...>:\Applied Biosystems\QuantStudio 12K Flex Software\User
Files\experiments\

where <. . .> is the installation drive. The default installation drive is C: if the software is installed
by the customer. The default installation drive is D: if the software is installed by a Thermo Fisher
Scientific field service engineer.
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Analyze the run data

This section includes general information and instructions about how to analyze the gene expression
example experiment provided with the QuantStudio™ 12K Flex Software. For specific instructions see
“Analyze gene expression experiment results” on page 72.

View the data from the EDS file. If the default analysis settings are not suitable for your experiment,
you can modify the data. You can also modify the project files, publish data, and export data for
downstream analysis using the ExpressionSuite™ Software.

Check the quality—control images

Check the quality—control (QC) images before analysis. Images can be viewed using Imaged, an open-
source software available from the NIH at imagej.nih.gov/ig.

QC images can be viewed in QuantStudio™ Design and Analysis Software v2.7 and later.

1.

In the QuantStudio™ 12K Flex Software E Export screen, click Browse, then create a uniquely—
named folder for the QC images export.

IMPORTANT! Create a new folder for images each time. Exporting a second run to the same
folder overwrites the images.

Click Export QC Images at the bottom of the screen.

View the following ROX™ image to check for loading quality issues:

® POST-READ CHANNEL 4.tiff

Check the following spotfind images for leaks or other displaced sample issues.
® 502 c001 t03 p0001 ml x2 el cp# spotfind.tiff
® 502 c040 t03 p0001 ml x2 el cp# spotfind.tiff

Note: The “cp#” in the image file name refers to array positions 1 through 4 within the instrument.

If a problem is found, view the following pre-run spotfind image to determine whether the issue
existed before cycling:

® s00 c001 t01 p0001 m2 x3 el cp# spotfind.tiff

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 63


https://imagej.nih.gov/ij

=% Chapter6

|~ ]
Analyze the run data

6. View the following FAM™ images to check for fluorescent abnormalities and to confirm any
problem seen in the spotfind images:

®* STAGE2 CYCLEl CHANNEL 1.tiff
®* STAGE2 CYCLE40 CHANNEL 1.tiff

7. Note any abnormalities found, as well as all other potentially relevant information related to the
setup of the run.

View the results

After an experiment run, close the run and reopen the EDS file to display the Amplification Plot.

Note: For auto-analysis of data, after a run, go to Tools » Preferences » Experiment, then select the
Auto Analysis checkbox. By default, Auto Analysis is always enabled. To reanalyze the data, select all
wells in the plate layout, then click Analyze.

Set up the EDS file

If you run a gene expression experiment using an EDT file, you must integrate the sample names and
Assay IDs into the resulting EDS file.

For Assay IDs, you can import the TPF file of that OpenArray™ Plate into the EDS file before or after the
run.

For sample names:

* You can import the OpenArray™ Plate format from the CSV file for the corresponding plate.

* If you use the OpenArray™ AccuFill™ Software for sample integration, navigate to the appropriate
folder containing the Loaded TPF file. A Loaded TPF file is one that has sample names integrated
into the file using the OpenArray™ AccuFill™ Software.

Change analysis settings

Analysis settings are different for each experiment type. If the default analysis settings in the
QuantStudio™ 12K Flex Software are not suitable for your own experiment, you can change the settings
in the Analysis Settings dialog box, then reanalyze your experiment. You can save the changed
analysis settings to the Analysis Settings Library to use them in other experiments.

Use the Analysis Settings Library dialog box to apply a filter to reduce the number of setting protocols
that are displayed. Access the Analysis Settings Library from the Tools menu.
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Select analysis settings or delete analysis settings. Apply a filter to reduce the number of analysis settings displayed. p )

Enter a fitter query, then click "Apply Fiter."

[ oo i ] \

IF ‘Ana\ysws Seftings v‘ = v ‘

Experiment Type Comments Created On Last Modified

| Analysis Settings

Flag Gene Expression

01-19-2012 16:16:02 SGT

01-19-2012 16:16:47 SGT

Pre-PCR SNP Genotyping

01-19-2012 16:39:00 5SGT

01-19-2012 16:39:14 SGT

Bad passive ref SNP Genotyping

01-19-2012 16:40:27 SGT

01-19-2012 16:40:40 SGT

1. From the Experiment Menu, select Analysis.

2. On the Analysis screen, click Analysis Settings.

3. In the Analysis Settings dialog box, change the analysis settings according to your requirement.
4. Click Save to Library to save the changes to the Analysis Settings Library.

To import the analysis settings that you have previously saved to the Analysis Settings Library, in the
Analysis Settings dialog box, click Load from Library.

Display wells

To display specific wells in the analysis plots, select the wells in the Plate Layout tab.
* To select specific well type, use the Show in Wells drop-down menu.
— For gene expression and miRNA experiments, select Sample Color or Target Color.
— For genotyping experiments, select Sample Color or Assay Color.
* To select a single well, click the well in the Plate Layout tab.

* To select multiple wells, click and drag over the desired wells, press Ctrl-click, or press Shift-click
in the Plate Layout tab.

* To select all wells, click the upper left corner of the Plate Layout tab.

This example shows the Plate Layout tab for a gene expression experiment.
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Expand view of a plot or wells

* (Click »| to expand the plot view, on the left side of the screen.
* Click 4| to expand the Targets, Samples, and Subarrays view on the right side of the screen.
¢ Click # to expand the Plate Layout or Well Table view on the lower half of the screen.

* (Click ¥ to expand the Plots and Targets, Samples, and Subarrays view on the upper half of the
screen.

* C(Click % to expand and collapse the Plot or Plate Layout view.

Edit plot properties

Use the Plot Properties dialog box on the Analysis screen to edit plot settings, such as the font and
color of the plot text, and the labels on the x-axis and y-axis.

1. Click [ on the Analyze screen (the icon appears above the plot).

2. In the Plot Properties dialog box, edit the settings under the General, X Axis, and Y Axis tab.

* (Click the X Axis tab to edit the x-axis label text, font, or color; select the tick marks and tick
mark labels to display; and select the range to display.

* C(Click the Y Axis tab to edit the y-axis label text, font, or color; select the tick marks and tick
mark labels to display; and select the range to display.

3. Click OK.
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Publish the analyzed data

Task Click
Save a plot as an image file. i
Print a plot. =)
Copy a plot to the clipboard.
Print a report.
Export data. B=
Task Go to Then
Print the plate layout. | File » Print Select the background color, then click Print.
Create slides. File » Send to PowerPoint | Select the slides for your presentation, then click Create
Slides.
Print a report. File » Print Report Select data for the report, then click Print Report.

(Optional) Export an experiment

Use the Export feature to export experiment data from the QuantStudio™ 12K Flex Software. Select to
export in the QuantStudio™ 12K Flex (TXT or XLSX) or RDML (no file selection) format.
You can export the following experiment data in a comma-separated file format (CSV).
* Sample setup data
¢ Raw data
* Amplification data
* Multicomponent data
* Results
You can also export plate images collected during the run as TIF files and use them for troubleshooting

purposes. To export plate images, first create an export folder on your hard drive. In the Export screen,
click Browse, navigate to the folder that you created, then click Export QC Images.

You can view the images using a public domain software program such as ImageJ
(http://rsb.info.nih.gov/ij/). For more information about QC images, see QuantStudio™ 12K Flex Real-
Time PCR System v1.6 or later Maintenance and Administration Guide (Pub. No. MAN0018832).

You can view images in QuantStudio™ Design and Analysis Software v2.7 and later. For more
information, see QuantStudio™ Design and Analysis Software 2 User Guide (Pub. No. MANO018200).

If you select the Auto Export option before running an experiment, the data are exported to the location
that you specified. If you do not select the Auto Export option, the analyzed data are not exported
automatically.
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1. Open the experiment file that contains the data to export, then from the Experiment Menu, click
E7 Export.

2. Select the format for exported data.
¢ QuantStudio 12k Flex format—Supports TXT and XLSX data.
* RDML format (Real Time Data Markup Language)—Supports only XML type of data.

3. Select to export all data in one file or in separate files for each data type.
¢ All data types are exported in one file.
- If you select the XLS format, a worksheet is created for each data type.
— If you select the TXT format, the data are grouped by data type.

* Each data type is exported in a separate file. If you select to export three different data types
(for example, Results, Amplification, and Multicomponent), three separate files are created.
You can select the export file type (XLS, XLSX, or TXT) to export from the File Type menu.

Note: You cannot use an exported XLS or an XLSX file when importing plate setup
information.

4. Select Yes to include or No to exclude bookmarked data from analysis in the export set.

The Filter Bookmark Data feature lets you include only the data bookmarked during analysis in
the export set.

5. (Optional) Select the Open file(s) when export is complete checkbox to open the file when export
is complete.

6. Enter a file name and location.
a. In Export File Name, enter a name for the export file.
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b. In Export File Location accept the default, or click Browse if you do not want to save the
export file in the default export folder.

Note: To set up the export file location, go to Tools » Preferences, then select the Export
tab. You can select the Use Last File Location or Use Default Folder checkbox.

T Startup W

SMTP Settings W

[ Non-OpenArray® T OpenArray® T
Print

Global Notification Settings

Experiment Display Format.

@ Select the default exportlocation

® Use Default Folder C:\Applied Biosystems\QuantStudio 12K Flex Software\User Files\experiments

Restore Defaults || Apply

7. Select the type of data to export.
Selection Data type to export
Sample setup Well, sample name, sample color, and target name of samples in the plate.
Raw data Raw fluorescence data for each filter, for each cycle.

Amplification data Amplification results, such as dCt values, R, or AR.

Multicomponent data | Fluorescence data for each dye, for each cycle.

Results Results information, such as Cy values, Rn, or calls.

Results data are not available for export until the run status is complete and
the data are analyzed.

The completed Export screen for a gene expression experiment should look like this.
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OAuto Bxport  Format : (QuantStudio12KFlex | Export Data To: @ One Fle O Separate Fles  Fiter Bookmark Data : O Yes ® No Open fii(s) when export is complete

Export Fie Location: [C:\applied 12K Flex
Export Fie Name: [GYQ17_Quantstudio_export Fie Type: [ (
[ Raw Dat: O ampification | [ Multicomponent

e mont Well Well Position  Sample Name | Sample Color | Biogroup Name | Biogroup Color | Target Name  Tard
1A Fields 1A1a1 HB RGB(176,23,31) Hs99999901 51 RGB(1
q 24122 HB RGB(176,23,31) 599999905_m1  RGB(]

. 3A123 HB RGB(176,23,31) Hs99999909 m1  RGB(C
Nell Postion 4Al24 HB RGB(176,23,31) Hs99999908_m1  RGB(Z
5A1as HB RGB(176,23,31) 1599999903 1 RGE(1

ample Name 6A136 HB RGB(176,23,31) H599999907_m1  RGB(3

7 A127 HB. RGB(176,23,31, Hs00609297_m1  RGB(1

|
|
|
ample Color 84138 HB 1) Hs00183533 M1 RGE(1
| 9A1b1 HB RGB(176,23,31) Hs99999906_m1  RGB(C
SRR 104102 H8 RGB(176,23,31) 15999999021 RGB(Z
E | 11A163 HB RGB(176,23,31) 15999999101 RGB(Z
12A1b4 HB RGB(176,23,31) 1599999911 m1 RGB(1
(] Target Name | 13A1b5 HB RGB(176,23,31) Hs00824723_m1  RGB(Z
14 A1b6 HB RGB(176,23,31) HS00237047_m1  RGE(S
[ Target Color | 15A167 HB RGB(176,23,31) it mi RGBE(Z
16 A1b8 HB RGB(176,23,31) Hs00172187_m1  RGB(1
| 17 Alcl HB RGB(176,23,31) Hs00201226_m1  RGB(C
18A12 HB RGB(176,23,31) HS00355782_ m1  RGB(]
| 10813 H8 RGB(176,23,31) HS00153277_m1  RGB(2
20 Alcd HB RGB(176,23,31) Hs00169255_m1  RGB(1
< >

Start Export || Save Export Set As || Load Export Set || Delete Export Set || Export QC Images.

8. (Optional) After you have defined the export properties or after you have moved the table headings
order, you can save those export settings as an export set. Click Save Export Set As.

9. Later you can import the heading order into another file by clicking Load Export Set. You can also
delete export settings by clicking Delete Export Set.

10. (Optional) Click Export QC Images to export quality control (QC) images in experiment files (EDS).

QC images include calibration images, a barcode image, and images taken during PCR. You can
view the images to check sample loading and assay spotting. View PCR images to validate your
data.

11. Click Start Export.
The exported file, when opened in Notepad, should look like this.

B GYQ17_QuantStudio_export.txt - Notepad

Cor
* pa = 2012-01-19 18:00:57 PM SGT

* Experiment File Name = C:\DOCS\OAEXamples\GvQl7_2012_01_11_152902.eds

* Experiment Name = GYQ17

* Experiment Run End Time = 2012-01-12 09:35:41 AM SGT

* Experiment Type = Gene Expression

* Instrument Name = spyder0i2

* Instrument Serial Number = spyder012

* Instrument Type = Quantstudio 12k Flex

* passive Reference =

* quantification Cycle method = crt

* signal smoothing on =

* Stage/ Cycle where Analysis is performed = Stage 2, Step 3

* User Name = NA

[Results]

Well  Well Position omit  sample Name  Target Name  Task  Reporter et comomean czr S0 Amp
Score  HIGHSD AMPSCORE

1 Alas alse  HB 1599999901 S UNKNOWN FAM NF : 322 N N
2 Ala alse B UNKNOWN FAM  NF 5 205 N M
3 Ala alse we UNKNOWN FAM  NF 2 2.2 T N
4 Ala: alse B UNKNOWN FAM N 5181 13w N
5 Ala: alse 1B UNKNOWN FAM  NF 7 7.3 180 N ¥
6 Ala alse KB UNKNOWN FAM  NE 9.858 19 352 N N
7 Ala alse  HB UNKNOWN FAM  NF 5. 6.42 a8 N N
s A alse B UNKNOWN FAM  NFQ-MGB 24.507 24.45 337 N N
o A alse B UNKNOWN FAM  NF 0. 0,43 a3 N N
10 a alse B UNKNOWN FAM  NFQ-MGB 21.273 21.3: 209 N N
11 A alse B UNKNOWN FAM  NFQ-MGB 25.046 25. 397 N N
12 Albi  true KNOWN FAM  NFQ-MGB N N
13 alse B UNKNOWN FAM  NFQ-MGS 19.166 1S. .488 N N
1 alse B UNKNOWN FAM  NEQ-MGS 24.850 25. 248 N N
15 a1 alse B UNKNOWN FAM  NEQ-MGS 19.776 19.7 296 N N
16 A alse B NKNOWN FAM  NFQ-MGB 23.083 23 1 N N
17 Alc alse 1B UNKNOWN FAM  NFQ-NGB 22.695 22.4 la09 n N
18 Alc: alse  HB UNKNOWN FAM  NFQ-MGB 23.963 24. 248 N M
19 ALc alse  HB UNKNOWN FAM  NFQ-MGE 201697 20. P N
20 Alc: alse B UNKNOWN FAM  NFQ-MGE 23.494 23.4s BN N
21 Alc alse B WN EAM  NEQ-MGB 23.590 23 365 N N
22 Alc alse  HB UNKNOWN FAM  NFQ-MGB 24.141 23! 3N M
23 ALc alse B UNKNOWN FAM  NFQ-MGB 24.003 24! a3 N N
2 A alse B UNKNOWN FAM  NFQ-MGB 24.515 24. 369 N N
25 a1 alse B UNKNOWN FAM  NFQ-MGS 24.919 24.7 370 N N
26 a1 alse B UNKNOWN FAM  NFQ-MGS 24.702 24 a1s N N
27 A alse B UNKNOWN FAM  NFQ-MGS 14.721 14.7 a1 N N
28 A alse  HB UNKNOWN FAM  NFQ-MGB 23.411 23. 355N N
29 A alse 1B KNOWN FAM  NFQ-MGB 24.663 24. a0z N N
30 A alse e UNKNOWN FAM  NEQ-MGE 20.860 20. a8 N N
31 A1 alse we UNKNOWN FAM  NFQ-MGE 24.741 24. laas N N
32 A alse  HB UNKNOWN FAM  NFQ-MGB 20,812 20.7 438 N N v
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Perform downstream analysis (secondary analysis)

You can perform downstream analysis of experiments that have been run on any real-time PCR system
by using the ExpressionSuite™ Software.

Use the ExpressionSuite™ Software to efficiently analyze, edit, and conduct a study of a large number of
gene expression.

* Import data from the QuantStudio™ 12K Flex Software project files, then manage the data in a
database.

® Search the database for assays using specific search criteria.

¢ FEasily view data in a variety of ways (plots, statistics, status codes, and so on).
¢ Edit data. Your edits are saved to the database.

* OQverlay data from multiple plates.

* Export data.

ExpressionSuite™ Software is available for download from the Thermo Fisher Scientific website.
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Analyze gene expression experiment results

In this section you use the gene expression example experiment files provided with the QuantStudio™
12K Flex Software to analyze the experiment results.

Workflow

Analyze gene expression experiment results

- Access the example experiment file (page 72)

. Assess amplification results on the Amplification Plot (page 73)

- Identify well problems using the Well Table (page 75)

Confirm accurate dye signal using the Multicomponent Plot
(page 76)

Determine signal accuracy using the Raw Data Plot (page 78)

Review the flags in the QC Summary (page 79)

(Optional) Adjust parameters to reanalyze your own experiments
(page 82)

Access the example experiment file

1. Double-click E3

(QuantStudio™ 12K Flex Software shortcut) to start the software.

2. From the Home screen, click Open,, then browse to the Gene Expression examples folder.

<...>:\Program Files (x86)\Applied Biosystems\QuantStudio 12KFlex
Software\examples\Gene Expression

3. Openthe Gene Expression Starter Kit Example.eds file.
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Set up the EDS file

If you run a gene expression experiment using an EDT file, you must integrate the sample names and
Assay IDs into the resulting EDS file.

For Assay IDs, you can import the TPF file of that OpenArray™ Plate into the EDS file before or after the
run.

For sample names:

* You can import the OpenArray™ Plate format from the CSV file for the corresponding plate.

* [f you use the OpenArray™ AccuFill™ Software for sample integration, navigate to the appropriate
folder containing the Loaded TPF file. A Loaded TPF file is one that has sample names integrated
into the file using the OpenArray™ AccuFill™ Software.

Assess amplification results on the Amplification Plot

The Ampilification Plot displays amplification of all samples in the selected wells. View the
Ampilification Plot for the example experiment to evaluate the quality of the amplification curve and to
check for outliers.

Three plots are available.

* AR vs Cycle—AR is the magnitude of fluorescence signal generated by the reporter at each cycle
during the PCR amplification. This plot displays AR as a function of cycle number. Use this plot to
identify and examine irregular amplification and to view Cgy values for the run.

* R vs Cycle—R is the fluorescence signal from the reporter dye. This plot displays R as a function
of cycle number. Use this plot to identify and examine irregular amplification.

® Cpgt Vs Well—Cgr is the PCR cycle number at which the fluorescence meets the threshold in the
amplification plot. This plot displays Cgr as a function of well position. Use this plot to locate
outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

View the Amplification Plot

1. From the Experiment Menu, select Analysis » Amplification Plot.
If no data are displayed, click Analyze.

2. Display the HPp wells in the Amplification Plot.
a. Click the Plate Layout tab.
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b. Select Show in Wells » Sample Color.
The Plate Layout screen should look like this.
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3. In the Amplification Plot, make the following selections.

Menu Selection
Plot Type AR vs Cycle (default)
Graph Type Log (default)
View Target Color (default)

Show Unselection (default)

4. View the Cgr values.
a. Click View » Show Cpgy.

b. Verify that the Crr value that is reported matches its occurrence (the triangle icon) on the plot.

R
%

[ M vo02ssass_m_ M wsooiosss7_mi M sooreass_mt

5. Repeat steps 2 through 4 on page 73 for the HLiv, HLun, HB, and NTC wells.

74
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Identify well problems using the Well Table

The Well Table displays the following information for each well in the reaction plate.
* The sample name, target name, task, and dyes.
* The calculated threshold cycle (Crt) and quantity values.
* Flags.

Example experiment values and flags
Review the Well Table to evaluate the Cgt precision of the replicate groups and AMPSCORE values.

The software produces the AMPSCORE flag if the amplification in the linear region is below a certain
threshold, corresponding to the score set in the analysis settings. For robust amplification, AMPSCORE
values should be >1.24.

View the Well Table
1. From the Experiment Menu, select Analysis » Amplification Plot, then click the Well Table tab.
2. From the Group By menu, select Replicate.

3. Look at the Cgr SD column to evaluate the Cry precision of the replicate groups.
In the example experiment, the Cgt SD have the expected value of <0.5.

Plate Layout L

Assess the Well Table in your own experiments

Expand All

= well I Omit. Flag Sample ... Target.. Task Dyes CRT CRT Mean [CrT SD+! Amp Sc... HIGHSD AMPSC... Comme...
574 ASh6 O HB Hs001661... UNKNOWN FAMNFQ-... 23.773 23.686 0.092 1.446 A
830  Blhe ] HB HS001661... UNKNOWN ~FAM-NFQ-... 23.798 23.686 0.092 1.497
1086 BShG O HB Hs001661... UNKNOWN FAMNFQ-.. 23.612 23.686 0.002 1.470
1342 B9hG ] HB HS001661... UNKNOWN ~FAM-NFQ-.. 23.702 23.686 0.092 1.452
1508 Cthe O HB Hs001661... UNKNOWN FAMNFQ-... 23.579 23.686 0.002 1.496
1854 C5h6 ] HB HS001661... UNKNOWN FAM-NFQ-... 23.540 23.686 0.092 1.466
2110 Cohe =) HB Hs001661... UNKNOWN FAM-NFQ-... 23.776 23.686 0.002 1.450
00167441_miL
39 ALe7 O HB He001674... UNKNOWN  FAM-NFQ-.. 23.708 23.922 0.137 1.384
295  ASe? ] HB HS001674... UNKNOWN FAM-NFQ-... 23.781 23.922 0.137 1.346
551 A9e7 O HB He001674... UNKNOWN FAMANFQ-.. 23.887 23.922 0.137 1.355
807 Ble7 ] HB HS001674... UNKNOWN  FAM-NFQ-... 24.187 23.922 0.137 1.382
1063 BSe7 O HB He001674... UNKNOWN FAMANFQ-.. 23.812 23.922 0.137 1.376
1319 B9e7 ] HB HS001674... UNKNOWN  FAM-NFQ-... 24.039 23.922 0.137 1.344
1575 Cle7 O HB He001674... UNKNOWN FAMANFQ-.. 23.834 23.922 0.137 1.374
1831 Coe7 ] HB Hs001674... UNKNOWN  FAM-NFQ-... 23.940 23.922 0.137 1.374
2087 97 ] HB He001674... UNKNOWN FAM-NFQ-.. 24.022 23.922 0.137 1.344
00169255_m1
20 Ald O HB He001692... UNKNOWN FAM-NFQ-... 23.494 23.447 0.274 1.331
276 A5c4 O HB Hs001692... UNKNOWN FAM-NFQ-... 23.470 23.447 0.274 1.290
532 A9cH O HB He001692... UNKNOWN FAMANFQ-... 23.810 23.447 0.274 1.242
788 Blc4 O HB Hs001692... UNKNOWN FAM-NFQ-... 22.944 23.447 0.274 1.283
1044 BSCH O HB He001692... UNKNOWN ~FAMANFQ-.. 23.105 23.447 0.274 1.256
1300 B9c4 [m} HB Hs001692... UNKNOWN FAM-NFQ-... 23.642 23.447 0.274 1.233
1556 Clcd O HB He001692... UNKNOWN FAMANFQ-.. 23.575 23.447 0.274 1.305
1812 C5c4 [m} HB Hs001692... UNKNOWN FAM-NFQ-... 23.354 23.447 0.274 1.275
2068 C9c4 ] HB He001602... UNKNOWN FAMANFQ-... 23.629 23.447 0.274 1.249
00172187_ml
16 Alb8 ] HB He001721... UNKNOWN ~FAM-NFQ-.. 23.083 23.204 0.119 1.314
272 A5b8 O HB Hs001721... UNKNOWN FAM-NFQ-... 23.324 23.204 0.119 1.303
528 ASb O HB HE001721... UNKNOWN FAMANFQ-.. 23.144 23.204 0.119 1.300
784 B1b8 O HB Hs001721... UNKNOWN FAM-NFQ-... 23.242 23.204 0.119 1.310
1040 BSH8 O HB HS001721... UNKNOWN FAM-NFQ-... 23.274 23.204 0.119 1.299
1296 B9b8 O HB Hs001721... UNKNOWN FAM-NFQ-... 23.042 23.204 0.119 1.270
1552 C1b8 O HB HS001721... UNKNOWN ~FAM-NFQ-... 23.102 23.204 0.119 1.324
1808 C5bs O HB Hs001721... UNKNOWN FAM-NFQ-... 23.397 23.204 0.119 1.283
2064 C9b8 0 HB HS001721... UNKNOWN _FAMANFQ-... 23.225 23.204 0.119 1.282 v

When you analyze your own OpenArray™ gene expression experiment, look for standard deviation in the
replicate groups (Crt SD values). If needed, omit outliers.
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Confirm accurate dye signal using the Multicomponent Plot
The Multicomponent Plot displays the complete spectral contribution of each dye in a selected well
over the duration of the PCR run.
In the OpenArray™ gene expression example experiment, review the Multicomponent Plot for:
* FAM™ dye (reporter)
* Spikes, dips, and/or sudden changes
¢ Amplification in the negative control wells

View the Multicomponent Plot
1. From the Experiment Menu, select Analysis » Multicomponent Plot.

If no data are displayed, click Analyze.

2. Display the unknown and standard wells, one at a time, in the Multicomponent Plot.
a. Click the Plate Layout tab.

b. Select one well in the plate layout. The well is shown in the Multicomponent Plot.

If you select multiple wells, the Multicomponent Plot displays the data for all selected wells
simultaneously.

3. Click View » Dye Color.

4. Click [E Show a legend for the plot (default).
This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. Check the FAM™ dye signals.

In the gene expression example experiment, the FAM™ dye signal increases throughout the PCR
process, indicating normal amplification.
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< Targets Subarrays
Sample Name Color Biological ... # of Wells

576
768
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576

4,000

2,750 |

2,500

3.250

3,000

2750

2,500

2,250 {

2,000

Fluorescence

1.750

1.500

1280

1,000

6. Select the negative control wells one at time and check for amplification.

In the gene expression example experiment, there is no amplification in the negative control wells.

<] Subarrays
> Sample Name Color Biological # of Wells

HPp [ | 576

[ | 576

HLun 576

HB [ ] 576

2000

3750

3500

v AW e
i
z
=

3250
3000
2,760
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2250
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1,000
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Tips for confirming dye accuracy in your own experiment

When you analyze your own experiment, look for these results.

Reporter dye—The reporter dye fluorescence level should display a flat region corresponding to the
baseline, followed by a rapid rise in fluorescence as the amplification proceeds.

Irregularities in the signal—There should not be any spikes, dips, and/or sudden changes in the
fluorescent signal.

Negative Control wells—There should not be any amplification in the negative control wells.

Determine signal accuracy using the Raw Data Plot

78

The Raw Data Plot displays the raw fluorescence signal (not normalized) for each optical filter for the
selected wells during each cycle of the real-time PCR.

In the OpenArray™ gene expression example experiment, review the Raw Data Plot for a stable
increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data Plot

1.

From the Experiment Menu, select Analysis » Raw Data Plot.
If no data are displayed, click Analyze.

To display all wells in the Raw Data Plot, click the upper left corner of the plate layout in the Plate
Layout tab.

Click & Show a legend for the plot (default).

The legend displays the color code for each row of the reaction plate (see the legend in the Raw
Data Plot).

This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

Click and drag the Show Cycle pointer from cycle 1 to cycle 40.

In the example experiment, the stable increase in signal from filter 1 corresponds to the FAM™ dye
filter.
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Amplitude

Tips for determining signal accuracy in your own experiment

When you analyze your own OpenArray™ gene expression experiment, look for the following conditions
in each filter.

* Characteristic signal growth.
* No abrupt changes or dips.

Review the flags in the QC Summary

The QC Summary displays a list of the QuantStudio™ 12K Flex Software flags, including the flag
frequency and location for the open experiment. Review the QC Summary in the OpenArray™ gene
expression example experiment for any flags triggered by the experiment data.

The following wells have data that triggered the HIGHSD flag.

A2b3, A3a7, A3b3, A3d5, A3f2, A3h3, Ad4a3, Adc4, Ade3, A6b3, A7a7, A7b3, A7d5, A7f2, A7h3, A8a3,
A8c4, A8e3, A10b3, A11a7, A11b3, A11d5, A11f2, A11h3, A12a3, A12c4, A12e3, B2b3, B3a7, B3b3,
B3d5, B3f2, B3h3, B4ag3, B4c4, B4e3, B6b3, B7a7, B7b3, B7d5, B7f2, B7h3, B8a3, B8c4, B8e3, B10b3,
B11a7, B11b3, B11d5, B11f2, B11h3, B12a3, B12c4, B12e3, C2b3, C3b3, C3d5, C3f2, C3h3, C4a3,
C4c4, C4e3, C6b3, C7a7, C7b3, C7d5, C7f2, C7h3, C8a3, C8c4, C8e3, C10b3, C11a7, C11b3, C11d5,
C11f2, C11h3, C12a3, C12c4, and C12e3

The following wells have data that triggered the AMPSCORE flag.

Ala2, Al1a5, Al1c2, A1c6, A1fl, A2a2, A2a5, A2b6, A2c2, A2¢c6, A2f1, A2f5, A3a2, A3a5, A3c2, A3c6,
A3f1, Ada2, Adab, Adb6, Adc2, Adc6, A4f1, Aba2, A5ab, ASb6, A5c2, A5c6, A5f1, AGa2, A6ab, A6b6,
ABc2, A6cB, Abe2, A6f1, A7a2, A7a5, A7c2, A7c6, A7e2, A7f1, A7f5, ABa2, A8a5, A8b6, A8c1, A8c2,
A8c6, ABe2, ABe8, ABf1, A8f5, ABh5, A9a2, A9a5, A9b6, A9c2, A9c6, A9e2, A9f1, A10a2, A10a5,
A10b6, A10c2, A10c4, A10c6, A10e2, A10f1, A10f5, A10f7, A11a2, A11a5, A11b6, A11c2, Al11c4,
A11c6, A11e2, A11f1, A1115, A11f7, A12a2, A12a5, A12c2, A12c6, A12f1, B1a2, B1a5, B1b6, B1c2,
B1c6, B1f1, B2a2, B2a5, B2c2, B2c6, B2f1, B3a2, B3a5, B3c2, B3c6, B3f1, B4a2, B4a5, B4b6, B4c2,
B4c6, B4f1, B5a2, B5a5, B5b6, B5¢c2, B5c6, B5f1, B6a2, B6a5, B6b6, B6¢c2, B6¢6, B6e2, B6f1, B6f7,
B7a2, B7a5, B7b6, B7c2, B7c6, B7e2, B7f1, B7f5, B7f7, B8a2, B8a5, B8b6, B8c2, B8c4, B8c6, B8e2,
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B8f1, B8f7, B9a2, B9a5, B9b6, B9c2, B9c4, B9c6, B9e2, B9f1, BIf5, B10a2, B10a5, B10b6, B10b7,
B10c2, B10c4, B10c6, B10e2, B10e8, B10f1, B10f5, B10f7, B11a2, B11a5, B11b6, B11c2, B11c4,
B11c6, B11e2, B11e8, B11f1, B11f5, B11f7, B12a2, B12a5, B12b6, B12c2, B12c6, B12f1, B12f7, C1a2,
C1a5, C1b6, C1c2, C1c6, Cl1e2, C1f1, C1f5, C2a2, C2a5, C2c2, C2c6, C2f1, C3a2, C3a5, C3a7, C3c2,
C3c6, C3f1, C4a2, C4ab, C4c2, C4co, C4f1, Cha2, C5a5, C5b6, C5¢c2, C5c6, C5e2, C5f1, C6a2, C6as,
C6b6, C6c2, Cbcb, C6e2, Cof1, C7a2, C7a5, C7b6, C7b7, C7c2, C7c6, C7d3, C7e2, C7f1, C8a2, C8ab,
C8b6, C8c2, C8cb, C8c8, C8e2, C8f1, C8f7, C9a2, C9a5, C9b6, C9c2, C9c6, C9e2, COf1, CIf5, COf7,
C10a2, C10a5, C10b6, C10b7, C10c2, C10c4, C10c6, C10c8, C10e2, C10e8, C10f1, C10f5, C1017,
C11a2, C11a5, C11b6, C11c2, C11c4, C11c6, C11c8, C11e2, C11e8, C11f1, C11f5, C11f7, C12a2,
C12a5, C12c2, C12c6, and C12f1

View the QC Summary

1.

From the Experiment Menu, select Analysis » QC Summary.
If no data are displayed, click Analyze.

Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the
experiment. If the frequency is >0, the flag appears somewhere in the experiment; the well position
is listed in the Wells column.

In the example experiment, there are 354 flagged wells.

In the Flag Details table, click each flag with a frequency >0 to see detailed information about
the flag. In the example experiment, the HIGHSD flag appears 80 times and the AMPSCORE flag
appears 274 times.

(Optional) For those flags with a frequency >0, click the troubleshooting link to view information
about correcting the flag.

The QC Summary for the example experiment looks like this.
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Flag Description Frequency Wells < -
Flag: HIGHSD—High standard deviation in replicate
> group
Flag Detail: The Ct standard deviation for the repicate
OFFSCALE Fluorescence is offscale ’g group exceeds the fiag setting.
i iati e ‘ 22 ) = : X e
HIGHSD High standard deviation in replicate group 180 A2b3, A3a7, A3b3, A3dS. Flag Criteria: Cr standard deviation > 0.5
Flagged Wells: A2b3, A3a7, A3b3, A3dS, A3f2, A3h3, Ada3,
Adc4, Ade3, A6b3, A7a7, A7b3, A7dS, A7f2,
NOSIGNAL No signal in well 0 A7h3, ABa3, ABc4, ABe3, A10b3, Alla7, A11b3,
Al1dS, A11f2, AL1h3, A12a3, A12c4, Al2e3,
[EXPFAL Exponential algorkhm faled 0 B2b3, B3a7, B3b3, B3d5, B3f2, B3h3, B4a3,
BLFAL Baselne algorithm faied 0 B4c4, B4e3, B6b3, B7a7, B7b3, B7dS, B7f2,
THOLDFAL ‘Tmi”“'d'”g 2gorthm faled 0 87h3, B8a3, B8c4, B8e3, B10b3, B11a7, B11b3,
CTFAIL CT algorithm failed (i
AMPSCORE [AMP Score 274 [Alaz, Alas, Alc2, ALCG... B11d5, B11f2, B11h3, B12a3, B12c4, B12e3,

C2b3, C3b3, C3ds, C3f2, C3h3, C4a3, C4c4,

C4e3, C6b3, C7a7, C7b3, C7dS, C7f2, C7h3,
C8a3, C8c4, C8e3, C10b3, C11a7, C11b3,
Cl1ds, C11f2, C11h3, C12a3, C12c4, C12e3

View HIGHSD Troubleshooting Information

Possible flags

The flags listed below may be triggered by the gene expression experiment data.

Flag Description
Preprocessing flag
OFFSCALE | Fluorescence is off scale.
Primary analysis flags
BADROX Bad passive reference signal.
NOAMP No amplification.
NOISE Noise is higher than others in plate.
SPIKE Noise spikes.
NOSIGNAL | No signal in well.
EXPFAIL Exponential algorithm failed.
BLFAIL Baseline algorithm failed.
THOLDFAIL | Thresholding algorithm failed.
CTFAIL C+ algorithm failed.
AMPSCORE | Amplification in the linear region is below a specific threshold, corresponding to the score set
in the analysis settings.

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide
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(continued)

Flag Description

Secondary analysis flags

OUTLIERRG | Outlier in replicate group.

AMPNC Amplification in the negative control.

HIGHSD High standard deviation in replicate group.

The AMPNC, BADROX, DRNMIN, NOAMP, NOISE, SPIKE, and OUTLIERRG flags, by default, are not in
use for the gene expression experiment.

For the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL flags are not

reported, but they appear in the QC Summary (by default, a 0 is displayed in the Frequency column for
each flag).

(Optional) Adjust parameters to reanalyze your own experiments

82

The Analysis Settings dialog box displays the analysis settings for the threshold cycle (Cgy), and flags
options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own
experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your

experiment.
View the analysis settings

1. From the Experiment Menu, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab.
® Cy Settings
* Flag Settings

Fiag sectings

[Stage 2, Step 3 v

Save 10 LiDrary Load from Library Revert (0 Defauit Anaysis seitngs [l &pply Anaiyss SeLtings
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3. View and, if needed, change the analysis settings.

See “Adjust analysis settings” on page 83.

You can save changes to the analysis settings to the Analysis Settings Library for later use. See
“Change analysis settings” on page 64.

Click Apply Analysis Settings to apply the current analysis settings.
You can go back to the default analysis settings, by clicking Revert to Default Analysis Settings.

Adjust analysis settings

Adjust Ct settings

Use the Data Step Selection feature to select one stage/step combination for Ct analysis when there is
more than one data collection point in the run method.

Adjust flag settings

Use the Flag Settings tab to adjust flag settings.

1.

Adjust the sensitivity so that more wells or fewer wells are flagged.
Change the flags that are applied by the QuantStudio™ 12K Flex Software.

In the Flag Settings tab, in the Use column, select the checkboxes for flags to apply during
analysis.

(Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying
the flag.

If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the
appropriate setting.

In the Reject Well column, select the checkboxes if you want the software to reject wells with the
flag.

After you have rejected the flagged wells, analysis results depend on factors such as the
experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments
using the Standard Deviation calculations may change the result of Cgr SD. For some flags,
analysis results calculated before the well is rejected are maintained.

In the Analysis Settings dialog box, click Apply Analysis Settings.
If the run status is complete, the data are reanalyzed.
The Flag Settings tab looks like this:
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alysis Settings for Gene Expression Starter Kit Example.eds

Flag Description Use Attribute Condition Value Reject Well
AMPNC |Amplification in negat... O (o g < w |35.000
BADROX Bad passive referenc... O Bad passive referenc... |» w |0.600
DRNMIN Define acceptable de... O cT = w (35.000
DRNMIN Define acceptable de... O Delta Rn = ~ [0.200
OFFSCALE Fluorescence is offscale O
HIGHSD High standard deviati... Cr standard deviation |> + (0.500 O
NOAMP Mo amplification \Amplification algorith... | < + (0.100
NOISE MNoise higher than ot... O Relative noise > v [4.000
SPIKE Noise spikes O Spike algorithm resuft |- + [1.000
NOSIGNAL o signal in well O
OQUTLIERRG Outler i replicate gr... O
EXPFAIL il a a
BLFAIL Baseline algorithm failed| O
THOLDFAIL Thresholding algorith... O
CTFALL C algorithm falled (]
AMPSCORE |AMP Score ] IAMP Score < w [11.240 O

Improve Cgr precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all. These wells
typically produce Cgr values that differ significantly from the average for the associated replicate wells.
If included in the calculations, these outliers can result in erroneous measurements. To enable Cgt
precision, omit the outliers from the analysis.

In the OpenArray™ gene expression example experiment, there are 354 outliers. You can remove these
wells from analysis.

1. From the Experiment Menu, select Analysis » Amplification Plot.
If no data are displayed, click Analyze.

2. In the Amplification Plot, select Plot Type » Cgrt vs Well.
3. Select the Well Table tab.

4. Inthe Well Table, identify outliers.
a. Select Group By » Replicate.

b. Look for outliers in the replicate group (ensure that they are flagged).
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c. Select the Omit checkbox next to outlying well or wells.

# well L Omit Flag Sample ... Target... | Task Dyes CRT CRT Mean CRT SD Amp Sc... | HIGHSD AMPSC... Comme...
2217 Ciift (] 1 HLun Hs001881... UNKNOWN FAM-NFQ-... 27.966 27.876 0.209 1.178 ~
= HLun - Hs00197826_m1
150  A3cé (] 1 HLun Hs001978... UNKNOWN FAM-NFQ-... 26.265 26.944 0.466 1.149
406 A7ce O 1 HLun Hs001978... UNKNOWN  FAM-NFQ-... 27.663 26.944 0.466 1.109
662  Allck O 1 HLun Hs001978... UNKNOWN FAM-NFQ-... 26.596 26.944 0.466 1.160
918 B3c6 O 1 HLun Hs001978... UNKNOWN FAM-NFQ-... 27.248 26.944 0.466 1.167
1174 B7c6 O 1 HLun Hs001978... UNKNOWN H .. 26.720 26.944 0.466 1.129
1430 B11c6 O 1 HLun Hs001978... UNKNOWN 3 26.765 26.944 0.466 1.115
1686 C3c6 o) 1 HLun Hs001978... UNKNOWN - 27.297 26.944 0.466 1133
1942 C7¢6 O 1 HLun Hs001978... UNKNOWN 26.562 26.944 0.466 1.129
2198 C11c6 | 1 HLun Hs001978... UNKNOWN  FAM-NFQ-... 27.381 26.944 0.466 1.130
= HLun - Hs00198357_m1
157  A3ds O 1 HLun Hs001983... UNKNOWN FAM-NFQ-... 27.349 27.500 0.552 1.386
413 A7ds (] 1 HLun Hs001983... UNKNOWN FAM-NFQ-... 28.466 27.900 0.552 1.358
669  Allds | 1 HLun Hs001983... UNKNOWN FAM-NFQ-... 27.194 27.800 0.552 1.348
925  B3ds O 1 HLun Hs001983... UNKNOWN FAM-NFQ-... 27.820 27.900 0.552 1.390
1181 B7d5 (] 1 HLun Hs001983... UNKNOWN FAM-NFQ-... 27.736 27.800 0.552 1.353
1437 B11dS O 1 HLun Hs001983... UNKNOWN FAM-NFQ-... 27.509 27.900 0.552 1342
1693 C3dS O 1 HLun Hs001983... UNKNOWN FAM-NFQ-... 27.748 27.800 0.552 1.385
1949 C7d5 O 1 HLun Hs001983... UNKNOWN FAM-NFQ-... 28.698 27.900 0.552 1.318
2205 C11ds D 1 HLun Hs001983... UNKNOWN  FAM-NFQ-... 28.583 27.900 0.552 1.355
145 A3l D HLun Hs002012... UNKNOWN  FAM-NFQ-... 26.821 26.316 0.368 1.378
401 AJcl O HLun Hs002012... UNKNOWN  FAM-NFQ-... 26.594 26.316 0.368 1.368
857 Allcl O HLun Hs002012... UNKNOWN  FAM-NFQ-... 26.156 26.316 0.368 1.368
913 B3cl O HLun Hs002012... UNKNOWN FAM-NFQ-... 26.246 26.316 0.368 1.363
1169 B7cl ] HLun Hs002012... UNKNOWN  FAM-NFQ-... 26.227 26.316 0.368 1332
1425 Billcl ] HLun Hs002012... UNKNOWN FAM-NFQ-... 25.818 26.316 0.368 1312
1681 C3cl O HLun H5002012... UNKNOWN  FAM-NFQ-... 26.457 26316 0.368 1.383
1937 Cict D HLun Hs002012... UNKNOWN  FAM-NFQ-... 26.731 26.316 0.368 1.340
2193 Clical HLun Hs002012... UNKNOWN  FAM-NFQ-... 25.794 26.316 0.368 1.326
170 A3f2 1 HLun Hs002055... UNKNOWN  FAM-NFQ-... 27.676 28.303 0.564 1.467
426 A2 D 1 HLun Hs002055... UNKNOWN  FAM-NFQ-... 28.769 28.303 0.564 1.453
682 A11f2 O 1 HLun Hs002055... UNKNOWN ~ FAM-NF! 28.310 28.303 0.564 1.446
938 B3f2 O 1 HLun Hs002055... UNKNOWN  FAM-NF 29.002 28.303 0.564 1.469
1194 B7f2 || 1 HLun Hs002055... UNKNOWN FAM-NFQ-... 27.631 28.303 0.564 1.436 o

5. With the outlying well or wells removed from the analysis, click Analyze to reanalyze the
experiment data.

- ()

Note: You can also omit undesirable wells in an experiment from the Plate Layout. To omit a well

from the Plate Layout, right-click the well and select Omit

Export the analyzed data

1. Open the OpenArray™ gene expression example experiment file that you analyzed in Chapter 5,

“Perform the instrument run”.

2. In the Experiment Menu, click £ Export.

Note: To export data automatically after analysis, during experiment setup or before running
the experiment, select the Auto Export checkbox. Auto Export is unchecked for the example
experiment.

3. In the top of the screen, select Format » QuantStudio 12K Flex format.

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide
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4. Complete the Export screen.

Iltem Entry

Export Data To One File

Filter Bookmark Data No

Export File Location <...>:\Applied Biosystems\QuantStudio 12K Flex
Software\experiments

Export File Name Gene Expression Starter Kit
Example QuantStudio export

File Type (*.txt)

Select Data to export/ Select Select the All Fields checkbox or select a specific set of
Content checkboxes.

The completed Export screen should look like this.

[J Auto Export  Format : |QJant5tumn:zmex | Export Data To: @ One File (O Separate Fles  Fiter Bookmark Data : O Yes & No [¥] Open file(s) when export s complete

Export Fie Location: | C:\Applied Biosystems\QuantStudio 12K Flex Software\User Files\expe riments
[SSLL AN lG e ne Expression Starter Kit Example QuantStudio export] File Type: |[] (=.txt) %

[ sample Setup [] RawData [ Amplfication [ Multicomponent

Skip Empty Wels [ Skip Omitted Wels

Select Content Well Well Position | Omit Sample Name | Target Name | Task Reporter Que.

) All Fields 1ALal O He He99999901_s1  UNKNOWN FAM NFQ-H

¥ wet 24132 0 HB He99999905_m1  UNKNOWN FAM HFQ-

/ 3133 O HB He99999909_m1  UNKNOWN FAM NFQ-K

[ Wel Pastion 44124 | HB Hs09999908_m1  UNKNOWN FAM NFQ-H

5AlaS ] HB Hs99999903_m1  UNKNOWN FAM NFQ-k

1 omt 6 Al36 0 HB H09999907_m1  UNKNOWN FAM NFQ-H

7 A7 0 HB HS00609297_m1  UNKNOWN FAM NFQ-H

[¥] samole Name 8 A138 O He Hs00183533_m1  UNKNOWN FAM NFQ-K

9A1b1 ] HB Hs99999906_m1  UNKNOWN FAM NFQ-k

[ Target Name 10A1b2 0 HB Hs00090002_mi  UNKNOWN FAM NFQ-K

B Tk 11163 0 He He99999910_m1  UNKNOWN FAM NFQ-K

12 Alb4 ol He Hs99999911_m1  UNKNOWN FAM NFQ-H

[# Reporter 13A1b5 O HB HS00824723_m1  UNKNOWN FAM NFQ-N

14 Alb6 O HB HS00237047_m1  UNKNOWN FAM NFQ-H

[ Quencher 15 A167 0 He Hs99999904_m1  UNKNOWN FAM HFQ-H

o 16 A168 0 HB HS00172187_m1  UNKNOWN FAM NFQ-H

= 17 Alct O HB HS00201226_m1  UNKNOWN FAM NFQ-K

[ ¢Or Mean 18412 | HB HS00355782_m1  UNKNOWN FAM NFQ-H

19A1c3 ] HB Hs00153277_m1  UNKNOWN FAM NFQ-k

Flcor so 20A1c4 0 He HS00169255_m1  UNKNOWN FAM NFQ-H
[#] Amp Score

[] HIGHSD

[2] AMPSCORE

< >

Start Export Save Export Set As Load Export Set Delete Export Set Export QC Images

When opened in Notepad, the exported file should look like this.
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ion Starter Kit Example_Quant

Fle Edit Format View Help
|- Barcode = GvQl7
* Block Type = opemrray Block
* Chemistry = TAQ
* Comment = NA
* Date Created = 2012-01-20 17:17:43 PM SGT
* Experiment File Name = C:\Docs\OAExamples\GYQl7_2012. 01 11_152902. eds
* Experiment Name = Gene Expresswn starter Kit Examp eds
* Experiment Run End Time = 2012-01-12 09:35:41 AM
* Experiment Type = Gene Expresswn
* Instrument Name = spyder
* Instrument Serial Number = spyder012
* Instrument Type = Quantstudio 12K Flex
* passive reference =
* quantification (yde ME(hud cro
* signal smoothing o
* stage/ Cycle where AnaTyns is performed = stage 2, step 3
* Usel Name = NA
[Results]

well well position omit sample Name Target Name Task  Reporter Quencher cor €IT Mean
Seore  Hiasp  AMPSCORE
1 Alal false HB )1_s1  UNKNOWN FAM NFQ-MGB 6.320  6.484 0.176 1.322 N N
2 Ala2 false HB _ml  UNKNOWN FAM NFQ-MGB 18.942 19.023 0.159 1.205 N Y
3 Ala3 false HB 09_ml  UNKNOWN FAM NFQ-MGB 22.153 22.255 0.141 1.344 N N
4 Alad false HB H: 08_ml  UNKNOWN FAM NFQ-MGB 25.778 25.810 0.227 1.313 N N
5 Alas false HB 03_ml  UNKNOWN FAM NFQ-MGB 17.183 17.310 0.135 1.180 N Y
6 Alab false HB 07_ml  UNKNOWN FAM NFQ-MGB 19.858 19.979 0.114 1.352 N N
7 Ala7 false HB Hs00609297_ml UNKNOWN FAM NFQ-MGB 25.926 26.425 0.277 1.428 N N
8 Alag  false HB HS00183533_ml  UNKNOWN FAM NFQ-MGB 24.597 24.458 0.152 1.337 N N
9 Albl  false HB H599999906_m1  UNKNOWN FAM NFQ-MGB 20.563 20.435 0.094 1.434 N N
10 Alb2  false HB H599999902 M1  UNKNOWN FAM NFQ-MGB 21.273 21.390 0.149 1.409 N N
11 Alb3 false HB H599999910_m1 UNKNOWN FAM NFQ-MGB 25.046 25.457 0.308 1.397 N N
12 Alb4 true HB HS99999911_ml UNKNOWN FAM NFQ-MGB Undetermined N
13 AlbS false HB Hs00824723_ml UNKNOWN FAM NFQ-MGB 19.166 18.987 0.105 1.488 N N
14 Alb6 false HE Hs00237047_ml UNKNOWN FAM NFQ-MGB 24.850 0. 1.248 N N
15 Alb7 false HE H599999904_m1 UNKNOWN FAM NFQ-MGB 19.776 0. 1.296 N N
16 Alb8 false HB H500172187_ml  UNKNOWN FAM NFQ-MGB 23,083 0. 1.314 N N
17 Alcl false HB H500201226_ml UNKNOWN FAM NFQ-MGB 22.695 0. 1.409 N N
18 Alc2 false HB H500355782_ml UNKNOWN FAM NFQ-MGB 23.963 0. 1.148 N Y
19 Alc3 false HB Hs00153277_m1 UNKNOWN FAM NFQ-MGB 20.697 0. 1.431 N N
20 Alcd false HB Hs00169255_m1 ~ UNKNOWN FAM NFQ-MGB 23.494 0. 1.331 N N
21 Alcs false HB Hs00206469_ml  UNKNOWN FAM NFQ-MGB 23.590 [ 1.365 N N
22 Alc6 false HB Hs00197826_ml  UNKNOWN FAM NFQ-MGB 24.141 0, 1.134 N Y
23 Alc? false HB Hs00426752_ml  UNKNOWN FAM NFQ-MGB 24.003 0. 1.413 N N
24 Alcs false HB Hs00362795_g1 UNKNOWN FAM NFQ-MGB 24.515 0. 1.369 N N
25 AldLl false HB H500245445_mL  UNKNOWN FAM NFQ-MGB 24.919 1.370 N N
26 Ald2  false HB HS00152844_ml  UNKNOWN FAM NEQ-MGB 24.702 1.415 N N
27 Ald3  false HB H502596862_g1  UNKNOWN FAM NFQ-MGE 14.721 1.416 N N
28 Aldd  false HB HS00608519_M1  UNKNOWN FAM NFQ-MGB 23.411 1.355 N N
29 AldS false HB HS00198357_ml  UNKNOWN FAM NFQ-MGE 24.663 1.402 N N
30 Aldé false HB Hs01102345_ml  UNKNOWN FAM NFQ-MGB 20. 860 1.458 N N
31 Ald7 false HB Hs00265497_m1 UNKNOWN FAM NFQ-MGB 24.741 . 141 1.445 N N
32 Aldg false HB H500734303_g1  UNKNOWN FAM NFQ-MGB 20.812 20,786 0,057 1.438 N N

CIT SD Amp
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QuantStudio™ 12K Flex OpenArray™ Genotyping Starter Kit

Each QuantStudio™ 12K Flex OpenArray™ Genotyping Starter Kit contains materials that are required
to perform two experiments on the QuantStudio™ 12K Flex Real-Time PCR System, from sample
preparation to data analysis, unless otherwise shown in Table 3 on page 90. The components allow for
a typical setup for two genotyping experiments.

Table 3 Components of the QuantStudio™ 12K Flex OpenArray™ Genotyping Starter Kit

Starter kit (2-20

Source Kit contents Description
components)

QuantStudio™ 12K | 4469605 | * TagMan™ OpenArray™ Genotyping | Contains reagents to

Flex OpenArray™ Master Mix, 2X conduct two real-time

Genotyping Starter e TagMan™ OpenArray™ Genotyping genotyping experiments on

Kit Training Plate, QuantStudio™ 12K the QuantStudio™ 12K Flex
Flex (2 plates) Real-Time PCR System, using

the TagMan™ OpenArray™
Genotyping Training Plate,
QuantStudio™ 12K Flex as an
example.

¢ QuantStudio™ 12K Flex OpenArray™
Accessories Starter Kit (Cat.
No. 4469586)

This kit does not contain

samples.
QuantStudio™ 12K | 4469586 * OpenArray™ Case Lid (6 lids) Contains accessories
Flex OpenArray™ e OpenArray™ Plugs (6 plugs) to assemble TrueMark™
AF:cessorles Starter « OpenAray™ Carriers (1 or 2 carriers) OpgnArray‘M Elate formats fo.r
Kit a single experiment starter Kkit.
® QuantStudio™ Immersion Fluid(6

Each experiment starter kit

syringes) contains this accessories starter
* OpenArray™ Immersion Fluid Tip kit.
* OpenArray™ AccuFill™ System Tips (1 | This kit does not contain
bOX Of 384 t|p5) Samples_
* OpenArray™ 384-well Sample Plate
(10 plates)
* OpenArray™ 384-Well Plate Seals (10
seals)

Plates

The instructions in this document use three types of plates. The plates are described in detail in
Appendix B, “Plate information”.

* MicroAmp™ Optical 96-Well Reaction Plate (96-well plate)
A non-optical 96-well reaction plate can also be used.

* OpenArray™ 384-well Sample Plate (384-well plate, for QuantStudio™ 12K Flex OpenArray™
AccuFill™ System)

* TrueMark™ OpenArray™ Plate (OpenArray™ Plate)
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File formats

The files are used to track your assays and samples. The QuantStudio™ 12K Flex Software (included
with the QuantStudio™ 12K Flex Real-Time PCR System) contains example data files for each starter kit
experiment type.

The instructions in this guide use four types of files.

Sample information file (CSV)— Contains the sample layout information for the plate. Allows input of
Sample IDs. See page 91).

SNP plate file (SPF)—Contains the information for genotyping runs. Allows input of Assay IDs and
thermal cycling protocol. See page 92.

Template file (EDT)—Includes complete setup information (samples, assays and cycling protocol)
saved as a template. See page 93).

Experiment file or data file (EDS)—A complete data file. See page 93.

Additional files (AIF, TXT) are available for selection if you use the batch experiment setup in the
software to create and run your own experiments.

Note: Use the AIF file to assign VIC™ and FAM™ dyes to the correct SNP alleles.

Sample information file (CSV)

We recommend that you create or use a comma-delimited file (CSV) to track your cDNA or gDNA
samples. Use a sample information file to perform these tasks.

Track where samples and controls are located in the 96-well plate. See Chapter 8, “Prepare the
nucleic acid samples”.
Map the sample locations, depending on the TrueMark™ OpenArray™ Plate format being used:
— Map the sample locations from the 96-well plate to the appropriate locations in the 384-well
plate. See Chapter 9, “Prepare the OpenArray™ 384-well Sample Plate”.
— Map the sample locations from the 384-well plate areas to the appropriate locations in each
OpenArray™ Plate. See Chapter 10, “Prepare the TrueMark™ OpenArray™ Plate”.

Associate information about the samples with the data results, to normalize data or compute
standard curves and calculate concentrations.

IMPORTANT! To enable accurate results, you must correctly track sample information from plate to
plate.

For OpenArray™ AccuFill™ Software v2.0, all sample tracking and mapping features are available in this
software. The OpenArray™ Sample Tracker Software is not used for OpenArray™ AccuFill™ Software
v2.0.

OpenArray™ 384-well Sample Plate—Integrate this file with a plate setup file in the OpenArray™
AccuFill™ Software (see “Prepare the plate setup files” on page 107).

TrueMark™ OpenArray™ Plate—Import this file directly into the QuantStudio™ 12K Flex Software
before starting a run (see “Start a run from the software” on page 123, or after the run is complete.
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Note: To track sample information for the starter kit experiments, use the example CSV files supplied
with the QuantStudio™ 12K Flex Software.

Plate setup file (SPF)

92

Use an OpenArray™ Plate setup file

Plate setup files (SPF) contain the assay information for individual OpenArray™ Plate formats, including
the gene symbol, gene name, assay ID, and location of each assay on the plate.

* Use the OpenArray™ AccuFill™ Software to integrate the sample information from a 384-well plate
file (CSV) with the assay information in the plate setup file. See “Prepare the plate setup files” on
page 107.

* Upload the assay information in the plate setup file directly into the QuantStudio™ 12K Flex
Software to create and run an experiment (EDS). See “Start a run from the software” on page 123.

Access the starter kit plate setup files
1. Go to thermofisher.com/OA-platefiles.
2. In the Select your product dropdown list, select TagMan OpenArray Inventoried.
3. Enter the serial numbers, then click Download.

Download your own plate setup files

To process a TrueMark™ OpenArray™ Plate on the QuantStudio™ 12K Flex Real-Time PCR System, you
must download the specific plate files that correspond to your plate and experiment type. Genotyping
experiments use SNP plate files (SPF).

Note:

. The OpenArray™ AccuFill™ Software v2.0 includes a feature to download the SPF files. The computer
running the software must be connected to the internet.

. The OpenArray™ AccuFill™ Software v2.0 includes a feature to create a SPF file from a template.

. For more information about these features, see QuantStudio™ 12K Flex OpenArray™ AccuFill™ System
User Guide (Pub. No. MAN0025669).

1. Go to thermofisher.com/OA-platefiles.

2. Select one of the following options.

e Custom
* |nventoried
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3. Enter the following information.

Product Information

Custom a. Enter the Lot number or Batch number.

b. Enter one Serial number from the lot.

Only one serial number is required. The serial number is used to confirm the lot
number or batch number. All of the files in the lot or batch are downloaded.

Inventoried | Enter the list of Serial numbers or Barcodes. Separate more than one serial number or
barcode with a comma or a line break.

The serial number or barcode entered corresponds to the file that is downloaded. Enter a
serial number or barcode for each file to download.

4. Click Download.

The downloaded files are in a compressed ZIP folder.

Template file (EDT)

An experiment document template file (EDT) contains predefined experiment setup information, such as
experiment type, assay names, and run method.
You can access a template to create a new experiment from the two locations.

* QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen. See “Start a run from the
instrument touchscreen” on page 127.

* QuantStudio™ 12K Flex Software. See “Experiment file (EDS)” on page 93.
To create and run the starter kit experiments, use the example template files supplied with the
QuantStudio™ 12K Flex Software.

The example template files are located at <. . .>:\Program Files (x86)\Applied
Biosystems\QuantStudio 12K Flex Software\templates\OpenArray,where<...>is
the installation drive. The default installation drive is C: if the software is installed by the customer.
The default installation drive is D: if the software is installed by a Thermo Fisher Scientific field
service engineer.

Experiment file (EDS)

An experiment document single file (EDS) is an electronic record used by the QuantStudio™ 12K
Flex Software that contains all information about a particular TrueMark™ OpenArray™ Plate run on the
QuantStudio™ 12K Flex Real-Time PCR Instrument. The EDS file includes the following information.

* Metadata
— Name
- Barcode
— Comments

* Experiment setup
— Well contents

— Assay definitions
* Run method (thermal cycling protocol)
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* Run results

* Analysis protocol

* Analysis results

* Audit records

® Other plate-specific data

Use an EDS file to perform these tasks.

* (Create and run an experiment using the QuantStudio™ 12K Flex Software (see “Start a run from the
software” on page 123).
To create and run the starter kit experiments, use the example template files (EDT, see “Template
file (EDT)” on page 93) supplied with the software.

¢ Create and run an experiment using the QuantStudio™ 12K Flex Real-Time PCR Instrument
touchscreen (see “Start a run from the instrument touchscreen” on page 127).

* Analyze the experiment results in the QuantStudio™ 12K Flex Software (see Chapter 12, “Analyze
the experiment results”).
To view and analyze results for the starter kit experiments, use the example experiment files
supplied with the QuantStudio™ 12K Flex Software.
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Starter kit data files

Use the example files supplied with the QuantStudio™ 12K Flex Software to perform the tasks that are
described in this guide.

Table 4 QuantStudio™ 12K Flex OpenArray™ Genotyping Starter Kit data files referenced in this

guide.
File o . : .
Description File name Location!] Used in
type
SPF | SNP plate - Download (see “Access the starter kit plate Chapter 9,
file setup files” on page 92) “Prepare the
OpenArray™
384-well
Sample Plate”
CSV | 96-well — These files can be generated in the OpenArray™ | Chapter 9,
sample AccuFill™ Software v2.0. “Prepare the
information OpenArray™
file 384-well
Sample Plate”
EDT |Experiment |Genotyping.edt |<.>:\Program Files (x86) \Applied Chapter 10,
template Biosystems\QuantStudio 12K “Prepare the
FlexSoftware\templates\OpenArray TrueMark™
OpenArray™
Plate”
EDS |Experiment |Genotyping <.>:\Program Files (x86)\Applied Chapter 12,
data file Starter Kit Biosystems\QuantStudio 12K Flex “Analyze the
Example.eds Software\examples\Genotyping experiment
results”

[l <> is the drive on which the software is installed. The default installation drive is C : if the software is installed by the customer. The
default installation drive is D : if the software is installed by a Thermo Fisher Scientific field service engineer.
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Workflow

QuantStudio™ 12K Flex OpenArray™ Genotyping Starter Kit

Prepare the nucleic acid samples (page 97)

The workflow for sample preparation varies, depending on starting from the MicroAmp™ Optical
96-Well Reaction Plate using cDNA or your own DNA.

Prepare the OpenArray™ 384-well Sample Plate (page 100)

Track the samples, prepare the PCR mix, and transfer the samples to the OpenArray™ 384-well
Sample Plate.

Prepare the TrueMark™ OpenArray™ Plate (page 104)

® Prepare for sample transfer using 384-well plates.

* Transfer the samples from 384-well plates to TrueMark™ OpenArray™ Plate formats using the
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System.

® Seal the TrueMark™ OpenArray™ Plate formats
* Complete sample transfer for the remaining TrueMark™ OpenArray™ Plate formats.

Perform the instrument run (page 118)
* Prepare the QuantStudio™ 12K Flex Software.
® Load the TrueMark™ OpenArray™ Plate formats into the instrument.
* Run the TrueMark™ OpenArray™ Plate formats.
® (Optional) Monitor the run.
® Unload the TrueMark™ OpenArray™ Plate formats from the instrument.
* Transfer the experiments results to the computer.

Analyze the experiment results (page 136)
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In this chapter, you prepare the nucleic acid samples for your experiment using the QuantStudio™ 12K
Flex OpenArray™ Genotyping Starter Kit.

Workflow

Prepare nucleic acid samples for a genotyping experiment

Measure the gDNA quality and quantity
See “DNA quality” on page 98 and “DNA quantity” on page 98.

Transfer the gDNA samples to a 96-well reaction plate (page 98)

Required materials

IMPORTANT! For the SDS of any chemical not distributed by Thermo Fisher Scientific, contact the
chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer,
and observe all relevant precautions.

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

Item Source
Starting material: human gDNA User-supplied
MicroAmp™ Optical 96-Well Reaction Plate 4316813
DNase-free, sterile-filtered water MLS
ProFlex™ 2 x Flat PCR System 4484078
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DNA quality

DNA that is used with genotyping experiments should have the following characteristics:

* The DNA is extracted from the raw material that you are testing with an optimized protocol. Salting
out procedures and crude lysates are not recommended.

* The DNA does not contain PCR inhibitors.

® The DNA has an Axggo3g ratio between 1.7 and 1.9.

* The DNA has an Axgg/ogo ratio between 1.7 and 1.9.

* The DNA is intact as visualized by gel electrophoresis.

* The DNA has not been heated above 60°C. Temperatures above 60°C can cause degradation.

DNA quantity

We recommend that you quantify and normalize the amount of gDNA in your human DNA samples, for
use with genotyping experiments.

* The recommended amount of template for each single (through-hole) reaction in a TrueMark™
OpenArray™ Plate is 250 copies of the haploid genome, equivalent to 0.84 ng for human DNA
samples.

The recommended starting concentration for human DNA samples is 50 ng/uL to obtain 250 copies
of the haploid genome per through-hole.

* For optimal cluster plot results, it is important to normalize all gDNA samples in an experiment so
that each through-hole receives the same input quantity of sample.
To quantify the amount of gDNA in your human DNA samples, perform one of the following items:
* Generate an Aygg reading using a UV spectrophotometer.
* Generate a Qubit™ dsDNA HS assay reading using a Qubit™ Fluorometer.
¢ Quantification by RNase real-time PCR experiment

See the appropriate instrument or chemistry kit user guide for detailed instructions about performing
the DNA quantitation.

Transfer the gDNA samples to a 96-well reaction plate

To load gDNA samples and controls into a TrueMark™ OpenArray™ Plate, pipet the samples into a
96-well reaction plate.

1. Transfer 5.0 L of the gDNA samples and controls into the appropriate number of wells of a
MicroAmp™ Optical 96-Well Reaction Plate, based on the OpenArray™ Plate format being used.

See Appendix B, “Plate information”.
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Note: For the starter kit experiment, the Format 64 OpenArray™ genotyping plate format is used
to test a maximum of 48 samples against the TagMan™ OpenArray™ Genotyping Training Plate,
QuantStudio™ 12K Flex, a fixed content panel containing 64 TagMan™ SNP Genotyping Assays.

2. (Recommended) Create a sample information file (CSV) to track where the samples are in the
96-well sample plate.
A CSV file can be created in OpenArray™ AccuFill™ Software v2.0.
For more information, see “Sample information file (CSV)” on page 91.

Proceed to Chapter 9, “Prepare the OpenArray™ 384-well Sample Plate”.

Perform your own experiments

When you prepare samples for your own genotyping experiments, note the following modifications.
* For gDNA samples of other organisms, proportionally adjust the starting concentration based on
the organism genome size relative to the human genome size (approximately 3 x 10° base pairs in
the haploid genome)

Note: To obtain the genome size for other species, go to genomesize.com or
cvalues.science.kew.org/.

¢ Transfer 5.0 pL of the gDNA samples and controls into the appropriate number of wells of a
MicroAmp™ Optical 96-Well Reaction Plate, based on the OpenArray™ genotyping plate format
being used. See Appendix B, “Plate information”.
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In this chapter, you use an 8- or 12-channel pipette to transfer the nucleic acid samples from the
96-well reaction plates to OpenArray™ 384-well Sample Plate formats. The plates are described in detalil
in Appendix B, “Plate information”.

You also track the sample locations from the 96-well reaction plates to the appropriate locations in the
384-well sample plates. The workflow for preparing the 384-well sample plate varies, depending on the
starter kit (or experiment type) in use.

Workflow

Prepare the OpenArray™ 384-well Sample Plate

- Track the samples (page 101)

Transfer the samples to the OpenArray™ 384-well Sample Plate and
add the PCR mix (page 102)

Required materials

IMPORTANT! For the SDS of any chemical not distributed by Thermo Fisher Scientific, contact the
chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer,
and observe all relevant precautions.
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Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

Item Sourcel'l
96-well reaction plates, containing prepared gDNA samples| User-supplied (see “Required materials” on
page 97)
2X TagMan™ OpenArray™ Genotyping Master Mix 4404846
OpenArray™ 384-well Sample Plate 4406947
OpenArray™ 384-Well Plate Seals 4469876
Fine-tip marker MLS

[l Provided in starter kit.

Track the samples

Track the samples from the 96-well reaction plates to the 384-well sample plates. For OpenArray™
AccuFill™ Software v2.0, samples are tracked in the OpenArray™ AccuFill™ Software. The samples are
tracked in the Map Plates tab.

For more information about OpenArray™ AccuFill™ Software v2.0, see QuantStudio™ 12K Flex
OpenArray™ AccuFill™ System User Guide (Pub. No. MAN0025669).

Navigate to the Full Run screen.

1. In the Configure design pane, in the Experiment type section, select Genotyping.

2. In the Plate format section, select a format for your experiment.

Experiment type Format
Starter kit experiments Genotyping—64
Your own experiments * Genotyping—16

* Genotyping—32
* Genotyping—64
* Genotyping—128
* Genotyping—192
* Genotyping—256

3. In the Pipettor section, select a type of pipette.

* Fixed

¢ Adjustable

The number of OpenArray™ Plate formats displayed in the Add your OpenArray plate serial
numbers section depends on the selections made in the previous steps.
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4.

10.

In the Add your OpenArray Plate serial numbers section, click Choose File, navigate to the
location of the SPF file, then select the file.

Repeat for each SPF file.

In the Add your sample plates - optional section, click Choose File, navigate to the location of
the CSYV file, then select the file.

If the sample plate file is not imported, the samples must be added manually.
The file must be a CSV file for a 96-well format.

The format of the sample plate file is validated. For information about the required format, see
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User Guide (Pub. No. MAN0025669).

The file name is displayed in the Select file field.
Repeat step 5 for each CSV file.

Click Next.
The Map plates pane is displayed.

(Optional) Add or edit the sample name.

Label the OpenArray™ 384-well Sample Plate with a fine-tip marker.

Based on the tracking information on the Map plates pane, mark the sections of the OpenArray™
384-well Sample Plate to transfer samples from the 96-well reaction plates.

Click Next.

The Start run pane is displayed.

Set up the samples in the OpenArray™ 384-well Sample Plate, then prepare to load the OpenArray™
Plate formats in the QuantStudio™ 12K Flex OpenArray™ AccuFill™ System.

Transfer the samples to the OpenArray™ 384-well Sample
Plate and add the PCR mix

Thaw the 96-well reaction plate containing prepared gDNA samples at room temperature.

102

1.

3.

Vortex the gDNA samples to mix, then centrifuge for 1 minute at 1,000 x g to collect the contents
at the bottom of the tube.

Review the concentration of the normalized gDNA samples. The recommended starting
concentration for human gDNA samples is 50 ng/pL.

Note: For optimal results, normalize all gDNA samples in an experiment. For human gDNA,

ensure that the samples are close to the recommended starting concentration of 50 ng/pL. For
gDNA samples of other organisms, proportionally adjust the starting concentration based on the
organism’s genome size relative to the human genome size (approximately 3 x 109 base pairs in the
haploid genome).

Mix the 2 X TagMan™ OpenArray™ Genotyping Master Mix by gently inverting the bottle 10 times.
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4. Load the OpenArray™ 384-well Sample Plate based on the plate layout.
See “Track the samples” on page 101.
a. Add the master mix to the 384-well sample plate.

b. Using a 12-channel pipette, transfer the normalized gDNA samples from the 96-well reaction
plate to the 384-well sample plate.

Volume per 384-well sample plate welll']

Component 5
F_ormat 64 (starter kit Format 16 | Format 32
experiment) and larger formats
2X TagMan™ OpenArray™ Genotyping 2.5uL 1.5puL 2.0pyL
Master Mix
Normalized gDNA sample(human 2.5uL 1.5 2.0 puL
gDNA starting concentration =
50 ng/ulL)
Total volume 5.0 L 3.0 yL 4.0 yL

[l One well of a 384-well sample plate corresponds to one subarray of a TrueMark™ OpenArray™ Plate . The number of
subarrays required depends on the format of the TrueMark™ OpenArray™ Plate. For more information, see Appendix B,
“Plate information”.

5. Seal the sample plate, vortex gently to mix, then centrifuge for 1 minute at 1,000 x g to eliminate
bubbles and to collect the contents at the bottom of the wells.

6. Place the sample plate on ice for up to 1 hour.

Proceed to Chapter 10, “Prepare the TrueMark™ OpenArray™ Plate”.
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In this chapter, you use the QuantStudio™ 12K Flex OpenArray™ AccuFill™ System to transfer the
nucleic acid samples from the OpenArray™ 384-well Sample Plate to the TrueMark™ OpenArray™ Plate.
The workflow is the same for all OpenArray™ Plate formats.

Workflow

Prepare the TrueMark™ OpenArray™ Plate

- Prepare for sample transfer (page 106)
. Transfer the samples (page 108)

Seal the TrueMark™ OpenArray™ Plate (page 114)

Required materials

IMPORTANT! For the SDS of any chemical not distributed by Thermo Fisher Scientific, contact the
chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer,
and observe all relevant precautions.
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Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

ltem Source
TrueMark™ OpenArray™ Platel!] See Appendix A, “Ordering
information”.
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System 4471021
QuantStudio™ 12K Flex OpenArray™ Accessories Starter Kit 4469586

The accessories kit contains:
* OpenArray™ Case Lid (6 lids)
* OpenArray™ Plugs (6 plugs)
* OpenArray™ Carriers (2 carriers)
* QuantStudio™ Immersion Fluid (6 syringes)
* OpenArray™ Immersion Fluid Tip
* OpenArray™ AccuFill™ System Tips (1 box of 384 tips)
* OpenArray™ 384-well Sample Plate (10 plates)
* OpenArray™ 384-Well Plate Seals (10 seals)

QuantStudio™ 12K Flex OpenArray™ Plate Press 2.0 A24945
Foil seals MLS
Bleach (10%) MLS
Ethanol MLS
Fine-tip marker MLS
Razor blade MLS
Powder-free gloves MLS
Laboratory-grade wipes MLS
Safety glasses MLS
Tweezers or forceps (for removing foil sections from the 384-well sample plate) MLS

' For more information, see Appendix B, “Plate information”.
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Storage conditions

The following materials require special storage conditions.

Item Storage

TrueMark™ OpenArray™ Plate Frozen, unopened | Store at —20°C until the expiration date provided on
the product label.

Thawed, unopened | Store at room temperature for up to 24 hours.

Thawed, opened | Store at room temperature for up to 1 hour.

Loaded and Store at room temperature, protected from light, for
sealed, pre-run | up to 24 hours.

OpenArray™ Immersion Fluid Unopened Store at room temperature until the expiration date
provided on the product label.

Opened Store at room temperature. Do not store any
remaining immersion fluid. Use the amount required,
then discard the remainder.

OpenArray™ AccuFill™ System Unopened Store at room temperature until the expiration date
Tips printed on the cardboard box.
Opened Store at room temperature. Use tips within one week.

Prepare for sample transfer

Guidelines for handling the OpenArray™ Plate

IMPORTANT! Wear powder-free gloves while preparing the OpenArray™ Plate.

* Hold the OpenArray™ Case by the edges.

¢ Do not touch the through-holes of the OpenArray™ Plate.

* Load and seal an OpenArray™ Plate within one hour after opening the package.

* |f you drop a loaded OpenArray™ Plate, discard it in the appropriate waste container.
¢ Do not reinsert an OpenArray™ Plate if it becomes dislodged from the case.

Prepare the equipment and plates

Ensure that the OpenArray™ 384-well Sample Plate, the OpenArray™ AccuFill™ System Tips, and
OpenArray™ Plate holder are completely clean and dry.

1. Remove an OpenArray™ Plate from the freezer, but do not open the packaging. Allow the plate to
thaw at room temperature (approximately 15 minutes).

2. Prepare a syringe containing OpenArray™ Immersion Fluid.
a. Remove the cap from the syringe containing OpenArray™ Immersion Fluid.
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b. Remove the cap and attach the tip to the syringe. Place the assembly on a clean surface.

@ OpenArray™ Immersion Fluid
@ Cap (remove)
@ Syringe tip (attach)

3. Score or cut the foil seal of the OpenArray™ 384-well Sample Plate into the 8 sections shown
below, then place the plate on ice to keep the samples cold.
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Prepare the plate setup files

* OpenArray™ AccuFill™ Software v2.0 allows the transfer of samples without a sample plate file. The
QuantStudio™ 12K Flex Instrument requires a sample plate file if the real-time PCR run is started
with an SPF file or an EDT file.

* For your own genotyping experiments, the following plate setup files can be used to transfer
samples with the OpenArray™ AccuFill™ Software

— OpenArray™ 384-well sample information file (CSV, see “Track the samples” on page 101)
— OpenArray™ plate setup file (SPF, see “Use an OpenArray™ Plate setup file” on page 92)

* (Optional) If you created a CSV file in the OpenArray™ AccuFill™ Software (see “Track the samples”
on page 101), you can import the sample information in this file directly into the QuantStudio™ 12K
Flex Software before starting the run, or after the run is complete.
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Transfer the samples

Start the system

Note: If the samples were tracked immediately before this section, the system might be on (see “Track
the samples” on page 101). The sample tracking and sample transfer functions are both done with
OpenArray™ AccuFill™ Software if OpenArray™ AccuFill™ Software v2.0 is used.

IMPORTANT! To safely operate the instrument, keep the deck clear and have enough room in the
waste bin to eject the used pipette tips. See “Set up the system” on page 37.

The instrument does not initiate a self-test immediately after starting the software. A self-test is initiated
the first time that one of the following items is clicked after starting the software:

¢ Full Run
* Quick Run
* Service » Diagnostics

The other features in the software can be accessed after starting the software without a self-test.

1. Ensure that the instrument door is closed.

2. Power on the instrument, if it is off.

3. Start the OpenArray™ AccuFill™ Software (|
The software checks the computer and connections as the system starts.

Proceed to set up the system.

Set up the system

IMPORTANT! To safely operate the instrument, keep the deck clear and have enough room in the
waste bin to eject the used pipette tips.

1. Open the instrument door, empty the waste bin, then place the waste bin back on the instrument
deck.

CAUTION! Wear appropriate personal protective equipment while handling the waste bin.

2. Ensure that the sample plate holder and the OpenArray™ Plate holders are empty.

3. Place the sample plate in the sample plate holder on the instrument deck, with the notch to the
left. Do not stack sample plates.

4. Place each OpenArray™ Plate in an OpenArray™ Plate holder.
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5. Replace the tip boxes, if necessary.
Each tip box contains 384 tips, divided into 8 sections.

When setting up a run, the status of the tip boxes is confirmed in the software. A full tip box is
recommended when starting a run.

6. Remove the cover from each tip box.
Ensure that the tip box covers are removed from the instrument deck.

IMPORTANT!
. Do not reuse tips.

. Use tips within one week of opening the box.
. Discard any unused tips within one week.

7. Close the instrument door.

The system is ready to start a run. A self-test is initiated the first time that one of the following items is
clicked after starting the software:

¢ Full Run
¢ Quick Run
* Service » Diagnostics

Verify the run setup and start the run

1. Click each tip box section so that the status on the Verify and start run pane matches the
physical tip box in the instrument.
We recommend starting the run with full tip boxes. The instrument does not start the run if there
are not enough tips on the deck.

Update the state of the tip boxes
(1) Section of the tip box that is full.

@ Section of the tip box that is empty.

2. (Optional) Click Auto-fill tip boxes.
The status of all sections of the tips boxes is set to full.

3. Select the first section of the sample plate to be used to fill the OpenArray™ Plate.

Select the first section of the sample plate if multiple plates are filled during a run. The software
selects the total number of sections that correspond with the total number of plates.

In the following example, section 5 was selected. The group of sections 5, 6, 7, and 8 is highlighted
by the software because four plates are being filled.
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The position box displays the color that corresponds to the section of the sample plate.

Select the sample platelarea to begin

1

Oianrray plate name and position

W

@ Sample plate section (section 5, 6, 7, and 8 are highlighted).
(2 Corresponding plates.

4. Remove the foil from the appropriate sections of the sample plate, then click the checkbox to
confirm.

Remove the foil only from the sections of the sample plate that are used to load a single
OpenArray™ Plate.

Note: Do not remove the foil from all the sections of the sample plate at once.

5. Close the instrument door.

6. Click Start Run.
The run does not begin under any of these conditions.
* The waste bin is not in position.
* The sample plate is not in position.
* The plates are not in position.

* There are more plates on the instrument deck than are defined in the experiment setup.

The Deck screen is displayed.

For a description of the run progress, see QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User
Guide (Pub. No. MAN0025669).

IMPORTANT! Each OpenArray™ Plate must be prepared for PCR immediately after it is filled (see “Seal
the TrueMark™ OpenArray™ Plate” on page 43).
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Remove the OpenArray™ Plate from the OpenArray™ AccuFill™ Instrument

After an OpenArray™ Plate is filled, the Remove plate and foil dialog box is displayed (see Figure 4).

Remove plate & foil X
Step 1 Step 2
Remove OpenArray Plate 1 and promptly seal the plate Confirm foil is removed from highlighted plate

with the adhesive lid, and fill with immersion fluid.

(-]
E
3

I
N
sy}
~
2]

—
—

Figure 4 Remove plate and foil dialog box.

@ OpenArray™ Plate to remove from the instrument.
@ Confirm foil is removed from highlighted plate section checkbox.

Remove each OpenArray™ Plate immediately after it has been filled, even if the run was set up to fill
multiple plates.

After the last OpenArray™ Plate in the run is filled, the Remove plate dialog box is displayed (see
Figure 5).
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Remove plate X

Remove OpenArray Plate 2 and promptly seal the plate with
the adhesive lid, and fill with immersion fluid.

Figure 5 Remove plate dialog box

@ OpenArray™ Plate to remove from the instrument

1.

Open the instrument door and remove the OpenArray™ Plate that is indicated by the blue box in
the dialog box.

IMPORTANT! Remove the OpenArray™ Plate immediately, to avoid evaporation within the plate.

One of the following dialog boxes is displayed:
* The Remove plate and foil dialog box.
* The Remove plate dialog box (after the last OpenArray™ Plate is filled).

Seal the case and fill the OpenArray™ Plate with immersion fluid.
(For Remove plate and foil dialog box only) Remove the foil seal from the next section of the

sample plate, then select the checkbox to confirm that the foil is removed from the section of the
plate that is highlighted.

Note: Remove the foil only from the next section of the sample plate. Do not remove the foil from
all sections of the sample plate.

Close the instrument door.
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5. Click Done.
The run does not proceed under any of the following conditions:
* The waste bin is not in position
* The sample plate is not in position
* The plates are not in position

* There are more plates on the instrument deck than are defined in the experiment setup
The instrument proceeds to load the next OpenArray™ Plate.
6. Repeat step 1 to step 5 for each OpenArray™ Plate to be loaded.
After all of the plates have been loaded, the Deck screen displays Run completed successfully.
Empty the waste bin before performing another run.

A loaded SPF is generated for each OpenArray™ Plate. The loaded SPF file corresponds to the original
SPF file that was imported for the run. The files are exported to the folder that was designed in the
Preferences.

Note: Some workflows might not generate a loaded SPF file. For more information about the workflows
available for the OpenArray™ AccuFill™ Software v2.0, see QuantStudio™ 12K Flex OpenArray™
AccufFill™ System User Guide (Pub. No. MAN0025669).
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Seal the TrueMark™ OpenArray™ Plate

IMPORTANT! Throughout this procedure, handle the OpenArray™ Plate and the OpenArray™ Case only
by the edges.

Note: The OpenArray™ Case consists of the sealed OpenArray™ Plate and the OpenArray™ Lid.

1.

114

Place the newly loaded OpenArray™ Plate in the QuantStudio™ 12K Flex OpenArray™ Plate Press
2.0.

Ensure that the barcode is facing left and the serial number is facing right.

From the OpenArray™ Lid, remove the clear protective film from the inside of the lid (D and the red
adhesive-protective strip @) from around the edge of the lid.

Figure 6 OpenArray™ Lid

@ Protective film on inside of the lid (remove before sealing)

@ Red adhesive-protective strip (remove before sealing)

@ Protective film on the outside of the lid (remove before running)
@ Notched end (align with serial number on plate)

Place the lid in the Plate Press using the alignment pins of the Plate Press for orientation.

IMPORTANT! The notched end of the case lid must be oriented towards the furthest back
right-side of the Plate Press.

@ OpenArray™ case lid
(® Notched end of lid
(@) Serial number of plate
@ OpenArray™ Plate

@ Barcode of plate

@ Alignment pins
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4. Seat the lid on the OpenArray™ Plate with the lid adhesive against the plate.

5. Engage the press mechanism until the green flashing light changes to a steady green light (after
20 seconds).

The status light turns solid green, indicating that the case is sealed.

Note: Do not apply additional pressure onto the Plate Press during its actuation.

6. Disengage the press and carefully remove the OpenArray™ Case.

7. Prepare the immersion fluid. Remove the cap, insert the accompanying syringe tip, and prime the
syringe by ejecting a small amount of immersion fluid onto a paper towel to ensure no air gap
remains in the newly attached pipette tip.

IMPORTANT! If the syringe is not primed, the direct burst of air and fluid can negatively affect the
assay(s) at the end of the array.

8. While holding the case upright by its edges at a 15-30 degree angle so that the port is at the
highest point of the array, insert the prepared syringe tip into the port in the case.
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9. Slowly inject the OpenArray™ Immersion Fluid until the case is filled, which should take about 10
seconds to fill. Minimize the creation of additional air bubbles when you dispense the fluid. Leave a
small air bubble as shown below.

IMPORTANT! If injected too quickly, the fluid can flush out the samples that are suspended in the
through-holes.

Overfilling the array and/or not leaving a small bubble may cause a leak during the PCR run.

10. While holding the case vertically, remove the syringe tip, insert the screw end of the OpenArray™
plug into the port of the case, then rotate clockwise until the black handle breaks off.

Note: Ensure that you are screwing the plug in at the same angle the case base is at. If it is off, it
can cause the plug to break off prematurely.

IMPORTANT! To avoid leaking of immersion fluid, hold the case vertically and rotate the plug
slowly to avoid cross-threading.

If the plug handle breaks off prematurely, use a Phillips #0 screwdriver to complete this step. Do
not overtighten. If plastic or adhesive remains attached to the screw due to premature breakout of
the plug handle, remove it with forceps prior to loading it into the instrument.

11. If needed, clean the case with the lint-free cloth included with the OpenArray™ Plate or a laboratory
wipe that has been thoroughly sprayed with ethanol, then dry the case with a clean laboratory

wipe.

The plate is ready for PCR.

Note: For genotyping experiments, you can store loaded and sealed plates at room temperature,
protected from light, for up to 24 hours.

Proceed to Chapter 11, “Perform the instrument run”.
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Guidelines for high-throughput loading

For optimal efficiency during and after loading large numbers (more than 6) of OpenArray™ Plates, follow
these guidelines.

To help avoid mistakes when entering sample information in the OpenArray™ AccuFill™ Software,
load the OpenArray™ Plates in alphanumeric order (according to the OpenArray™ Plate serial
number).

Seal each OpenArray™ Plate immediately after loading is completed, while the other OpenArray™
Plates are loaded.

IMPORTANT! To avoid evaporation, seal the OpenArray™ Plate with the QuantStudio™ 12K Flex
OpenArray™ Plate Press 2.0, add the OpenArray™ Immersion Fluid, plug the case, then place the
case in a vertical position.

Use the OpenArray™ Carriers to transport up to four loaded OpenArray™ Plates to the QuantStudio™
12K Flex Instrument.

After loading is complete, you can use a large bin to properly discard any used OpenArray™
AccuFill™ System Tips.

For cleaning procedures, see QuantStudio™ 12K Flex OpenArray™ AccufFill™ System User Guide
(Pub. No. MAN0025669).
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In this chapter, you run the QuantStudio™ 12K Flex TrueMark™ OpenArray™ Plate formats on the
QuantStudio™ 12K Flex Real-Time PCR System. During the run, the system performs thermal cycling (if
the experiment includes ampilification) and collects fluorescence data. The workflow is the same for all
OpenArray™ Plate formats.
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Workflow

Perform the instrument run

- Prepare the QuantStudio™ 12K flex software (page 119)

Load the TrueMark™ OpenArray™ Plate into the instrument
(page 199)

. Run the OpenArray™ Plate formats (page 122)
(Optional) Cycle offline genotyping experiments (page 129)

(Optional) Monitor experiments (page 130)

Unload the TrueMark™ OpenArray™ Plate from the instrument
(page 133)

(Optional) Transfer experiment results (page 133)

Prepare the QuantStudio™ 12K flex software

(Optional) Select OpenArray™ block run preferences

Preferences provide user-access to the settings that govern how the QuantStudio™ 12K Flex Software
functions. This section summarizes only those preferences that apply to experiments with OpenArray™
Plate formats.

For detailed information about the preferences, see the QuantStudio™ 12K Flex Software Help (click €
or press F1).

1. Double-click Bl (QuantStudio™ 12K Flex Software shortcut) to start the software.

2. In the toolbar, click Tools » Preferences, then select the OpenArray tab.
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3. Complete the tab, as needed.

Settings Description

Setup Folder Define the absolute path to the default folder from which the software
imports experiment setup files. The Import dialog box opens to the import
folder when invoked from the software.

Experiment Folder Define the absolute path to the default folder to which the software reads or
writes experiment files. The Open and Save dialog boxes open to the data
folder when invoked from the software.

Passive Reference Define the dye to use as the passive reference. The default is set to None.
While the software requires a selection, a passive reference dye is

not used to normalize fluorescence signals collected during OpenArray™
experiments.

Default Browse File Type | Define the file type that the Import, Open, and Save dialog boxes select by

list default when invoked from the software.

Apply experiment If selected, the software applies the Run Method defined in the selected
template (EDT) to all experiment template (EDT) to all OpenArray™ experiments. For more
OpenArray experiment | information about OpenArray™ experiment templates, see the software
checkbox help.

Always include (Genotyping experiments only) If selected, the software adds an

Amplification stage for | Amplification stage to the Run Method for all OpenArray™ genotyping
Genotyping experiment | experiments.

checkbox If deselected, you must perform amplification on another instrument. For
more information about Run Method settings, see the software help.

Always include Pre- (Genotyping experiments only) If selected, the software adds a Pre-Read
Read stage for stage to the Run Method for all OpenArray™ genotyping experiments. For
Genotyping experiment | more information about Run Method settings, see the software help.
checkbox

4. Click OK to save your changes and close the Preferences dialog box.

IMPORTANT! You must restart the software for preference changes to take effect.

Access the Instrument Console

120

The Instrument Console displays every QuantStudio™ 12K Flex Real-Time PCR Instrument discovered
on a network, divided into groups. A group is a way to organize your instruments. By default, there are
two groups.

®* On the Network—All instruments available on the network.

* My Instruments —Instruments you have selected to monitor.

To start and monitor a run on an instrument, you must move the instrument from the On the Network
group to the My Instruments group or a custom group that you create.

To access the Instrument Console and enable monitoring of a networked instrument:
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1. Double-click E

(QuantStudio™ 12K Flex Software shortcut) to start the software.

2. On the Home tab, from the Tools menu, select Instrument Console.
If you do not see an instrument, click Refresh in the Instrument Console toolbar.

@2 Fosmiratsitoz (2]

Dispay Group: IR v Al states v Instrument Status: READY

My Instruments (1) My Instruments

] el
READY Uniform...[09-01-201... |ADMINIST.... Expired
@ Dye
lae ]
g 4 4 4@
285830002 00025 SoAGUSAKIDO soyceroos ToalGesforBlod 0 |
oune onre onE oune TowDegeesforBok o |
[vae ]

Instrument Label Juo
Seral Number [FoSMRAJS1L02
Instrument Frmware Ver...
1P Address 172.28.1.136
Bock Type [384-Wel Block
Controller Firmware Verson|0.20.2

Optics Fimware Verson _ (65535
Thermal Block Frmware ... |25

Heated Cover Frmvare ... |25

3. If needed, move an instrument from the On the Network group to a group that can be monitored:

a. Click the instrument of interest, then click Assign to Group in the Instrument Console
toolbar.

b. Select the My Instruments group or a personal group in the drop-down list.

Note: Alternatively, you can select the icon of the instrument that you want to add to the My
Instruments list, then click Add to My Instruments. Similarly, click Remove from My Instruments

to remove an instrument from the My Instruments list. You can also drag and drop the instrument icon
into My Instruments or into the group created by you.

The instrument is now monitored. The status is indicated by an icon in the upper right corner. For
detailed information about the Instrument Console, see the QuantStudio™ 12K Flex Software Help
(click € or press F1).
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Enable or change the notification settings

You can configure the QuantStudio™ 12K Flex Software to alert you by email when the QuantStudio™
12K Flex Real-Time PCR Instrument begins and completes a run, or if an error occurs during a run.

Note: For details on using the notification settings feature, see QuantStudio™ 12K Flex Real-Time PCR
System v1.6 or later Maintenance and Administration Guide (Pub. No. MAN00O18832).

Load the OpenArray™ Plate into the instrument

VAN CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the sample block
&= temperature can reach 100°C. Allow it to cool to room temperature before handling.

IMPORTANT! Wear powder-free gloves when you handle the OpenArray™ Plate.

IMPORTANT! The instrument should be loaded and unloaded only by operators who have been
warned of the moving parts hazard and who have been adequately trained.

1. Open the plate adapter on the instrument. Touch & on the QuantStudio™ 12K Flex Real-Time PCR
Instrument touchscreen, or click Open Door in the Instrument Console of the QuantStudio™ 12K
Flex Software, to allow the plate adapter to come out from the instrument side.

2. Remove the clear protective film from the outside of the OpenArray™ Case (sealed plate + lid).

3. Place the OpenArray™ Plate or plates on the plate adapter.
* Ensure that each plate is properly aligned in the plate adapter.
* Ensure that the plate barcode is facing up and toward the front of the instrument.

4. Close the plate adapter on the instrument. Touch & on the instrument touchscreen, or click
Close Door in the Instrument Console of the software, to retract the plate adapter back into the
instrument.

Run the OpenArray™ Plate formats

You can run TrueMark™ OpenArray™ Plate formats in two ways.
* From the QuantStudio™ 12K Flex Software. See “Start a run from the software” on page 123.

* From the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen. See “Monitor an
experiment from the instrument touchscreen” on page 131.

Note: The starter kit experiments in this guide run OpenArray™ Plate formats from the QuantStudio™
12K Flex Software.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the
QuantStudio™ 12K Flex Real-Time PCR Instrument is in operation.
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Start a run from the software

There are two ways to create and run an OpenArray™ experiment (EDS) from the QuantStudio™ 12K Flex
Software.

* For the starter kit experiments, use a template file (EDT). See “Use a template file” on page 123
* For your own experiments:
— Use a template file (EDT). See “Use a template file” on page 123.

— Use an OpenArray™ plate setup file (SPF). See “Use an OpenArray™ Plate setup file” on
page 126

— Use the Batch Experiment Setup Utility. See the QuantStudio™ 12K Flex Software Help (click
€ or press F1)

Use a template file

You can use a template file (EDT) to create a new OpenArray™ experiment, then import the sample and
assay information for an OpenArray™ Plate or plates before starting the run, or after the run is complete.

1. Double-click Bl (QuantStudio™ 12K Flex Software shortcut) to start the software.

2. Onthe Home tab, select = Create From Template.

3. Navigate to and select the template file (EDT) that you want to use, then click Open.
A new experiment is created using the setup information from the template.

Note: To access the starter kit templates, navigate to the templates folder located at
<...>:\Program Files (x86)\Applied Biosystems\QuantStudio 12K Flex
Software\templates

where <. . .> is the installation drive. The default installation drive is C: if the software is installed
by the customer. The default installation drive is D: if the software is installed by a Thermo Fisher
Scientific field service engineer.

4. In the Experiment Properties screen, scan the OpenArray™ Plate barcode or type the OpenArray™
Plate serial number.

5. In the Samples screen, do either of the following:

* (Recommended) Click Import above the sample table, navigate to and select the OpenArray™
sample information file (CSV) that you want to use, then click Select File.

For the genotyping starter kit experiments, use the OpenArray™ CSV files that were created in
OpenArray™ AccuFill™ Software v2.0. (see “Track the samples” on page 101).

* In the sample table, click in a cell in the Sample Name column, then enter a new name.
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6. From the open experiment, select File » Import Plate Setup.

a. Click Browse, navigate to and select the genotyping starter kit plate setup file that you want
to use.

Genotyping Source File (SPF)—Corresponds to the plate setup file associated with
genotyping OpenArray™ Plate formats.

For the genotyping starter kit experiments and for your own experiments, download the
appropriate plate setup files from the Thermo Fisher Scientific website. See “Plate setup file
(SPF)” on page 92.

b. Click Select, then click Start Import.

c. If your experiment already contains plate setup information, the software asks you to replace
the plate setup with the data from the file. Click Yes to replace the plate setup information.

7. Select File » Save As, enter a file name, select a location for the experiment file (EDS), then click
Save.

Proceed to “Start the OpenArray™ run” on page 124.

Start the OpenArray™ run

Ensure that the default browse file type is set to EDS. See “(Optional) Select OpenArray™ block run
preferences” on page 119.

1. Double-click El

(QuantStudio™ 12K Flex Software shortcut) to start the software.

2. On the Home tab, from the Run menu, select ¥ OpenArray.

[x)|

Load the the instrument. Select the sewp fies, (2

@

Select Instrument

FOSMIRAJS1L02

RunType: N/A
ReagentType: N/A

OpenArmay 1: * Setup Fie :

OpenArmay 2 * Setup Fie :

OpenArmay 3: * Setup Fie :

OpenArray 4 * Setup Fie :

* Experiment Fie Name

» Cancel

Note: Be sure to add an instrument to My Instruments in the Instrument Console before you run
an experiment. See “Access the Instrument Console” on page 48. If no instrument is selected, a
warning appears.
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i ) There are no instruments available.
\/ Go to the Instrument Console and add at least one instrument to My Instruments.

3. In the Select Instrument pane, select the instrument that you want to use to run the experiment.

4. Complete the Setup OpenArray Run pane.

¢ Click Get Plate IDs to import the barcode of the OpenArray™ Plate formats that you want to
run.

* (Optional) Click Confirm Plate Centers to view the center of the OpenArray™ Plate formats
that you want to run. For each plate image in the Confirm OA Plate Centers dialog box, click
Continue if the red box is aligned to the center of the plate. If the box is not in the center of
the plate, click OK, eject the carrier, rearrange the plates, then click Get Plate IDs.

* (Optional) Click Browse, then navigate on your computer to select the appropriate setup files.
The setup file was created in “Use a template file” on page 51.

Depending on the number of OpenArray™ Plate formats loaded in the instrument, the barcodes of
those plates are populated.

IMPORTANT! If the QuantStudio™ 12K Flex Real-Time PCR Instrument does not detect a
barcode, repeat the barcode read.

5. Click Start Run.
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Use an OpenArray™ Plate setup file

The OpenArray™ AccuFill™ Software integrates the sample information into an OpenArray™ Plate setup
file (SPF). You can save the newly created Loaded_spf files to the OpenArray™ Plate File Input Folder
that you selected in the Preferences dialog box of the OpenArray™ AccuFill™ Software. Configure this
location in the QuantStudio™ 12K Flex Software preferences to upload the integrated plate setup file
into the QuantStudio™ 12K Flex Software, then run the file.

Note: You can import a CSV file into the QuantStudio™ 12K Flex Software before starting the run, or
after the run is complete.

1. Double-click B (QuantStudio™ 12K Flex Software shortcut) to start the software.

2. On the Home tab, from the Run menu, select @ OpenArray.

x|

Load the the nstument the setp fes, 6
@ P (7]

Select Instrument

FOSMIRAJS1L02

Setup OpenArray Run
R RunTipe: WA
Reagent Type: N/A

OpenArmay 1: * Setup Fie : * Experiment File Location :
* Bxperi

File Name :

OpenArmay 2 * Setup Fie : * Experment File Location :
* Experiment File Name

OpenArmay 3: * Setup Fie : * Experment File Location :
* Experiment File Name

OpenArmay 4 : * Setup Fie : * Experment Fie Location :

* Experiment File Name

Note: Be sure to add an instrument to My Instruments in the Instrument Console before running
an experiment. See “Access the Instrument Console” on page 120. If no instrument is selected, a
warning appears.

i There are no instruments available,
\) Go to the Instrument Console and add at least one instrument to My Instruments.

3. In the Select Instrument pane, select the instrument that you want to use to run the experiment.
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4. Complete the Setup OpenArray Run pane.

¢ Click Get Plate IDs to import the barcode of the OpenArray™ Plate formats that you want to
run.

* (Optional) Click Confirm Plate Centers to view the center of the OpenArray™ Plate formats
that you want to run. For each plate image in the Confirm OA Plate Centers dialog box, click
Continue if the red box is aligned to the center of the plate. If the box is not in the center of
the plate, click OK, eject the carrier, rearrange the plates, then click Get Plate IDs.

* (Optional) Click Browse, then navigate on your computer to select the appropriate
OpenArray™ Plate setup files (SPF or TPF).

Note: When the setup file is selected, Experiment File Location and Experiment

File Name are populated. To set the default Experiment File Location, go to

Tools » Preferences » OpenArray » Experiment Folder. In the Setup OpenArray Run pane,
to select another location for the experiment file, click Browse. You can also enter an
experiment file name of your choice.

Depending on the number of OpenArray™ Plate formats loaded in the instrument, the barcode of
those plates is populated.

IMPORTANT! If the QuantStudio™ 12K Flex Real-Time PCR Instrument does not detect a
barcode, repeat the barcode read.

5. Click Start Run.

Start a run from the instrument touchscreen

There are three ways to start a run from the QuantStudio™ 12K Flex Real-Time PCR Instrument
touchscreen:

e “Start a run on the instrument touchscreen from an existing experiment” on page 127
® “Start a run on the instrument touchscreen from a template” on page 128
e “Start a run on the instrument touchscreen from a shortcut” on page 128

Note: The starter kit experiments in this guide start a run from the QuantStudio™ 12K Flex Software.

Start a run on the instrument touchscreen from an existing experiment

1. Touch the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen to activate it.
If the touchscreen is not at the Main Menu screen, touch EJ (Home).

2. In the Home screen, touch Run OpenArray Plates.
The instrument retrieves the barcodes and scans for existing experiments with the same barcodes.

3. If experiments with the same barcode cannot be found, touch Source Input to select a template to
use.
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4. Touch ki (Start Run Now) to start the run.

IMPORTANT! If the instrument does not detect a barcode, repeat the barcode read. If the
barcode is detected incorrectly, type the correct barcode number on the instrument touchscreen.
Do not proceed if a barcode is not detected by the instrument.

Start a run on the instrument touchscreen from a template

1. Touch the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen to activate it.

Note: If the touchscreen is not at the Main Menu screen, touch [ (Home).

2. In the Home screen, touch (View Templates).

3. Inthe View Templates screen, touch & (Folders) to display the folders containing the template
files.

4. Touch any of the folders to display the templates in that folder.

5. In the View Templates screen, select the desired template, then touch s (Start Run).

The instrument retrieves the barcodes and creates new experiments based on the template for
each plate found.

6. Touch kasiid (Start Run Now) to start the run.

Start a run on the instrument touchscreen from a shortcut

1. Touch the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen to activate it.
If the touchscreen is not at the Main Menu screen, touch g (Home).

2. In the Home screen, touch any of the shortcuts that have been set to an OpenArray™ template.

The instrument retrieves the barcodes and creates new experiments based on the template for
each plate found.

3. Touch kasiid (Start Run Now) to start the run.
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(Optional) Cycle offline genotyping experiments

You can cycle OpenArray™ Plate formats on the ProFlex™ 2 x Flat PCR System.

The thermal protocol to be used for offline cycling is as follows.

=
=
=
—

Stage Step Temp Time Ramp rate Cycles
Pre-PCR hold 1 93.0°C 10 minutes 100% -
PCR cycles 1 95.0°C 45 seconds 84% 50 cycles

2 94.0°C 13 seconds 100% —
3 53.5°C 2 minutes and 14 seconds 44% -
Pre-PCR hold 1 25.0°C 2 minutes 100% -

Note: To image plates on the QuantStudio™ 12K Flex Real-Time PCR Instrument, in the QuantStudio™
12K Flex Software, uncheck the Include Amplification checkbox on the Run screen.

n OpenArrz

7

FOSMIRAJS1LO2
READY

Load the reaction plate into the instrument. Select the instrument and enter the setup files, then dick Start Run.

Select Instrument

e

[ GetPiateDs | [ Confirm Plate Centers |

OpenArray 1: DEBO1

OpenArray 2 : DEB02

OpenArray 3 @ DEBO3

OpenArray 4 :  [DEB04

Reagent Type: TagMan

* Setup File : |Genotyping.edt £

Sample File :

Browse

* Setup File : |Genotyping.edt S

Sample File :

Sample File :

* Setup File : |Genotyping.edt -
owse -

Browse

* Setup File : |Genotyping.edt -

Sample File :

Browse

Experiment File Location :
* Experiment File Name :

Experiment File Location :

* Experiment File Name :

Experiment File Location :

* Experiment File Name :

Experiment File Location :

* Experiment File Name :

Setup OpenArray Run
Run Type: Genotyping | [J Include Ampification Include Pre-read

lex Software\User Files\experiments [ Browse J

DEB01_2012_04_26_164409.eds

lex Software\User Files\experiments [ Browse ]

DEB02_2012 04_26_164409.eds

lex Software\User Files\experiments | EBrowse

DEB03_2012_04_26_164410.eds

lex Software\User Files\experiments || Erowse

DEB04_2012_04_26_164410.eds

Since
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(Optional) Monitor experiments

You can monitor an OpenArray™ experiment run in three ways.

* From the Run screen of the QuantStudio™ 12K Flex Software, while the experiment is in progress.
See “Monitor an experiment from the software Run screen” on page 130.

* From the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen, in the same way that you
run the experiment. See “Monitor an experiment from the instrument touchscreen” on page 131.

* From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor an experiment
started from another computer or from the QuantStudio™ 12K Flex Real-Time PCR Instrument
touchscreen). See “Monitor an OpenArray™ experiment run from the Instrument Console” on
page 130.

Note: If there is loss of connection during an experiment, remove and then add the instrument to
the My Instruments list, or restart the QuantStudio™ 12K Flex Software. Then resume monitoring the
experiment run.

Monitor an experiment from the software Run screen

To monitor the Amplification Plot of the experiment that you are running, in the QuantStudio™ 12K Flex
Software, from the Run Experiment Menu, click Amplification Plot.

Monitor an OpenArray™ experiment run from the Instrument Console

1. Double-click B (QuantStudio™ 12K Flex Software shortcut) to start the software.

2. In the Home tab, in the Tools menu, click Instrument Console.

3. In the Instrument Console, select the icon of the instrument that you are using to run the
experiment, then click Manage Instrument or double-click the instrument icon.

Note: You must add the instrument to a group that can be monitored before you can manage it.
See “Access the Instrument Console” on page 120.

4. In the Instrument Manager, click Monitor Run to access the Run screen.
You can view the progress of the run in real time from the Run screen. During the run, periodically
view the Ampilification Plot for potential problems. See “Monitor the Ampilification Plot” on
page 131).

Task Action

To stop the run ¢ |n the QuantStudio™ 12K Flex Software, click STOP RUN.
* In the Stop Run dialog box, click one of the following:
— Stop Immediately to stop the run immediately.

— Stop after Current Cycle/Hold to stop the run after the current
cycle or hold.

To view amplification data | Select Amplification Plot.
in real time
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To view data in the Amplification Plot, click Amplification Plot from the Run Experiment menu, select
the Plate Layout tab, then select the wells to view. You can view up to four OpenArray™ experiments
per run. Click the different tabs to view the Amplification Plot for each experiment.

Use the Amplification Plot to view sample amplification as the instrument collects fluorescence data
during a run. If a method is set up to collect real-time data, the Amplification Plot shows the data for
the wells selected in the Plate Layout tab. The plot contrasts normalized dye fluorescence (ARn) and

cycle number.

The Ampilification Plot is useful for identifying and examining abnormal amplification, including:

* |Increased fluorescence in negative control wells.

* Absence of detectable fluorescence at an expected cycle (determined from previous similar
experiments run using the same reagents under the same conditions).

Note: If you notice abnormal amplification or a complete absence of signal, troubleshoot the error
as explained in the QuantStudio™ 12K Flex Software Help (click € or press F1).

Monitor an experiment from the instrument touchscreen

The QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen displays the barcodes (or Plate
IDs) of the TrueMark™ OpenArray™ Plate formats for the run, the date and time at which the run started,
the time remaining in the run, and other information.

Task

Action

To display the experiment names in the run

Touch Experiment View.

To show the Amplification Plot for the run

Touch the Plot View, then touch Experiment View to
return to the previous screen.

To display the time elapsed and the time
remaining in the run

Touch the (® Time View tab, then touch Experiment
View to return to the previous screen.

To stop the run

Touch @ STOP to stop the run immediately.

View the Events Log

Touch the status bar to display the events log.
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(¢} Time View Plot View Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 59.5 °C
Reaction Volume: 20 pL. Heated Cover (Set Point): 105.0 °C (105.0 °C)

Stage / Step / Cycle: 2/2/5

01:11:22

© Remaining Time Elapsed Time

December 082011 - 12:06AM o

Error occurred during run. Details: Holdtime 60 s exceeded. Actual Holdtim...

Plot view

The Plot View displays the Amplification Plot in real time.

@ Time View Plot View ]  Experiment View

E m m Linear W AR V¥ FAM v

Subarray: A1
2,000

1,500

1,000 -
©
<

500

0

-500 -

January 30 2012 - 10:15AM o

You can change the plot using the drop-down menus that are available on the Plot View tab.

Touch... To...
TR Change the data displayed on the y-axis. Select either R (reporter) or AR (baseline-
corrected reporter).
For OpenArray™ experiments, the data is not normalized.
FAM v | Change the reporter dye displayed in the plot. Only the dyes that are used in your
experiment are shown.
0 View the run events that occurred during the run. Touch € again to close the event list.
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Unload the TrueMark™ OpenArray™ Plate from the
instrument

About completed runs

After the run is complete, if you started the run from the:

¢ QuantStudio™ 12K Flex Software, close the run and reopen the EDS file to display the Allelic
Discrimination Plot screen (for genotyping experiments). See Chapter 12, “Analyze the experiment
results”.

* QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen, see “(Optional) Transfer
experiment results” on page 133.

Unload the instrument

When the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen displays the Home screen,
unload the TrueMark™ OpenArray™ Plate from the instrument.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the sample block
temperature can reach 100°C. Allow it to cool to room temperature before handling.

1. Touch & on the instrument touchscreen, or click Open Door in the Instrument Console of the
QuantStudio™ 12K Flex Software.

2. Remove the OpenArray™ Plate from the plate adapter.

3. Touch & or click Close Door to retract the plate adapter back into the instrument.
If the instrument does not eject the plate, remove the plate.
a. Power off the instrument.

b. Wait for 15 minutes, then power on the instrument and eject the plate.

c. If the instrument does not eject the plate, power off and unplug the instrument, then open the
access door.

d. Wearing powder-free gloves, reach into the instrument and remove the plate from the heated
cover, then close the access door.

(Optional) Transfer experiment results

If you started a run from the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen, transfer
the experiment data to the computer for analysis after the run is complete. You can transfer the
experiment results in either of the following two ways:

* “Download the experiment from the instrument over the network” on page 134

* “Transfer the experiment from the instrument to the computer with a USB drive” on page 134
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Download the experiment from the instrument over the network
1. In the QuantStudio™ 12K Flex Software, select Instrument » Instrument Console.

2. From My Instruments list, select the instrument icon of the QuantStudio™ 12K Flex Real-Time
PCR Instrument that you just used to run the experiment.

3. Click Manage Instrument.
4. In the Instrument Manager, click Manage Files.
5. In the Experiments panel, select the experiment to download, then click Download.

6. In the Save dialog box, select the folder to hold the experiment results, then click Save, then
navigate to the experiments folder location.
<...>:\Applied Biosystems\QuantStudio 12K Flex Software\User
Files\experiments\
where <. . .> is the installation drive. The default installation drive is C: if the software is installed
by the customer. The default installation drive is D: if the software is installed by a Thermo Fisher
Scientific field service engineer.

Transfer the experiment from the instrument to the computer with a USB
drive

1. If not already connected to the QuantStudio™ 12K Flex Real-Time PCR Instrument, connect a USB
drive to the USB port.

2. Touch the instrument touchscreen to activate it.
3. If the touchscreen is not at the Main Menu, touch EJ (Home).

4. In the Main Menu, touch [ (Collect Results) to save the data to the USB drive.
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5. Select one or multiple experiments (by touching them). Then touch g (Save to USB) to copy
selected experiments to the USB drive.

Note: If your instrument cannot find the USB drive, remove the USB drive, then try again. If the
instrument still does not recognize the USB drive, try another USB drive.

6. Touch EJ (Home) to return to the Main Menu.

7. Remove the USB drive from the instrument, then connect it to one of the USB ports on your
computer.

8. In the computer desktop, use the Windows™ Explorer to open the USB drive.

9. Copy the example experiment file to:
<...>:\Applied Biosystems\QuantStudio 12K Flex Software\User
Files\experiments\

where <. . .> is the installation drive. The default installation drive is C: if the software is installed
by the customer. The default installation drive is D: if the software is installed by a Thermo Fisher
Scientific field service engineer.
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Analyze the run data

This section includes general information and instructions about how to analyze the example
experiments provided with the QuantStudio™ 12K Flex Software. For specific instructions, see “Analyze
genotyping experiment results” on page 145.

View the data from the EDS file. If the default analysis settings are not suitable for your experiment,
you can modify the data. You can also modify the project files, publish data, and export data for
downstream analysis using the ExpressionSuite™ Software and TagMan™ Genotyper Software.

Check the quality—-control images

Check the quality—control (QC) images before analysis. Images can be viewed using Imaged, an open-
source software available from the NIH at imagej.nih.gov/ig.

QC images can be viewed in QuantStudio™ Design and Analysis Software v2.7 and later.

1.

136

In the QuantStudio™ 12K Flex Software E Export screen, click Browse, then create a uniquely—
named folder for the QC images export.

IMPORTANT! Create a new folder for images each time. Exporting a second run to the same
folder overwrites the images.

Click Export QC Images at the bottom of the screen.

View the following ROX™ image to check for loading quality issues:

® POST-READ CHANNEL 4.tiff

Check the following spotfind images for leaks or other displaced sample issues.
® 502 c001 t03 p0001 ml x2 el cp# spotfind.tiff
® 502 c040 t03 p0001 ml x2 el cp# spotfind.tiff

Note: The “cp#” in the image file name refers to array positions 1 through 4 within the instrument.

If a problem is found, view the following pre-run spotfind image to determine whether the issue
existed before cycling:

® s00 c001 t01 p0001 m2 x3 el cp# spotfind.tiff

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide


https://imagej.nih.gov/ij

Chapter 12 [¥P5Y

T
Analyze the run data

6. View the following FAM™ images to check for fluorescent abnormalities and to confirm any
problem seen in the spotfind images:

®* STAGE2 CYCLEl CHANNEL 1.tiff
®* STAGE2 CYCLE40 CHANNEL 1.tiff

7. Note any abnormalities found, as well as all other potentially relevant information related to the
setup of the run.

View the results

After an experiment run, close the run and reopen the EDS file to display the Allelic Discrimination
Plot (for genotyping experiments).

Note: For auto-analysis of data, after a run, go to Tools » Preferences » Experiment, then select the
Auto Analysis checkbox. By default, Auto Analysis is always enabled. To reanalyze the data, select all
the wells in the plate layout, then click Analyze.

Set up the EDS file

If you run a genotyping experiment using an EDT file, you must integrate the sample names and Assay
IDs into the resulting EDS file.

For Assay IDs, you can import the SPF file of that OpenArray™ Plate into the EDS file before or after the
run.

For sample names:

* You can import the OpenArray™ Plate format from the CSV file for the corresponding plate.

* If you use the OpenArray™ AccuFill™ Software for sample integration, navigate to the appropriate
folder containing the Loaded SPF file. A Loaded SPF file is one that has sample names integrated
into the file using the OpenArray™ AccuFill™ Software.

Change analysis settings

Analysis settings are different for each experiment type. If the default analysis settings in the
QuantStudio™ 12K Flex Software are not suitable for your own experiment, you can change the settings
in the Analysis Settings dialog box, then reanalyze your experiment. You can save the changed
analysis settings to the Analysis Settings Library to use them in other experiments.

Use the Analysis Settings Library dialog box to apply a filter to reduce the number of setting protocols
that are displayed. Access the Analysis Settings Library from the Tools menu.
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Select analysis settings or delete analysis settings. Apply a filter to reduce the number of analysis settings displayed. p )

Enter a fitter query, then click "Apply Fiter."

IF [Analysis Settings v [= vl W }
| Analysis Settings Experiment Type Comments Created On Last Modified
'Flag Gene Expression 01-19-2012 16:16:02 SGT |01-19-2012 16:16:47 SGT
Pre-PCR SNP Genotyping 01-19-2012 16:39:00 SGT |01-19-2012 16:39:14 SGT
Bad passive ref SNP Genotyping 01-19-2012 16:40:27 SGT (01-19-2012 16:40:40 SGT

—
.

From the Experiment Menu, select Analysis.

2. On the Analysis screen, click Analysis Settings.

3. In the Analysis Settings dialog box, change the analysis settings according to your requirement.
4. Click Save to Library to save the changes to the Analysis Settings Library.

To import the analysis settings that you have previously saved to the Analysis Settings Library, in the
Analysis Settings dialog box, click Load from Library.

Display wells

To display specific wells in the analysis plots, select the wells in the Plate Layout tab.
* To select specific well type, use the Show in Wells drop-down menu.
— For gene expression and miRNA experiments, select Sample Color or Target Color.
— For genotyping experiments, select Sample Color or Assay Color.
* To select a single well, click the well in the Plate Layout tab.

* To select multiple wells, click and drag over the desired wells, press Ctrl-click, or press Shift-click
in the Plate Layout tab.

* To select all wells, click the upper left corner of the Plate Layout tab.

This example shows the Plate Layout tab for a genotyping experiment.
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Expand view of a plot or wells

* (Click »| to expand the plot view, on the left side of the screen.
* Click 4| to expand the Targets, Samples, and Subarrays view on the right side of the screen.
¢ Click s to expand the Plate Layout or Well Table view on the lower half of the screen.

* (Click X to expand the Plots and Targets, Samples, and Subarrays view on the upper half of the
screen.

* C(Click 7 to expand and collapse the Plot or Plate Layout view.

Edit plot properties

Use the Plot Properties dialog box on the Analysis screen to edit plot settings, such as the font and
color of the plot text, and the labels on the x-axis and y-axis.

1. Click [ on the Analyze screen (the icon appears above the plot).

2. In the Plot Properties dialog box, edit the settings under the General, X Axis, and Y Axis tab.

* (Click the X Axis tab to edit the x-axis label text, font, or color; select the tick marks and tick
mark labels to display; and select the range to display.

* C(Click the Y Axis tab to edit the y-axis label text, font, or color; select the tick marks and tick
mark labels to display; and select the range to display.

3. Click OK.
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Publish the analyzed data

Task Click
Save a plot as an image file. i
Print a plot. =)
Copy a plot to the clipboard.
Print a report.
Export data. B=
Task Go to Then
Print the plate layout. | File » Print Select the background color, then click Print.
Create slides. File » Send to PowerPoint | Select the slides for your presentation, then click Create
Slides.
Print a report. File » Print Report Select data for the report, then click Print Report.

(Optional) Export an experiment

140

Use the Export feature to export experiment data from the QuantStudio™ 12K Flex Software. You can
export experiment data in the QuantStudio™ 12K Flex format (TXT or XLSX) or RDML format (no file
selection).
You can export the following experiment data in a comma-separated file format (CSV).

* Sample Setup data

¢ Raw data

* Amplification data

* Multicomponent data

® Results
You can also export plate images collected during the run as TIF files to use them for troubleshooting.

To export plate images, first create an export folder on your hard drive. In the Export screen, click
Browse, navigate to the folder that you created, then click Export QC Images.

You can view the images using a public domain software program such as Imaged (imagej.nih.gov/ig).
See the QuantStudio™ 12K Flex Real-Time PCR System v1.6 or later Maintenance and Administration
Guide (Pub. No. MAN0018832) for more information on QC Images.

If you selected the Auto Export option before running an experiment, the data is automatically exported
to the location that you specified. If you did not select the Auto Export option, the analyzed data is not
exported automatically.
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1. Open the experiment file that contains the data to export, then from the Experiment Menu, click
E7 Export.

2. Select the format for exported data.
¢ QuantStudio 12k Flex format—Supports TXT and XLSX data.
* RDML format (Real Time Data Markup Language)—Supports only XML type of data.

3. Select to export all data in one file or in separate files for each data type.
¢ All data types are exported in one file.
- If you select the XLS format, a worksheet is created for each data type.
— If you select the TXT format, the data are grouped by data type.

¢ Each data type is exported in a separate file. If you select three different data types (for
example, Results, Amplification, and Multicomponent) to export, three separate files are
created. From File Type, select the export file type (XLS, XLSX, or TXT) to export.

Note: You cannot use an exported XLS or XLSX file when importing plate setup information.

4. Select Yes to include or No to exclude bookmarked data from analysis in the export set.

The Filter Bookmark Data feature lets you include only the data bookmarked during analysis in
the export set.

5. (Optional) Select the Open file(s) when export is complete checkbox to open the file when export
is complete.

6. Enter a file name and location.
a. In Export File Name, enter a name for the export file.
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b. In Export File Location accept the default, or click Browse if you do not want to save the
export file in the default export folder.

Note: To set up the Export File Location, go to Tools » Preferences, then select the Export
tab. You can select the Use Last File Location or Use Default Folder checkbox.

[ Non-OpenArray® T OpenArray® T Global Notification Settings T Startup W
Print SMTP Settings W

Experiment Display Format.

@ Select the default exportlocation

® Use Default Folder C:\Applied Biosystems\QuantStudio 12K Flex Software\User Files\experiments

Restore Defaults || Apply

7. Select the type of data to export.
Type of data Data to export
Sample setup Well, sample name, sample color, and target name of samples in the plate.
Raw data Raw fluorescence data for each filter, for each cycle.

Amplification data Amplification results, such as dCt values, R, or AR.

Multicomponent data | Fluorescence data for each dye, for each cycle.

Results Results information, such as Cy values, Rn, or calls.
Results data are not available for export until the run status is complete and
the data are analyzed.

The completed Export screen for a genotyping experiment should look like this.
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D Auto Export Format : |QuantStudio12KFlex N Export Data To: ® One File O Separate Files Fiter Bookmark Data : O Yes @ No Open file(s) when export is complete

Export Fle Location: |C-AApplied Biosystems\QuantStudio 12K Flex Software\User Files\experiments

Export File Name: |Genotyping Starter Kit Example_QuantStudio_export File Type: [F] (=o0) v
[ sample Setup [ Raw Data ] ampification [ Mutticomponent

Skip Empty Wels [ Skip Omitted Wels

Select Content Well Well Position | Omit Sample Name | SNP AssayN... | Task Allelel R Allele2 R Pass.Ref

Al Fields a 1Atal a NA17004 C___177489_10 UNKNOWN 338.090 1,447.676
well 2A122 [m} NA17004 C 940286_10 UNKNOWN 1,864.954 54.500
W 34123 O NAL7004 C__1046426_10  UNKNOWN 272798 2,280.990
[ el Postion 4Ala4 O NA17004 C__1085595_10 UNKNOWN 2,252.908 1,035.927
5A135 O NAL7004 C__1213693_10 UNKNOWN 2,351.529 80.401
omt 6A126 [ NA17004 C__1240647_1_ UNKNOWN 161.586 3,219.506
7 Ala7 O NA17004 C__1240651_20 UNKNOWN 164.436 1,145.265
Sample Name 8Al1a8 O NA17004 C___1332250_10 UNKNOWN 1,905.560 181.627
5P Assay ame 9A1b1 O NAL7004 C__1376137_10 UNKNOWN 2,156,528 1,777.867
f 10Ab2 O NA17004 C__1551497_10 UNKNOWN 305.203 1,756.986
Task 11A1b3 O NA17004 C__1839948_10 UNKNOWN 1,300.943 59.720
12A1b4 [ NA17004 C__1985480_20 UNKNOWN 2,396.389 3,171.856
Alele1 R 13A1bS O NA17004 C__2267279_10 UNKNOWN 2,141.680 468.944
14 A1b6 [m} NA17004 C__2301954_20 UNKNOWN 2,407.912 2,518.912
Alele2 R 15A1b7 O NA17004 C__2862873_10 UNKNOWN 2,232.974 268.073
[7] Pass.Ref 16A1b8 O NA17004 C___3123006_1_ UNKNOWN 1,728.596 257.580
- 17 Alcl O NA17004 C__3123485_1_ UNKNOWN 2,607.119 218453
Qualiy(%) 18A1Q2 O NA17004 C__3168989_10 UNKNOWN 202.025 3,156.142
19A13 O NA17004 C__3197300_10 UNKNOWN 2,549,761 2,545,545
cal 20 Alc4 [m} NA17004 C__3237878_10 UNKNOWN 435.728 3,927.884

1 Method ¥ = >

Start Export [ Save Export Set As || Load Export Set || Delete Export Set [ Export QC Images

8. (Optional) After you have defined the export properties or after moving the table headings order,
you can save those export settings as an export set by clicking Save Export Set As. Later you can
import the heading order into another file by clicking Load Export Set. You can also delete export
settings by clicking Delete Export Set.

9. (Optional) Click Export QC Images to export quality control (QC) images in experiment files (EDS).

QC images include calibration images, a barcode image, and images taken during PCR. You can
view the images to check sample loading and assay spotting. View PCR images to validate your
data.

10. Click Start Export.
The exported file, when opened in Notepad, should look like this.
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L Genotyping Starter Kit Exampls_QuantSmdin_export.m - Notepad
e Edt Format Vies
* Barcode = GRQQZ -~
* Block Type = Openarray Block =
* Chemistry = TAQMAN
¥ Comment = NA
* Date created = 2012-01-23 17:20:26 PM SGT
* Experiment File Name = C: \Dacs \OAExampTes \GRQ92_GT_Training_Plate. eds
* Experiment Name = Genotyping Starter Kit Example.eds
* Experiment Run End Time = NOt Started
* Experiment Type = SNP Genotyping
* Instrument Name = 285880030
* Instrument Serial Number = 285880030
* Instrument Type = QuantStudio 12K Flex
* passive Reference =
* Quantification Cycle Method = Ct
* signal smoothing on = true
* stage/ Cycle where Analysis is performed = stage 3, Step 3
¥ User Name = NA
[Results]
well well position omit Sample Name SNP Assay Name Task Allelel R Allele2 R Pass.Ref qQuality(%)
call Method Amp Score Allelel automatic Ct Threshold Allelel ct Threshold Allelel Automatic Baseline A'I'Ie'\e{ Baseline
start  Allelel Baseline End Allele2 Automatic ct Threshold Allele2 ct Threshold Allele2 Automatic Baseline Allele2 Baseline
start Allele2 Baseline End CTFAIL
1 Alal false NA17004 C. 177489_10 UNKNOWN 338.090 1,447.676 98.534 Homozygous Allele 2/allele 2 Auto
1.300 true 22.289 true 3 25 true 60.119 true 3 17 N

Ala2 false NA17004 C 940286_10 UNKNOWN 1,864,954 54.500 98.534 Homozygous Allele 1/Allele 1 Auto
0.503 true 57.720 true 3 15 true 65.561 true 3 49 N
3 Ala3 false  NAL7004 C__1046426_10 UNKNOWN 272,798 2,280.990 98.514 Homozygous Allele 2/Allele 2 Auto
1.352 true 48.102 true 3 20 true 30,686 true 3 15 N
4 Alad false NA17004 C___1085595_10 UNKNOWN 2,252.908 1,035.927 98.534 Heterozygous Allele 1/allele 2
Auto 1.107 true 99.451 true 3 135 true 36.521 true 3 16 N

Alas false NAL7004 C___1213693_10 UNKNOWN 2,351.529 Bg 401 98.534 Heterozygous Allele 1/Allele 2 Auto
0.000 true 53.127 true 3 14 true 45 359 true 32 N
6 Ala6 false NA17004 C___1240647_1_ UNKNOWN 161.586 3,219. 506 98.524 Homozygous Allele 2/Allele 2 Auto
1.461 true 29,242 true 3 22 true 61.953 true 14 N
7 Ala7 false NAL7004 C___1240651_20 UNKNOWN 164.436 1,145. 265 98.534 Homozygous Allele 2/Allele 2 Auto
1.051 true 25.597 true 3 23 true 20.500 true 17 N
8 Alas false NAL7004 C__1332250_10 UNKNOWN 1,905.560 181.627 98,524 Homozygous Allele 1/allele 1 Auto
0.000 true 64.763 true 3 16 true 55.166 true 3 36 N
9 Albl false NAL7004 C__ 1376137_10 UNKNOWN 2,156.528 1,777.867 98.524 Heterozygous Allele 1/Allele 2
Auto 1.266 true 21.923 true 3 17 true 28.696 true 3 18 N
1] Alb2 false NAl7004 c_1551497_10 UNKNOWN 305,203 1,756.986 98.524 Homozygous Allele 2/Allele 2 Auto
1.229 true 39.450 true 3 true 51.648 true 3 21 N
11 Alb3 false  NA17004 c 1339943_10 UNKNOWN 1,300.943 59.720 98.524 Homozygous Allele 1/Allele 1 Auto
0.744 true 16.402 true true 46.239 true 3 22 N
12 Alb4 false NA17004 c 1955480 20 UNKNOWN 2,396.389 3,171. 856 98.534 Heterozygous Allele 1/Allele 2
Auto 1.375 true 38.108 tr 3 a5 true 70.526 true 3 17 N
13 A1bS false NAL7004 C___ 2267279 _10 UNKNOWN 2,141,680 468.944 98,524 Homozygous Allele 1/Allele 1 Auto
0.000 true 38,155 true true 61.212 true 3 32 N
14 Alb6 false NA17004 C 2301954_20 UNKNOWN 2,407.912 2,518.912 98.481 Homozygous Allele 1/Allele 1
Auto 1.320 true 39.146 tr 3 15 true 68.994 true 3 15 N
15 Alb7 false NAL7004 C___ 2862873_10 UNKNOWN 2,232,974 268.073 98.534 Homozygous Allele 1/Allele 1 Auto

Perform downstream analysis (secondary analysis)

You can perform downstream analysis of experiments that have been run on any real-time PCR system
with the TagMan™ Genotyper Software. Use the TagMan™ Genotyper Software to efficiently analyze,
edit, and conduct a study of a large number of genotyping experiments.

* Import data from the QuantStudio™ 12K Flex Software project files, then manage the data in a
database.

* Search the database for assays using specific search criteria.

* Easily view data in a variety of ways (plots, statistics, status codes, and so on).
¢ Edit data. Your edits are saved to the database.

* OQverlay data from multiple plates.

* Export data.

TagMan™ Genotyper Software is available for download from the Thermo Fisher Scientific website. See
also Appendix A, “Ordering information”

For more information about the TagMan™ Genotyper Software, see the TagMan™ Genotyper Software
Getting Started Guide (Pub. No. 4448637).
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Analyze genotyping experiment results

In this section, you use the example experiment files provided with the QuantStudio™ 12K Flex Software
to analyze the experiment results.

Workflow

Analyze genotyping experiment results

Access the example experiment file (page 146)

View and assess clusters in the Allelic Discrimination Plot
(page 146)

Confirm setup accuracy using the Plate Layout (page 149)

Assess amplification results on the Amplification Plot (page 150)

Identify well problems using the Well Table (page 151)

Confirm accurate dye signal using the Multicomponent Plot
(page 154)

Determine signal accuracy using the Raw Data Plot (page 155)

Review the flags in the QC Summary (page 156)

(Optional) Adjust parameters for reanalysis of your own experiments
(page 159)

(Optional) Export an experiment (page 140)
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Access the example experiment file

1.

3.

Double-click El

(QuantStudio™ 12K Flex Software shortcut) to start the software.

In the Home tab, in the Experiment menu, click Open,, then browse to the experiments folder.

<...>:Program Files (x86)\Applied Biosystems\QuantStudio 12K Flex
Software\examples\Genotyping

Open the Genotyping Starter Kit Example.eds file.

Set up the EDS file

If you run a genotyping experiment using an EDT file, you must integrate the sample hames and Assay
IDs into the resulting EDS file.

For Assay IDs, you can import the SPF file of that OpenArray™ Plate into the EDS file before or after the

run.

For sample names:

You can import the OpenArray™ Plate format from the CSV file for the corresponding plate.

If you use the OpenArray™ AccuFill™ Software for sample integration, navigate to the appropriate
folder containing the Loaded SPF file. A Loaded SPF file is one that has sample names integrated
into the file using the OpenArray™ AccuFill™ Software.

View and assess clusters in the Allelic Discrimination Plot

146

The Allelic Discrimination Plot is a plot of the signal from one allele-specific probe on the x-axis
against the signal from the other allele-specific probe on the y-axis.

View the Allelic Discrimination Plot to identify clusters.

Clusters for the three possible genotypes (Allele 1 homozygous, Allele 2 homozygous, and Allele
1/2 heterozygous).

A cluster for the no template controls.

. From the Experiment menu, select Analysis » Allelic Discrimination Plot.

Click the Plate Layout tab, then click any empty well to select it.

In the Allelic Discrimination Plot, the software highlights all wells that are selected in the Plate
Layout tab. If the plot displays a single color for all wells, then all wells in the plate layout are
selected.

In the Allelic Discrimination Plot, select C 177489_10 from the Assay menu, on the top-right
side of the screen, then enable Autocaller.

If the Autocaller is not enabled, the Allelic Discrimination Plot displays a crossmark (X —
Undetermined) for each sample.

To enable or disable Autocaller, go to Analysis Settings. By default, Autocaller is enabled but
you can edit the default call settings and uncheck the Autocalling Enabled checkbox.
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The Allelic Discrimination Plot displays allele symbols for each sample evaluated for the selected
SNP. The samples are grouped on the plot.

Genotype Symbol Location

Homozygous for Allele 1 of the selected SNP assay | @ (red) |x-axis of the plot

Homozygous for Allele 2 of the selected SNP assay | @ (blue) | y-axis of the plot

Heterozygous for both alleles of the selected SNP | () (green) | Midway between the homozygote
assay (Allele 1 and Allele 2) clusters

No Template Control

M (black) | Bottom-left corner of the plot

Undetermined

2 (black) | Anywhere on plot

4. Review each cluster in the plot.

a. Click and drag a box around the cluster to select the associated wells in the Plate Layout and

Well Table.

b. Confirm that the expected wells are selected in the Well Table.

For example, if you select the cluster at the bottom-left corner of the plot, only the no-
template controls should be selected. The presence of an unknown among the no-template
controls may indicate that the sample failed to amplify.

c. Repeat steps a and b for all other clusters in the plot.

Table 5 Allelic Discrimination Plot elements.

dropdown menu

Element Description
Assay tab Determines the assay data that the QuantStudio™ 12K Flex Software displays in
the plot.
Plot Type dropdown | Determines the type of plot (Cartesian or Polar) that the QuantStudio™ 12K Flex
menu Software uses to display the data.
Change Call When a datapoint is selected, use this menu to assign an allele call to the

datapoint within the scatterplot.

Toolbar

Tools for manipulating the scatterplot.
e |l (Selection tool), to select a single data point
e [& (Selection tool), to select multiple data points
* ["(Reposition)
* [E](Zoom in)
e [N(Zoom out)

Legend

Explains the symbols in the scatterplot.

Show Options

Use the Reveal Traces option to trace the clusters throughout the PCR process.

This option is not active for the example experiment. To activate the option, see
“Adjust analysis settings” on page 161.

This is an example of the Allelic Discrimination Plot for the OpenArray™ genotyping experiment.
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Plot Type ¥ i Change Call ¥ E [ = <W]
2 2 L Assay Name Color # of Well Allele 1

oo 1 C___177489_10 B 48 Allele 1 AN
e 2 94028610 | 48 Alele 1 A
3 C__1046426_10 ] 48 Allele 1 A
4 C__1085595_10 48 Allele 1 A
2000 5 €__1213693_10 [ ] 48 Alele 1 A
: 6 C__1240647_1 48 Allele 1 A
7 €__1240651_20 (| 48 Allele 1 A
8 C__1332250_10 | 48 Alele 1 A
9 C__1376137_10 48 Allele 1 A
10 C___1551497_10 48 Alele 1 A
12000 11 C__1830948_10 48 Allele 1 A
“ 12 C__1985480_20 [ ] 48 Allele 1 A
2 13 C__2267279_10 H 48 Alele 1 A
= 14 C__2301954_20 ] 48 Allele 1 A
H & C__2862873_10 H 48 Allele 1 A
000 16 C__3123006_1_ ] 48 Allele 1 A
17 C__3123485_1_ | ] 48 Allele 1 A
18 C__3168989_10 ] 48 Alele 1 A
19 C__3197300_10 48 Allele 1 A
20 C__3237878_10 ] 48 Allele 1 A
2000 O | A ) 21 C__7454599_10 48 Alele 1 A
o 090 k “ 22 C__7555101_10 (] 48 Allele 1 A
% ot 23 C__7610555_10 ] 48 Allele 1 A
. ~F 24 C__7620048_20 48 Allele 1 A
25 C__8376164_10 48 Allele 1 A
26 C__8685532_20 48 Allele 1 A
300.0 800.0 1300.0 1800 0 23000 27 C_E7DD]QI_1’J . 48 Allele 1 A
Sptions Allele 1 28 C__8700820_10 ] 48 Allele 1 A
3 29 C__8795100_10 = 48 Alele 1 A
D] Reveal Traces  Show Cyce: 50 30 C__8883774_10 48 Allele 1 A

3 ) & &+ s &% 31 . C__8884023_10 (| 48 Allele 1 >Av

Troubleshoot clustering on the Allelic Discrimination Plot
Do all controls have the correct genotype?
In the example experiment and in your own experiments, confirm that data points cluster as expected.

Clustering in positive controls

1. From the Well Table, select the wells containing a positive control to highlight the corresponding
data points (symbols) in the Allelic Discrimination Plot.

2. Check that the data points for the positive controls cluster along the expected axis of the plot. For
example, if you select the Positive Control Allele 1/Allele 1, then the controls should cluster along
the x-axis.

3. Repeat steps 1 and 2 for the wells containing the other positive controls.

Failed amplification in the unknown samples

1. Select the data points of the cluster in the lower left corner of the Allelic Discrimination Plot to
select the corresponding wells in the well table.
2. Check that the selected wells in the well table are the no template controls, and not unknown
samples.
Samples clustered with the no template controls

Samples that clustered with the no template controls may:
¢ Contain no DNA
* Contain PCR inhibitors
* Be homozygous for a sequence deletion

* May not have been set up correctly due to pipetting error

Confirm the results of these samples by retesting them.
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Are outliers present?

If the Allelic Discrimination Plot contains clusters other than the three representative genotype

clusters (heterozygous, homozygous allele 1, and homozygous allele 2), then those can be classified
as outliers.

Confirm the results of the associated samples by retesting them.

Note: The results displays are synchronized. For example, selecting a well in the Plate Layout selects
the corresponding data in the Well Table and in the Allelic Discrimination Plot.

Confirm setup accuracy using the Plate Layout

Review the experiment results in the Plate Layout. The Plate Layout displays the assay-specific setup

and analysis properties for the experiment in a well format corresponding to the type of reaction plate
used for the run.

Click the Plate Layout tab in the bottom-half of the screen to display the Plate Layout.

Example experiment plate layout values

For the example experiment, confirm that the QuantStudio™ 12K Flex Software called these samples.
* 2 samples as Allele 1 homozygous (@ ).
* 34 samples as Allele 2 homozygous (@ ).
* 4 samples as heterozygous (O)).

* 8 samples as undetermined ().

Confirm that no wells of the reaction plate triggered QC flags (

). The example experiment displays 3
flags.

View the Plate Layout

1. Click the > and . icons beside and below the Allelic Discrimination Plot to maximize the view

of the Plate Layout.

Click @ » Show in Wells » Sample Color to display the sample color in the wells.
The following figure shows the Plate Layout of the OpenArray™ genotyping example experiment.
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Tips for troubleshooting plate setup in your own experiment

You can adjust the view of the Plate Layout.

* Note the location of any samples that trigger QC flags - . Understanding the position of errors can
aid in diagnosing any failures that may occur.

* Select the entire reaction plate, areas of the reaction plate, or specific wells.
— Click the upper left corner of the reaction plate to select all subarrays.
— Left-click the mouse and drag across the area to select it.

— Select Sample, SNP Assay, or Task from the Show in Wells menu in the Plate Layout to
select wells of a specific type using the well-selection criteria.

* Use the (Zoom In), (Zoom Out), [FZ] (Quick view), and gl (Fit Plate) buttons to magnify or
compress the view of the wells shown.

* Use the A arrow tabs to expand the Plate Layout to cover the entire screen.

Assess amplification results on the Amplification Plot

150

The Ampilification Plot displays amplification of all samples in the selected wells. View the
Ampilification Plot for the example experiment to evaluate the quality of the amplification curve and to
check for outliers.

Three plots are available.

* AR vs Cycle—AR is the magnitude of fluorescence signal generated by the reporter at each cycle
during the PCR amplification. This plot displays AR as a function of cycle number. Use this plot to
identify and examine irregular amplification and to view Cgy values for the run.

* R vs Cycle—R is the fluorescence signal from the reporter dye. This plot displays R as a function
of cycle number. Use this plot to identify and examine irregular amplification.

®* Cpgt Vs Well—Cgr is the PCR cycle number at which the fluorescence meets the threshold in the
amplification plot. This plot displays Crt as a function of well position. Use this plot to locate
outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

View the Amplification Plot

1. From the Experiment Menu, select Analysis » Amplification Plot.
If no data are displayed, click Analyze.

2. In the Amplification Plot, select:

Menu Selection
Plot Type AR vs Cycle (default)
Graph Type Log (default)
View SNP Allele Color (default)
Show Unselection (default)

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide



Chapter 12 [
Analyze genotyping experiment results C

3. View the Cgy values.

a. From the View drop-down, Show Cgr.

b. Verify that the Cry value that is reported matches its occurrence (the triangle icon) on the plot.

10000

AR

Cycle

Identify well problems using the Well Table

Review the details of the experiment results in the Well Table and identify any flagged wells. The Well
Table displays the assay-specific setup and analysis properties for the experiment in a tabular format.

Example experiment values and flags

For the example experiment, look for wells that triggered QC flags (. ). The example experiment has 3

flags.

View the Well Table

1.

2.

From the Experiment Menu, select Analysis » Amplification Plot, then click the Well Table tab.

Click the Flag column to sort the data so that the wells that triggered flags appear at the top of the
table.

Confirm the integrity of the controls.
a. From the Group By menu, select Task to organize the table rows by their function on the
reaction plate.

b. Confirm that each of the controls do not display flags

c. Click the H icon to collapse the negative and positive controls.
The Well Table for the OpenArray™ genotyping example experiment looks like this.
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Plate Layout

Epandal @

Flag Sample ... SNP As... AssayID Allele 1 | Allele2 | Allele 1... Allele2...| Allele1... Allele 2...| ROXSig... Call

1 Alal ] NA17004  C___177... .. Unknown  Alele 1 Allele 2 VICNFQ-M.... FAM-NFQ-... 338.000  1,447.676 Homozygo... 98.534 Aut
65 Al O NA17057  C___177.. .. Unknown  Alele 1 Allle 2 VICNFQM... FAM-NFQ-..  414.040  1,812.982 Homozygo... 98.534 Aut
129 A3l [} NA17005  C___177... ... Unknown  Allele 1 Allle 2 VICNFQ-M... FAM-NFQ-...  1,369.277 1,575.605 Heterozyg... 98.534 Aul
193 Adal O NA17059  C___177 ... Unknown  Alele 1 Alele2  VICNFQ-M... FAM-NFQ-... 504.790  2,014.206 Homozygo... 98.534 Aut
257 Asal O NA17034  C__1 .. Unknown  Allle 1 Alele 2 VIC-NFQ-M... FAM-NFQ-... 576.798  2,080.472 Homozygo... 98.534 Aul
321 A6l [} NA17060 C__1 ... Unknown  Alele 1 Allele 2 VICNFQ-M... FAM-NFQ-... 611732 2,223.806 Homozygo... 98.534 Auf
385 A7al 0 NA17051  C___177... .. Unknown  Alele 1 Allle 2 VICNFQ-M... 594.411  2,174.000 Homozygo... 98.534 Auf
449 Asal O NA17104  C__17 .. Unknown  Alele 1 Allele 2 VICNFQ-M... 1,497.123  1,928.546 Heterozyg... 98.534 Aul
513 A%l ] NA17053  C__1 ... Unknown  Alele 1 Allele 2 VICNFQ-M... 573.567 2,359.790 Homozygo... 98.534 Auf
577 Allal O NA17105 C__1 ... Unknown  Alele 1 Allele 2 VICNFQM... 537.917 2,115.444 Homozygo... 98.534 Aut
641  Allal O NA17055  C___177... ... Unknown  Alele 1 Alele 2 VICNFQM... 525499  2,210.420 Homozygo... 98.534 Aut
705 Al2al [} NA17108  C___177. ... Unknown  Alele 1 Alele2  VIGNFQ-M... 512175 2,196.327 Homozygo... 98.534 Auf
769 Blal [} NA17108  C__ 17 .. Unknown  Allle 1 Allele 2 VIC-NFQ-M. 441100 2,013.071 Homozygo... 98.534 Aul
833 B2l [} NA17208 C__1 ... Unknown  Alele 1 Allele 2 VICNFQ-M 504539  2,159.505 Homozygo... 98.534 Auf
897  B3al O NA17125  C__1 ... Unknown  Alele 1 Allle 2 VICHNFQ-M... FAM-NFQ-... 459.415  2,116.520 Homozygo... 98.534 Aut
%61  B4al O NAG4671  C__1 .. Unknown  Allle 1 Allele 2 VICNFQ-M... FAMANFQ-..  1,663.670  295.365 Homozygo... 97.040 Aut
1025  Bsal [} NA17201  C___177... ... Unknown  Alele 1 Allele 2 VICNFQ-M.... FAM-NFQ-... 580.349  2,165.138 Homozygo... 98.534 Aut
1089 B6al O 1 NTC 17 ... Unknown  Alele 1 Allle 2 VICHNFQ-M... FAM-NFQ-... 33.204 25671 Undetermi...  100.000 Aut
1153 B7a1 [} NA17202  C__1 ... Unknown  Alele 1 Alele 2 VICHFQ-M.... FAM-NFQ-... 587.505 2,212.112 Homozygo... 98.534 Aut
1217 Bgal O NTC G771 ... Unknown  Alele 1 Alele2  VIGNFQ-M... FAM-NFQ-... 40.205 3613 Undetermi...  100.000 Auf
1281 B9l [} NA17203  C___177.. .. Unknown  Allle 1 Allele 2 VIC-NFQ-M... FAM-NFQ-... 531179 2,296.937 Homozygo... 98.534 Aut
1345 B10a1 [} NTC C__177... ... Unknown  Alele 1 Allele 2 VICNFQ-M.... FAM-NFQ-... 53797 45.074 Undetermi...  100.000 Aut
1409 Bllal 0 NA17205  C___177 .. Unknown  Alele 1 Allle 2 VICNFQ-M... FAM-NFQ-... 547.880  2,253.406 Homozygo... 98.534 Aut
1473 B12al O NTC @il ... Unknown  Alele 1 Allele 2 VICNFQ-M... FAM-NFQ-... 55325  -35.682 Undetermi...  100.000 Aut
1537 Clal ] 1 NA17004  C___177... ... Unknown  Alele 1 Allele 2 VICNFQ-M.... FAM-NFQ-... 423.932  1,935.394 Homozygo... 98.534 Aut
1601 C2al O NA17057 C__1 ... Unknown  Allle 1 Allele 2 VIGNFQ-M... FAM-NFQ-..  483.336 2,113.948 Homozygo... 98.534 Aut
1665 C3a1 O NA17005  C___177... ... Unknown  Alele 1 Alele 2 VIGNFQ-M... FAM-NFQ-..  1,486.921 1,878.511 Heterozyg... 98.534 Aul
mn - ~ aianen A amm n ew oo A et s s sen ceoen adma AR i o o2 a
< >

The Well Table shows the following information.

Column Description

Well The position of the well on the reaction plate.

Omit A check mark indicates that the well has been removed from the analysis.

Flag A . symbol indicates that the well triggered the number of flags listed inside
the symbol.

Sample Name The name of the sample.

SNP Assay Name | The name of the SNP assay evaluated by the well.

Assay ID The Assay ID number of the SNP evaluated by the well.

Task The task assigned to the well (Unknown, No Template Control, or Positive
Control).

Allele1/2 The name of the associated allele for the SNP evaluated by the well.

Allele 1 / 2 Dyes | The name of the reporter and quencher dyes of the associated allele for the
SNP evaluated by the well.

Allele1/2 g, Normalized signal (,,) of the reporter dye of the associated allele for the SNP
evaluated by the well.

Pass Ref The signal of the passive reference dye for the well.

Call The allele call assigned to the sample, where possible calls are:
¢ @ Homozygous 1/1 —Homozygous for allele 1

¢ @ Homozygous 2/2—Homozygous for allele 2

e () Heterozygous 1/2—Heterozygous

¢ Ml No Template Control

® X Undetermined

Quality (%) The quality value calculated for the genotype call.

Method The method used to assign the call to the sample (Auto if assigned by the
QuantStudio™ 12K Flex Software, or Manual if applied by a user).
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(continued)
Column Description
Comments Comments entered for the associated sample well.
Allele1/2 Cy Threshold cycle (Cy) of the sample for the associated allele for the SNP
evaluated by the well.

Identify quality control (QC) problems

The Well Table displays columns for QC flags that are triggered by the experimental data. If the
experiment data does not trigger a QC flag, then the QuantStudio™ 12K Flex Software does not display
a corresponding column for the flag.

A . in one of the following columns indicates that the associated well triggered the flag.
Flag Description

BADROX The well produced a passive reference signal greater than the limit defined in the analysis
settings.

OFFSCALE | The well produced a level of fluorescence greater than the QuantStudio™ 12K Flex Real-Time
PCR System can measure.

NOSIGNAL | The well did not produce a detectable level of fluorescence.

CLUSTER# | For the SNP evaluated by the well, the number of clusters generated from the experiment
data is greater than the limit defined in the analysis settings.

PCFAIL The positive control did not produce an g, for the associated allele greater than the limit
defined in the analysis settings indicating that the control may have failed to amplify.

SMCLUSTER | The number of data points in the associated cluster is less than the limit defined in the
analysis settings.

AMPNC The negative control has produced an g, greater than the limit defined in the analysis
settings indicating possible amplification.

NOAMP The well did not produce an g, for either allele that is greater than the limit defined in the
analysis settings indicating that the well may have failed to amplify.

NOISE The background fluorescence (noise) produced by the well is greater than the other wells on
the reaction plate by a factor greater than the limit that is defined in the analysis settings.

SPIKE The amplification plot for the well contains one or more data points inconsistent with the
other points in the plot.

EXPFAIL The software cannot identify the exponential region of the amplification plot for the well.

BLFAIL The software cannot calculate the best fit baseline for the data for the well.

THOLDFAIL | The software cannot calculate a threshold for the associated well.

CTFAIL The software cannot calculate a threshold cycle (Cy) for the associated well.

AMPSCORE | Amplification in the linear region is below a specific threshold, corresponding to the score set
in the analysis settings
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Tips for analyzing your own experiments
Confirm the integrity of positive controls

When you analyze the example experiment or your own experiment, if you are using positive controls,
confirm the integrity of the positive controls.

1. From the Group By menu, select Task to organize the table rows by their function on the reaction
plate.

2. Confirm that the positive controls do not display flags - and that their reporter dye fluorescence
(R) is appropriate for the genotype.

For example, if evaluating the Positive Control Allele 1/Allele 1, you would expect to see significant
increase in R, for the Allele 1 probe and very little for the Allele 2 probe.

Adjust the Well Table
* Review the data for the Unknown samples. For each row that displays . in the Flag column, note
the data and the flag or flags triggered by the associated well.
* Select areas of the table or wells of a specified type. Use one of these methods.
- Left-click the mouse, then drag across the area of the table that you want to select.

- In the Well Table, from the Select Wells menu, select Sample, SNP Assay, or Task to select
wells of a specific type using the well-selection tool.

* Select an option from the Group By menu to group the rows of the plate layout. To collapse or
expand the lists, either click the +/- icon next to individual lists, or click [ Collapse All or [
Expand All.

* To omit a well from the analysis, select the Omit checkbox for that well. To include the well in the
analysis, deselect the Omit checkbox.
You must reanalyze the experiment each time you omit or include a well.

Confirm accurate dye signal using the Multicomponent Plot
The Multicomponent Plot displays the complete spectral contribution of each dye in a selected well
over the duration of the PCR run.
In the OpenArray™ genotyping example experiment, review the Multicomponent Plot for:
* FAM™ dye (reporter)
* VIC™ dye (reporter)
* Spikes, dips, and/or sudden changes
* Amplification in the no-template control wells

View the Multicomponent Plot

1. From the Experiment Menu, select Analysis » Multicomponent Plot.
If no data are displayed, click Analyze

2. Display the unknown wells one at a time in the Multicomponent Plot.
a. Click the Plate Layout tab.
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b. Select one well in the plate layout. The well is shown in the Multicomponent Plot.

If you select multiple wells, the Multicomponent Plot displays the data for all selected wells
simultaneously.

3. Click View » SNP Allele Color.

4. Click [E Show a legend for the plot (default).
This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. Check the FAM™ dye signals.

In the genotyping example experiment, the FAM™ dye signal increases throughout the PCR
process, indicating normal amplification.
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Tips for confirming dye accuracy in your own experiment

When you analyze your own experiment, look for these results.

* Reporter dye—The reporter dye fluorescence level should display a flat region corresponding to the
baseline, followed by a rapid rise in fluorescence as the amplification proceeds.

* Irregularities in the signal—There should not be any spikes, dips, and/or sudden changes in the
fluorescent signal.

* Negative Control wells—There should not be any amplification in the negative control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot displays the raw fluorescence signal (not normalized) for each optical filter for the
selected wells during each cycle of the real-time PCR.

In the OpenArray™ genotyping example experiment, you review the Raw Data Plot screen for a stable
increase in signal (no abrupt changes or dips) from the appropriate filter.
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View the Raw Data Plot

1. From the Experiment Menu, select Analysis » Raw Data Plot.
If no data are displayed, click Analyze

2. To display all wells in the Raw Data Plot, click the upper left corner of the plate layout in the Plate
Layout tab.

3. Click & Show a legend for the plot (default).
The legend displays the color code for each row of the reaction plate (see the legend in the Raw

Data Plot).
This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 52.
In the example experiment, the stable increase in signal from filter 1 corresponds to the FAM™ dye
filter.

Ampltude

x2mz

Tips for determining signal accuracy in your own experiment
When you analyze your own OpenArray™ genotyping experiment, look for the following conditions in
each filter.

* Characteristic signal growth

* No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary displays a list of the QuantStudio™ 12K Flex Software flags, including the flag
frequency and location for the open experiment. Review the QC Summary in the OpenArray™
genotyping example experiment for any flags triggered by the experiment data.

The following wells have data that triggered the SMCLUSTER flag.

Alal, A1a2, Ala4d, Ala7, A1c3, A1d5, Ale2, A1f7, A1g4, A1h4, A2al, A2a2, A2a4, A2a7, A2¢c3, A2d5,
A2e2, A2f7, A2g4, A2h4, A3al1, A3a2, A3a4, A3a7, A3c3, A3d5, A3e2, A3f7, A3g4, A3h4, Adal, Ada2,
Adad, Ada7, Adc3, A4d5, Ade2, A4f7, Adg4, Adh4, A5al, Aba2, Aba4, Aba7, A5c3, Abd5, Abe2, A5f7,
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Abg4, A5h4, A6al, A6a2, Aba4d, A6a7, A6c3, ABd5, A6e2, A6f7, ABg4, A6h4, A7al, A7a2, A7a4, A7a7,
A7c3, A7d5, A7e2, A7{7, A7g4, A7h4, A8al, A8a2, ABa4, A8a7, A8c3, A8d5, A8e2, A8f7, A8g4, A8h4,
A9a1, A9a2, A9a4, A9a7, A9c3, A9d5, A9e2, A9f7, A9g4, A9h4, A10al, A10a2, A10a4d, A10a7, A10c3,
A10d5, A10e2, A10f7, A10g4, A10h4, A11al, A11a2, A11a4, A11a7, A11c3, A11d5, A11e2, A1117,
Al11g4, A11h4, A12a1, A12a2, A12a4, A12a7, A12c3, A12d5, A12e2, A12f7, A12g4, A12h4, B1al, B1a2,
B1a4, Bi1a7, B1c3, B1d5, B1e2, B1f7, B1g4, B1h4, B2al, B2a2, B2a4, B2a7, B2c3, B2d5, B2e2, B2{7,
B2g4, B2h4, B3a1, B3a2, B3a4, B3a7, B3c3, B3d5, B3e2, B3f7, B3g4, B3h4, B4a1, B4a2, B4a4, B4a7,
B4c3, B4d5, B4e2, B4f7, B4g4, B4h4, B5a1, B5a2, B5a4, B5a7, B5c3, B5d5, B5e2, B5f7, B5g4, B5h4,
B6al, B6a2, B6a4, B6a7, B6¢c3, B6d5, B6e2, B6f7, B6g4, B6h4, B7al, B7a2, B7a4, B7a7, B7c3, B7d5,
B7e2, B7f7, B7g4, B7h4, B8a1, B8a2, B8a4, B8a7, B8c3, B8d5, B8e2, B8f7, B8g4, B8h4, B9al, B9a2,
B9a4, B9a7, B9c3, B9d5, B9e2, B9f7, B9g4, B9h4, B10al, B10a2, B10a4, B10a7, B10c3, B10d5,
B10e2, B10f7, B10g4, B10h4, B11ai1, B11a2, B11a4, B11a7, B11c3, B11d5, B11e2, B11f7, B11g4,
B11h4, B12a1, B12a2, B12a4, B12a7, B12c3, B12d5, B12e2, B12f7, B12g4, B12h4, C1al, C1a2, C1a4,
C1a7, C1c3, C1d5, C1e2, C1f7, C1g4, C1h4, C2al1, C2a2, C2a4, C2a7, C2c3, C2d5, C2e2, C2f7, C24g4,
C2h4, C3a1, C3a2, C3a4, C3a7, C3c3, C3d5, C3e2, C3f7, C3g4, C3h4, C4al, C4a2, C4a4, Cda7,
C4c3, C4d5, C4e2, C4f7, C4g4, C4h4, Chal, C5a2, C5a4, C5a7, C5c3, C5d5, C5e2, C5f7, Chg4,
C5h4, Cea1, C6a2, C6a4, Cba7, C6c3, C6d5, C6e2, C6f7, C6g4, C6h4, C7al, C7a2, C7a4, C7a7,
C7c3, C7d5, C7e2, C7f7, C7g4, C7h4, C8al, C8a2, C8a4, C8a7, C8c3, C8d5, C8e2, C8f7, C8g4,
C8h4, C9a1, C9a2, C9a4, C9a7, C9c3, C9d5, C9e2, C9f7, C9g4, C9h4, C10al1, C10a2, C10a4, C10a7,
C10c3, C10d5, C10e2, C10f7, C10g4, C10h4, C11al, C11a2, C11a4, C11a7, C11c3, C11d5, C11e2,
C11f7, C11g4, C11h4, C12a1, C12a2, C12a4, C12a7, C12c3, C12d5, C12e2, C12f7, C12g4, C12h4,
D1al, D1a2, D1a4, D1a7, D1c3, D1d5, D1e2, D17, D1g4, D1h4, D2a1, D2a2, D2a4, D2a7, D2c3, D2d5,
D2e2, D27, D2g4, D2h4, D3a1, D3a2, D3a4, D3a7, D3c3, D3d5, D3e2, D3f7, D3g4, D3h4, D4al, D4a2,
D4a4, D4a7, D4c3, D4d5, D4e2, D47, D4g4, D4h4, D5al, D5a2, D5a4, D5a7, D5c3, D5d5, D5e2, D5f7,
D5g4, D5h4, D6a1, D6a2, D6a4, D6a7, D6c3, D6d5, D6e2, D67, D6g4, D6h4, D7al, D7a2, D7a4, D7a7,
D7c3, D7d5, D7e2, D7f7, D7g4, D7h4, D8a1, D8a2, D8a4, D8a7, D8c3, D8d5, D8e2, D8f7, D8g4, D8h4,
D9al, D9a2, D9a4, D9a7, D9c3, D9d5, D9e2, D9f7, D9g4, D9h4, D10al1, D10a2, D10a4, D10a7, D10c3,
D10d5, D10e2, D10f7, D10g4, D10h4, D11al1, D11a2, D11a4, D11a7, D11c83, D11d5, D11e2, D117,
D11g4, D11h4, D12a1, D12a2, D12a4, D12a7, D12c3, D12d5, D12e2, D127, D12g4, D12h4

The following wells have data that triggered the CTFAIL flag.

A1b8, A115, A2b5, A2c6, A2e1, A2f1, A2h7, A3c4, A3c6, A3f1, A3h6, Adab, Ada8, Add5, Add7, Adg2,
A4h3, A5a5, A5e8, A5f1, A5f6, A5h6, A6ab, A6d5, A6e7, ABhd, A7b3, A7d7, A7e8, ABa5, A8d3, A8dS,
A8e5, A8g2, A8g5, A8Bh5, A9a7, A9e6, A9f1, A9g2, A9g3, A10a5, A10e6, A10g3, A10g7, A11e8, A11f1,
A11g2, A12a7, A12a8, A12c6, A12d3, A12e3, A12e8, A12f2, A12h4, B1a6, B1e6, B1h4, B2c6, B2c7,
B3a5, B3e1, B3g2, B4c2, B4d4, B4d5, B4d8, B47, B4h4, B6al, B6b4, B6b8, B6c8, B6d3, B6el, B6f1,
B6f2, B6f8, B6g6, B6g7, B6h2, B6h4, B7b2, B7c6, B7c8, B7g3, B7h2, B8a3, B8b1, B8c1, B8d6, B8dS,
B8e1, B8h6, B9a7, B9c2, B9c3, B9f7, B10c6, B10c8, B10e1, B10e5, B10f6, B10f7, B10g2, B10g3,
B10h4, B11c4, B11c6, B11c8, B11d4, B11e3, B11e6, B12a5, B12b1, B12c1, B12¢5, B12¢6, B12d1,
B12e1, B12e5, B12g1, B12g2, C1al, C1b5, C1c1, C1d6, C1g3, C2c6, C2¢c7, C2f1, C3e3, C3f1, C3g2,
C4c6, C4e7, C4h3, C4h6, C5a2, C5a5, C5h6, C61, C6g3, Ceh4, C7d5, C7f1, C8b2, C8h6, CIb5,
C9c3, C9f4, C9g2, COh7, C10e8, C11a7, C11b2, C11c6, C11c8, C11d3, C11e5, C11e7, C11f4, C11g3,
C12a7, C12d8, C12e2, D1e6, D15, D2a2, D2e1, D2e4, D2g5, D3c6, D3d8, D3e5, D4d5, D4g3, D5¢7,
D6a1, D6a7, D6b1, D6c6, D6d4, D6d5, D65, D66, D6f8, D6h3, D6h4, D7b1, D7g3, D8a7, D8c2, D8d5,
D8d7, D8e2, D8g6, D8g7, D8h4, D8h7, D9a5, D10b3, D10c3, D10d5, D10d8, D10e2, D10e5, D10e7,
D10g3, D10h3, D11f8, D12c4, D12¢6, D12e2, D12g1, D12h3, D12h4, D12h6
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View the QC Summary

1.

From the Experiment Menu, select Analysis » QC Summary.
If no data are displayed, click Analyze

Review the Flags Summary.

A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment.
If the frequency is >0, the flag appears somewhere in the experiment; the well position is listed in
the Wells column.

In the example experiment, there are 635 flagged wells.

In the Flag Details table, click each flag with a frequency >0 to display detailed information about
the flag.

In the example experiment, the SMCLUSTER flag appears 416 times and the CTFAIL flag appears
219 times.

For genotyping experiments, flag appearance is triggered by experiment data or the assay. If a

flag has been triggered by the assay, the Plate Layout does not display the . icon. The flag
details appear in the QC Summary. In the example experiment, some samples have only one allele
present and therefore indicate many CTFAIL flags because there is no amplification plot for the
second allele.

(Optional) For those flags with frequency >0, click the troubleshooting link to view information
about correcting the flag.

The QC Summary for the OpenArray™ genotyping example experiment looks like this.

Flag Description Frequency Wells <

Flag: CTFAIL—CT algorithm faied
Flag Detail: The software cannot calculate CT.

Flagged Wells: A1bS, A1fS, A2bS, A2c6, A2e1, A2f1, A2h7, A3c4, A3C6, A3f1, A3h6,
A4a6, A4a8, A4dS, A4d7, A402, A4h3, A5a5, ASeB, ASf1, ASf6, AShe,
A6a6, A6dS, A6e7, AGh4, A7D3, A7d7, A7e8, ABaS, ABd3, ABdS, ASeS,
A8g2, ABgS, ABNS, A9a7, A%e6, ASF1, ASG2, ASg3, A10aS, AL0e,
A10g3, AL0g7, Alle8, A11f1, A11g2, A12a7, A12a8, A12c6, Al2d3,
A12€3, A12¢8, A12f2, A12h4, B1a6, Ble6, B1h4, B2c6, B2c7, B3aS,
B3el, B3g2, B4c2, B4d4, B4d5, B4d8, B4f7, B4hd, B6al, B6b4, BEbS,
B6C8, B6d3, Beel, B6f1, B6f2, B6fS, B6g6, B6g7, B6h2, B6hd, B7b2,
B7c6, B7c8, B7g3, B7h2, B8a3, B3b1, B3c1, B3d6, B3dS, B8el, B3he,

luorescence s offscale
No signal in well
ostwe control faled
mall number of samples in cluster 0
Ampification in negatwe control
o ampification
oise higher than others in plate
oise spikes

algorkthm failed
aseine algortthm faied
hresholding algorithm failed
CT algorithm faled la13

C__10008862_10, C_27...

B9a7, B9c2, BIC3, BIf7, B10c6, B10c8, B10e1, B10eS, B10f6, B10f7,
B10g2, B10g3, B10h4, B11c4, B11c6, B11c8, B11d4, B11e3, Bl1e6,
B12a5, B12b1, B12cl1, B12c5, B12c6, B12d1, B12el, B12e5, B12g1,
B12g2, Clal, C1b5, Clcl, C1d6, C1g3, C2c6, C2c7, C2f1, C3e3, C3f1,
(392, C4c6, C4e7, C4h3, C4h6, C5a2, C5as, C5he, C6f1, C6g3, Cohd,
C7ds, C7f1, C8b2, C8h6, CIbS, C9c3, C9f4, C9g2, Coh7, C10e8,
Ciia7, C11b2, Ciic6, Clic8, Ci1d3, CiieS5, Cile7, Ciif4, C11g3,
C12a7, C12d8, C12e2, D1e6, D1f5, D2a2, D2el, D2e4, D2g5, D3c6,
D3d8, D3es, D4ds, D4g3, D5c7, Déal, Déa7, Deb1, D6c6, D6d4,
D6dS, D6fS, Déf6, D68, DEh3, D6h4, D7b1, D793, D8a7, D82,
D8ds, D8d7, D8e2, D8g6, D897, D8h4, D8h7, D9as, D10b3, D10c3,
D10dS5, D10d8, D10e2, D10eS, D10e7, D10g3, D10h3, D11f8, D12c4,
D12c6, D12e2, D12g1, D12h3, D12h4, D12h6

View CTFAIL Troubleshooting Information

|A1b8, A1f5, A2bS5, A2¢6,...

Possible flags

The flags listed below may be triggered by the genotyping experiment data.

Flag Description

Preprocessing flag

OFFSCALE

Fluorescence is off scale.
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(continued)

Flag Description

Primary analysis flags

BADROX Bad passive reference signal.

NOAMP No amplification.

Flag
NOISE Noise higher than others in plate
SPIKE Noise spikes.

NOSIGNAL | No signal in well.

EXPFAIL Exponential algorithm failed.

BLFAIL Baseline algorithm failed.

THOLDFAIL | Thresholding algorithm failed.

CTFAIL Cr algorithm failed.

AMPSCORE | Amplification in the linear region is below a specific threshold, corresponding to the score set
in the analysis settings.

Secondary analysis flags

AMPNC Amplification in the negative control.

HIGHSD High standard deviation in replicate group.

The BADROX and AMPSCORE flags, by default, are not in use for the genotyping experiment.

For the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL flags are not
reported, but they appear in the QC Summary (by default, a 0 is displayed in the Frequency column for
each flag).

(Optional) Adjust parameters for reanalysis of your own experiments
The Analysis Settings dialog box displays the analysis settings for the threshold cycle (Cgy), and flags
options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own
experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your
experiment.
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View the analysis settings

1. From the Experiment Menu, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings di
experiment, the default analysis settings are used for each tab.

* Call Settings
® Cy Settings
* Flag Settings

The Analysis Settings dialog box for the OpenArray™ genotyping ex
this.

alog box. In the example

ample experiment looks like

~ Data Analysis Settings

2

© Analyze Datz from Post-PCR Read Only Q Analyze Data from Pre-PCR Read and Post-PCR Read
() Analyze Rea-Time Rn Data (%) Analyze Real-Time Rn - Median(Rna to Rnb)

— Default Call Settings
Default call settings are used to make allele calls for SNP assays without custom settings. To edit the default settings, dick Edit Default Settings.

Autocaler Enabled: Yes Keep Manual Calls from Previous Analysis: Yes Quality Value: 95 |3 ETIEEITN G

~ Select a SNP Assay Call Settings for C 177489_10——
SNP Assay Analysis Type Autocaller Keep Manual Calls | Quality Value Apply Call Settings: [ Default Settings
C__ 177489 10 Default Yes Yes 95 =
C___ 940286_10 Default Yes Yes a5
C___1046426_10 Default Yes Yes 95
C__1085595_10 Default Yes Yes 95
C__1213693_10 Default Yes Yes 95
L AnNAREAT 4 P e Ve Vmm ne b/

3. View and, if necessary, change the analysis settings.
See “Adjust analysis settings” on page 161).

You can save the changes to the analysis settings to the Analysis Settings Library for later use.

See “Change analysis settings” on page 137.

4. Click Apply Analysis Settings to apply the current analysis settings.

If necessary, click Revert to Default Analysis Settings to go back to the default analysis settings.
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Adjust analysis settings

Adjust call settings

Use the Call Settings tab to adjust analysis settings.

® (Change the default data analysis settings.

Analyze data from Post-PCR Read only—Select this option if you do not want to use data
from the pre-PCR read to determine genotype calls.

Analyze data from Pre-PCR Read and Post-PCR Read—If you included the pre-PCR read in
the run, select this option to use data from the pre-PCR read to determine genotype calls.

Analyze Real-Time Rn Data—If you included amplification in the run, select this option to use
the normalized reporter (Rn) data from the cycling stage to determine genotype calls.

Analyze data from Rn - Avg (Rna - Rnb)—If you included amplification in the run, select
this option to use the subtracted median of the normalized reporter (Rn) data from the cycling
stage to determine genotype calls, where Rna to Rnb refers to all the cycles from the Start
Cycle Number to the End Cycle Number. The average subtraction provides improved data
accuracy.

)|

Note: To activate the Reveal Traces feature on the Allelic Discrimination Plot, select either
Analyze Real-Time Rn Data or Analyze data from Rn - Avg (Rna - Rnb).

¢ Edit the default call settings. Click Edit Default Settings, then specify the default settings.

Autocaller Enabled —Select this setting for the software to make genotype calls using the
autocaller algorithm.

Keep Manual Calls from Previous Analysis —If the autocaller is enabled, select to maintain
manual calls after reanalysis

Quality Value—Enter a value to use to make genotype calls. If the confidence value is less
than the call setting, the call is undetermined.

® Use custom call settings for an SNP assay.

Select one or more SNP assays in the table, then deselect the Default Settings checkbox.
Define the custom call settings.

Adjust Ct settings

Use the Data Step Selection feature to select one stage/step combination for Ct analysis when there is
more than one data collection point in the run method.

Adjust flag settings

Use the Flag Settings tab to:

* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the QuantStudio™ 12K Flex Software.
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1. In the Flag Settings tab, in the Use column, select the checkboxes for flags to apply during
analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying
the flag.
If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the
appropriate setting.

3. In the Reject Well column, select the checkboxes if you want the software to reject wells with the
flag.

After you have rejected the flagged wells, analysis results depend on factors such as the
experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments
using the Standard Deviation calculations may change the result of Cgy SD. For some flags,
analysis results calculated before the well is rejected are maintained.

4. In the Analysis Settings dialog box, click Apply Analysis Settings.
If the run status is complete, the data are reanalyzed.
The Flag Settings tab looks like this.

ﬁ e L B —'E
Call Settings Cr Settings Flag Settings

@ Configure the flags and fitering. In this panel you can enable, disable, and configure flags, and indicate if a welis to be rejected when a flag is raised.

Flag 'Desmpnnn T use Attribute Condition " Value Reject Well
AMPSCORE AMP Score O AMP Score < ~ [1.000
BADROX Bad passive reference ... [ i} Fluorescence < + [500.000
OFFSCALE Fluorescence i offscale =] ]
NOSIGNAL No signal in well O
PCFAIL Positive control faled
SMCLUSTER Small number of sampl... Number of data points... < v [2.000
AMPNC Amplification in negativ... Cr w [35.000 O
NOAMP No amplfication Amplification algorithm ...|< w |0.100 ]
NOISE [Noise higher than oth... Relstive noise ~ [4.000 [}
SPIKE Noise spikes Spike algorithm result w [[1.000 O
EXPFAIL [Exponentil algorithm ... O
BLFALL Baseline algorithm faled O
THOLDFAIL Thresholding algorithm... =] O
CTFAIL CT algorithm faled O

(Optional) Export the analyzed data

1. Open the genotyping example experiment file that you analyzed in Chapter 11, “Perform the
instrument run”.

2. In the Experiment Menu, click £ Export.

Note: To export data automatically after analysis, select the Auto Export checkbox during
experiment setup or before running the experiment. Auto export is unchecked for the example
experiment.
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3. In the top of the screen, select QuantStudio 12K Flex format.

4. Complete the Export screen.

Field or Selection Entry

Export Data To One File

Filter Bookmark Data No

Export File Location <...>\Applied Biosystems\QuantStudio 12K Flex
Software\experiments

Export File Name Genotyping Starter Kit
Example QuantStudio export

File Type o (ixt)
e (*.xls)

* (*.xlsx)

Select Data to export/ Select Select the All Fields checkbox or select a specific set of
Content checkboxes.

The completed Export screen should look like this.

[ Auto Export Format : |QuantStudio 12KFlex v Export Data To: @ One Fie O Separate Fies Fiter Bookmark Datz : O Yes ® No Open fie(s) when export is complete
Export Fie Location: |C:\Applied Biosystems\QuantStudio 12K Flex Software\User Files\e xperiments
Export File Name: |Genotyping Starter Kit Example_QuantStudio_export Fle Type: |[F) (xtxt) &

] sample Setup [JRawpata | [ Amplification [ Muticomponent

Skip Empty Wels [ Skip Omitted Wels

Select Content Well Well Position || Omit Sample Name | SNP AssayN... | Task Allelel R Allele2 R Pass.Ref

7] All Fields 2 1A1a1 (m] NA17004 C__177489_10 UNKNOWN 338.000 1,447.676
el 24122 ] NA17004 C___040286_10 UNKNOWN 1,864.954 54.500
3Al1a3 O NA17004 C__1046426_10 UNKNOWN 272.798 2,280.990
Well Poskion 4A124 O NA17004 C__1085595_10 UNKNOWN 2,252.908 1,035.927
5A135 O NA17004 C__1213603_10 UNKNOWN 2,351.520 89.401
Omit 6 Ala6 O NA17004 C___1240647_1_ UNKNOWN 161.586 3,219.506
7A127 O NA17004 C__1240651_20 UNKNOWN 164.436 1,145.265
Sample Name 8A1a8 O NA17004 C__1332250_10 UNKNOWN 1,905.560 181.627
9A1b1 O NA17004 C__1376137_10 UNKNOWN 2,156.528 1,777.867
SNP Assay Name 10A1b2 =] NA17004 C__1551497_10 UNKNOWN 305.203 1,756.986
Task 11A1b3 O NA17004 C__1839948_10 UNKNOWN 1,300.943 59.720
12 A1b4 O NA17004 C__1985480_20 UNKNOWN 2,396.389 3,171.856
Alele1 R 13A1b5 O NA17004 C__2267279_10 UNKNOWN 2,141.680 468.944
14 A1b6 ] NA17004 C__2301954_20 UNKNOWN 2,407.912 2518912
Allele2 R 15A1b7 0 NA17004 C__2862873_10 UNKNOWN 2,232.974 268.073
pass.Ref 16 A1b8 O NA17004 C___3123006_1_ UNKNOWN 1,728.596 257.580
. 17 AtcL O NA17004 C__3123485_1_ UNKNOWN 2,607.119 218.453
Qualty(%) 18Al1c2 O NA17004 C___3168989_10 UNKNOWN 202.025 3,156.142
19413 u| NA17004 C__3197300_10 UNKNOWN 2,549,761 2,545.545
cal 20A1c4 [m] NAL7004 C__3237878_10 UNKNOWN 435.728 3,027.884

[¥1 Method ¥ | >

Start Export | Save Export Set As Il Load Export Set [ Delete Export Set || Export QC Images

5. Click Start Export.

The exported TXT file, when opened in Notepad, should look like this.
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it Example_QuantStudio_export.txt - Notepad

Barcode = GRQ92 A~
Block Type = opemrray Block =
Chemistry = TAQW,

Comment = NA

Date Created = 2012-01-23 17:20:26 PM SGT.

Experiment File Name = C:\Docs\QAExamples\GRQ92_GT_Training_Plate.eds

Experiment Name = Genotyping Starter Kit Example.eds

Experiment Run End Time = NOt Started

EXperiment Type = SNP Genotyping

Instrument Name = 285880030

Instrument Serial Number = 285880030

Instrument Type = Quantstudio 12K Flex

passive Reference
qQuantification Cycle method =

signal smoothing on = true

stage/ Cycle where Analysis is performed = stage 3, step 3
User Name = NA

R KRR A XK R KR L LR R EE

[Results]
well

well position omit Sample Name SNP Assay Name Task Allelel R Allele2 R Pass.Rref Quality (%)
call Method Amp Score Allelel Automatic €t Threshold Allelel ct Threshold Allelel Automatic Base'lme Allelel Baseline
start  Allelel Baseline End Allele2 Automatic ct Threshold Allele2 ct Threshold Allele2 Automatic Baseline Allele2 Baseline
start  Allele2 Baseline End  CTFAIL
1 false NAL7004 C___177489_10 UNKNOWN 338.090 1,447.676 98.534 Homozygous Allele 2/allele 2 Auto
1.300 true  22.280 true 3 25 true  60.119 3 17 N

Ala2 false NA17004 C. 940286_10 UNKNOWN 1,364 954 54.500 98.534 Homozygous Allele 1/Allele 1 Auto
0.503 true  57.720 true 3 15 true 3 9 N

Ala3 false  NAL7004 C__ 104642610 UNKNOWN 272 79& 2 280 990 98.514 Homozygous Allele 2/Allele 2 AuUTO
1.352 true  48.102 tr 3 20 true 30.686 true 3 15 N

Alad  false NA17004 & 1035595_10 UNKNOWN 2, 252. 908 1,035.927 98.534 Heterozygous Allele 1/allele 2
Auto  1.107  true  99.451 15 true  36.521 true 3 16 N

Ala! false_  NA17004 C 1213693_10 UNKNOWN 2, 351.529 89.401 98.534 Heterozygous Allele 1/allele 2 auto
0.000 true  53.127 true 3 true  48.359 true 3 32 N

Ala6  false  NA17004 C. 1240647_1_ UNKNOWN 161 SEG 3 219 Sﬂﬁ 98.524 Homozygous Allele 2/allele 2 Auto
1.461 true  29.242 true 3 22 true 14 N

Ala7 false NAL7004 C__ 1240651 20 UNKNOWN 164 436 1 145 265 98.534 Homozygous Allele 2/Allele 2 Auto
1.051 true  25.597 true 3 23 true  20.500 true a7 N

Alag  false  NAL7004 C__1332250_10 UNKNOWN 1,905.560 151 627 98.524 Homozygous Allele 1/allele 1 Auto
0.000 true  64.763 tr 3 16 true 55.166 true 36 N

Albl false NA17004 C___1376137_10 UNKNOWN 2,156.528 1 777.867 98.524 Heterozygous Allele 1/Allele 2
Auto 1.266 true 21.923 true 3 17 8.696 true 3 18 N

Alb2 false NAL17004 C___1551497_10 UNKNOWN 305 203 1 756 986 98.524 Homozygous Allele 2/allele 2 Auto
1.229 true  39.450 true 3 30 true 2 N

Alb3  false  NA17004 C__1839948_10 UNKNOWN 1,300343 59.720 98.524 Homozygous Allele 1/allele 1 Auto
0.744 true  16.402 true 3 true 239 true 3 22 N
2 Alb4  False NA17004 e 1985480)0 UNKNOWN 2, 396. 389 3,171.856 98.534 Heterozygous Allele 1/allele 2
Auto  1.375  true 38.108 15 true  70.526 true 3 17 N

AlbS false  NA17004 c 2267279_10 UNKNOWN 2,141.680 468.944 98.524 Homozygous Allele 1/Allele 1 Auto
0.000 rue 38.155 true true .212 true N

Alb6 false NA17004 C___2301954_20 UNKNOWN 2, 407912 2,518.912 98.481 Homozygous Allele 1/Allele 1
Auto 1.320 true 39.146 true 3 15 true 68,994 truE 3 15

Alb7  false NA17004 C___2862873_10 UNKNOWN 2,232.974 073 98.534 Homozygous Allele 1/allele 1 Auto

The exported XLS file should look like this. There is a separate tab for each data set that was selected
for export.

Al 8 | e [ o | E | F | & | u | 4 |« | v [ m | w | o | p | @ | R | s | T | u [ v | w | X [ ¥ | z | A | a8 | Ac | AD | AL | AF | AG | M [«

1 [Garseae |

2 [Block Typé 96-Wel Block (0.2mL)

3| Caliration Yes

4 |Calioration 08-07-2011

5 |Caliration tio

& |Calioration 05-07-2011

7 |Caliration o

8 |Caliration 06-07-2011

5 |Calirstion Nio

10 | Caliration 08-07-2011

11 | Caliration Yes

12 Caliration 08-07-2011

13 Caliration Yes

18 | Calbration 08-07-2011

15 | Chemstry TAQUAN

16 |Cor

17 |Date Creat 01-13-2015 2224:12 Pt PST

18 |Date odif 07-24-2023 0B:16:14 Al POT

19 Expe Fies 2 eds

20 Experimen 96-1¥el Genotyping Exampie

21 |Experimen 06-10-2011 223945 B PDT -

22 |Experimen 08-11-2011 00:13:21 Al POT

23 |Experimen Genotyping

24 |Exported  Cycle 40

25 nstrument QuantStudioDemo

26 nstument QuantStudioDemo

27 nstrument QuantStuio 12K Flex

28  Passive ReROX

29 Post Read Stage 4 Step 1.Cycke |

30 Pre-Read ¢ Stage 1,Step 1.Cyck 1

31 Quantiicat ct

32 |signal Smctrue

33 | Stage/ Cyc stage 3, Step 2

38 User Name

=

alwel |t Fonbont _|Sampe i Assay © Aot Mot Al o et Dyt Aheis? D\ NCE SHP (Coter e Gy Vo SHP Asenf Tan__| Al e e Dl Pase et iy O Aot AmAloe? A Al G Aloe2Ca Cai WMot _|CaCycke Al A e U1 Al Al e Ba Al s Adle2 At Al 1| dle At A2

a7 1Al FALSE  Sampl 1 Alele1  Alel2  VIC-IFQ-LFAN-NFQ- SNP Assal UNKNOV#N 16,600,070.000 0.582 Heterozyg Auto s TRUE oo TRUE A 21 TRUE 0182 TRUE 3

El 2/ FALSE  Sample2 Mol Aleaz VCAFGAFAAFG. S AN 1470 345e o, Seio Tl 1 057e 0500 ey Al 40 TRUE 0068 TRUE 3 2 TRUE 0183 TRUE 3

ol 3A3 FALSE  Sampe3 Alele 1 Al 2 VICHIFOL FANNFQ- SNP AssaiUNKNOWN  0.12¢  48¢1 17703852000 86416 0000 1474 000D 0.883 Homozygo Auto 4 TRUE 0063 TRUE 3 3 RUE 0183 TRUE 3

ol +aL FALSE  Sample £ Alele 1 Alele 2 VICHFO-L FAINFQ- SNPAssaUNKNOWN 0122 6080 18362614000 ©6.415 0000 1473 000D 0.987 Homozyoo Auto 40 TRUE 0063 TRUE 3 3 TRUE 0183 TRUE 3

] 5 A5 FALSE  Sample & Alele 1 Alele 2 VICHFQL FAINFO- SNP Assal UNKNOWN 0108 5020 16548211000 SG.415 0000 1477 0000 0.925 Homozygo Auto 4 TRUE 0063 TRUE 3 3 TRUE 0183 TRUE El

2| 646 FALSE  Sample6 Alele 1 Alele 2 VIC-NFQ- FAI-NFQ- SNP AssalUNKNOWN  0.092 5062 16990208000 6415 0000 1471 0000 0.957 Homozygo Auto 40 TRUE 0063 TRUE 3 3 TRUE 0183 TRUE El

o 7 a1 FALSE  Sampl 1 Alele 1 Alele2  VICNIFQFAN-NFQ- SNP AssalUNKNOWN 0878 0371 16755000000 S6.415 1035 075 0805 0.828 Homozygo Auto s TRUE  o0o0s0 TRUE 2 2 TRUE 0040 TRUE El

) 848 FALSE  Sample2 Alele 1 Al 2 VIG-HIFQ-h FAII-NFQ- SNPAssaiUNKNOWN 0951 0357 16935728000 96415 1037 0767 082  0.622 Homozygo Auto 40 TRUE 0040 TRUE 3 2 TRUE 0040 TRUE 3

5] 5 a8 FALSE  Sampe3 Alele 1 Al 2 VICHIFOL FANNFQ- SNP AssalUNKNOWN 0913 0403  16,77,012000 86416 1018 0785 0805 0.843 Homozygo Auto 4 TRUE 004D TRUE 3 2 TRUE 0040 TRUE 3

| 10 A10 FALSE  Sample £ Alele 1 Alele 2 VICHFO-L FAINFQ- SNPAssaiUNKNOWN 0087 0830 16398268000 ©6.415 0000 0997 0000  0.801 Homozyoo Auto 40 TRUE 0040 TRUE 3 39 TRUE 0040 TRUE 3

a7 1 At FALSE  Sample & Alele 1 Alele 2 VICHFQL FAINFO- SNP Assal UNKNOWN  0.032 0854 16,419.438000 S6.415 0000 1000 0000  0.880 Homozygo Auto 4 TRUE 0040 TRUE 3 3 TRUE 0040 TRUE El

@ 12 a12 FALSE  Sample Alele 1 Alele 2 VIC-NFQ- FAI-NFQ- SNP AssalUNKNOWN  0.090 0885 16,089,065000 S6.415 0000 0.995 0000 0.833 Homozygo Auto 40 TRUE 0040 TRUE 3 3 TRUE 0040 TRUE El

s 13 81 FALSE  Sample 7 Alele 1 Alele2  VICNIFQFAN-NFQ- SNP AssalUNKNOWN  0.122 4885 15917262000 S6.415 0000 1473 0000 0.985 Homozygo Auto s TRUE oo TRUE 2 3 TRUE 0182 TRUE El

50 1482 FALSE  Sampe Alele 1 Al 2 VIG-HIFQ-h FAII-NFQ- SNP AssalUNKNOWN 1491 3516 16, 1165 1367 0373 0962 eterozyg Auto 40 TRUE 0068 TRUE 3 21 TRUE 0183 TRUE 3

51 1583 FALSE  Sampes Alele 1 Al 2 VICHIFOL FANNFQ- SNP AssalUNKNOWN  0.108 5023 0000 1476 0000 0884 Homozygo Auto 4 TRUE 0063 TRUE 3 3 RUE 0183 TRUE 3

2 16 B4 FALSE _ Sample 10 Alele 1 Alele 2 VICNFOL FAN-NFQ- SNPAssa UNKNOWN 1475 3462 18000324000 S6.415 1148 1353 DSTI  0.983 Heterozyg Auto 40 TRUE 008 TRUE b 21 TRUE 0182 TRUE 3
sample Setup Amplification Data Results ® Kl | D
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Part

Custom miRNA OpenArray™ panels

This section covers miRNA chemistry. For advanced miRNA chemistry, see TagMan™ Advanced miRNA
Assays User Guide— TrueMark™ OpenArray™ Plates (Pub. No. MANOO16124).
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Custom miBRNA OpenArray™ panels

This part provides information to perform runs with the custom miRNA OpenArray™ panels.

For advanced miRNA chemistry, see TagMan™ Advanced miRNA Assays User Guide— TrueMark™
OpenArray™ Plates (Pub. No. MANO016124).

Plates

The instructions in this document use three types of plates. The plates are described in detail in
Appendix B, “Plate information”.

* MicroAmp™ Optical 96-Well Reaction Plate (96-well plate)
A non-optical 96-well reaction plate can also be used.

* OpenArray™ 384-well Sample Plate (384-well plate, for QuantStudio™ 12K Flex OpenArray™
AccuFill™ System)

* TrueMark™ OpenArray™ Plate (OpenArray™ Plate)

Data files

Data files are used to track your assays and samples.

The instructions in this guide use four types of data files.

* Sample information file (CSV)—Allows input of Sample IDs. See “Sample information file (CSV)” on
page 167.

* Plate setup file (TPF)—Allows input of Assay IDs and cycling protocol. See “Plate setup file (TPF)”
on page 167.

¢ Template file (EDT)—Includes complete setup information (samples, assays and cycling protocol)
saved as a template. See “Template file (EDT)” on page 168

* Experiment file (EDS)—A complete data file. See “Experiment file (EDS)” on page 168,.
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Additional data files (AIF, TXT) are available for selection if you use the Batch Experiment Setup Utility
in the software to create and run your own experiments. See the QuantStudio™ 12K Flex Software Help
(click € or press FI).

Sample information file (CSV)

We recommend that you create or use a comma-delimited file (CSV) to track your cDNA samples. Use a
sample information file to perform these tasks.
* Track where samples and controls are located in the 96-well plate. See Chapter 14, “Prepare the
nucleic acid samples”.
* Map the sample locations, depending on the TrueMark™ OpenArray™ Plate format being used.
— Map the sample locations from the 96-well plate to the appropriate locations in the 384-well
plate. See Chapter 15, “Prepare the OpenArray™ 384-well Sample Plate”.
— Map the sample locations from the 384-well plate areas to the appropriate locations in each
TrueMark™ OpenArray™ Plate. See Chapter 16, “Prepare the OpenArray™ Plate”.

* Associate information about the samples with the data results to normalize data or to compute
standard curves and calculate concentrations.

IMPORTANT! To enable accurate results, you must correctly track sample information from plate to
plate.

For OpenArray™ AccuFill™ Software v2.0, all sample tracking and mapping features are available in this
software. The OpenArray™ Sample Tracker Software is not used for OpenArray™ AccuFill™ Software
v2.0.

* OpenArray™ 384-well Sample Plate—Integrate this file with a plate setup file in the OpenArray™
AccuFill™ Software. See “Prepare the plate setup files” on page 185.

* TrueMark™ OpenArray™ Plate—Import this file directly into the QuantStudio™ 12K Flex Software
before starting a run (see “Start a run from the software” on page 200), or after the run is complete.

Plate setup file (TPF)

(Optional) Use an OpenArray™ Plate setup file
Plate setup files (TPF) contain the assay information for individual OpenArray™ Plate formats, including
the gene symbol, gene name, assay ID, and location of each assay on the plate.

* Use the OpenArray™ AccuFill™ Software to integrate the sample information from a 384-well plate
file (CSV) with the assay information in the plate setup file. See “Prepare the plate setup files” on
page 185.

* Upload the assay information in the plate setup file directly into the QuantStudio™ 12K Flex
Software to create and run an experiment (EDS). See “Start a run from the software” on page 200.
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Download your own plate setup files

For miRNA experiments, use template files (EDT) supplied with the QuantStudio™ 12K Flex Software.
The files are located at

<...>:\Program Files (x86)\Applied Biosystems\QuantStudio 12K Flex
Software\templates\OpenArray, where <. . .> is the installation drive. The default installation
drive is C: if the software is installed by the customer. The default installation drive is D: if the software
is installed by a Thermo Fisher Scientific field service engineer.

The miRNA EDT files located at <..>\Program Files (x86)\Applied
Biosystems\QuantStudio 12K Flex Software\templates\OpenArray include:
® miRNA Human.edt
® miRNA Rodent.edt

* (Recommended) Use the EDT file to integrate samples in the OpenArray™ AccuFill™ Software. If you
plan to integrate samples, save the file to the OpenArray™ plate file input folder that you selected
in the Preferences dialog box of the OpenArray™ AccuFill™ Software. The default save location is
<...>:\OpenArray\OpenArray Plates.

* Use the EDT file directly in the QuantStudio™ 12K Flex Software to start an experiment, then upload
samples to the experiment file (EDS) in the software after the experiment is run. See “Use an
OpenArray™ Plate setup file” on page 201.

Template file (EDT)

An experiment document template file (EDT) contains predefined experiment setup information, such as
experiment type, assay names, and run method.
You can access a template to create a new experiment from the two locations.

¢ QuantStudio™ 12K Flex Software. See “Start a run from the software” on page 200.

* QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen. See “Start a run from the
instrument touchscreen” on page 202.

The example template files are located at <. . .>:\Program Files (x86)\Applied
Biosystems\QuantStudio 12K Flex Software\templates\OpenArray, where<...>is
the installation drive. The default installation drive is C: if the software is installed by the customer.
The default installation drive is D: if the software is installed by a Thermo Fisher Scientific field
service engineer.

Experiment file (EDS)

An experiment document single file (EDS) is an electronic record used by the QuantStudio™ 12K Flex
Software that contains information about a particular OpenArray™ Plate run on the QuantStudio™ 12K
Flex Real-Time PCR Instrument.

The EDS file includes the following information:
* Metadata
- Name
— Barcode

- Comments
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* Experiment setup
— Well contents
— Assay definitions
¢ Run method (thermal cycling protocol)
* Run results
* Analysis protocol
* Analysis results
¢ Audit records
® Other plate-specific data

Use an EDS file to perform these tasks.

¢ Create and run an experiment using the QuantStudio™ 12K Flex Software. See “Start a run from the
software” on page 200.
To create and run the starter kit experiments, use the example template files (EDT) supplied with the
QuantStudio™ 12K Flex Software. See “Template file (EDT)” on page 168.

* Create and run an experiment using the QuantStudio™ 12K Flex Real-Time PCR Instrument
touchscreen. See “Start a run from the instrument touchscreen” on page 202.

* Analyze the experiment results in the QuantStudio™ 12K Flex Software. See Chapter 18, “Analyze
the experiment results”.
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Workflow

Custom miRNA OpenArray™ panels

Prepare the nucleic acid samples (page 171)
The workflow for sample preparation can vary.

Prepare the OpenArray™ 384-well Sample Plate (page 178)

Track the samples, prepare the PCR mix, and transfer the samples to the OpenArray™ 384-well
Sample Plate.

Prepare the OpenArray™ Plate (page 181)
* Prepare for sample transfer using 384-well plates.

* Transfer the samples from 384-well plates to the OpenArray™ Plate using the QuantStudio™
12K Flex OpenArray™ AccuFill™ System.

® Seal the OpenArray™ Plate.
* Complete sample transfer for each remaining OpenArray™ Plate.

Perform the instrument run (page 195)
* Prepare the QuantStudio™ 12K Flex Software.
® [oad the OpenArray™ Plate into the instrument.
® Run the OpenArray™ Plate formats.
* (Optional) Monitor the run.
* Unload the OpenArray™ Plate from the instrument.
* Transfer the experiments results to the computer.

Analyze the experiment results (page 210)
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Workflow

Prepare nucleic acid samples for a microRNA experiment

- Isolate the RNA starting material (page 172)

. Reverse transcribe the RNA with Megaplex™ RT primers (page 173)

Preamplify the cDNA with Megaplex™ PreAmp Primers (page 175)

Required materials

IMPORTANT! For the SDS of any chemical not distributed by Thermo Fisher Scientific, contact the

chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer,
and observe all relevant precautions.
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¢ Isolate the RNA starting material

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

Item Source
One set of Megaplex™ Primer Pools for your selected microRNA panel | See “Megaplex™ Primer Pools” on
page 173.

mirVana™ miRNA lIsolation Kit, with phenol AM1560
TagMan™ MicroRNA Reverse Transcription Kit, 200 reactions 4366596
TagMan™ PreAmp Master Mix Kit 4384266
MicroAmp™ Optical 96-Well Reaction Plate 4316813

¢ MicroAmp™ Clear Adhesive Film e 4306311

or or

*  MicroAmp™ Optical 8-Cap Strips e 4323032
Thermal Cycler MLS
0.1X TE pH 8.0 MLS

Note: Do not use TagMan™ Advanced miRNA cDNA Synthesis Kit (Cat. No. A28007). This kit is
optimized for advanced microRNA assays.

Isolate the RNA starting material

To prepare RNA samples, use the mirVana™ miRNA Isolation Kit, with phenol for preparing high-quality

total RNA containing miRNA species. Follow the total RNA isolation procedure (do not follow the option
for enrichment for small RNAs).

Before performing a run, import the sample names and save the file as EDS. Use this EDS file to run the
miRNA experiment.
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Reverse transcribe the RNA with Megaplex™ RT primers

Megaplex™ Primer Pools

The Megaplex™ Primer Pools include content-matched pools of Megaplex™ RT Primers and Megaplex™
PreAmp Primers.

Use...
For...
Megaplex™ Primer Pools Contents Storage
Human Megaplex™ Primer Pools, Human | ® Megaplex™ RT Primers Pool A -25°C to -15°C
nucleic acid Pools Set v3.0 (Part No. e Megaplex™ RT Primers Pool B
4444750) e Megaplex™ PreAmp Primers Pool A
gaplex™ PreAmp Primers Poo
Rodent Megaplex™ Primer Pools, Rodent | ® Megaplex™ PreAmp Primers Pool B
nucleic acid Pools Set v3.0 (Part No.
4444766)

Set up the RT reactions

In this step, single-stranded cDNA is reverse transcribed from total RNA. Run two reverse transcription
(RT) reactions per sample, using Megaplex™ RT Primers Pool A and Pool B.

Each RT reaction has a final volume of 7.5 pL and contains:
* 100 ng (recommended) of total RNA in 3 pL
* 4.5 L of RT reaction mix, containing reverse transcriptase, Megaplex™ RT Primers Pool A or Pool
B, and other reverse transcription reagents
1. Thaw the following on ice.
* Megaplex™ RT Primers

* TagMan™ MicroRNA Reverse Transcription Kit components (do not vortex the MultiScribe™
Reverse Transcriptase)

* MgCl, (supplied with the Megaplex™ RT Primers)

2. Combine the following in each of two 1.5-mL microcentrifuge tubes (one for Pool A, the other for

Pool B).
RT reaction mix components Volume per reaction | Volume for 3 reactions!!]

Megaplex™ RT Primers (10X), Pool A 0.75 pL 25uL
dNTPs with dTTP (100 mM) 0.15 L 0.5 uL
MultiScribe™ Reverse Transcriptase (50 U/uL) 1.50 pL 5.1 pL
10X RT Buffer 0.75 uL 2.5 L
MgCl, (25 mM) 0.90 pL 3.0 uL
RNase Inhibitor (20 U/pL) 0.09 uL 0.3 pL
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(continued)

RT reaction mix components Volume per reaction | Volume for 3 reactions!!]
Nuclease-free water 0.35 uL 1.2 L
Total 4.50 uL 15.1 yL

' Includes 12.5% excess for loss from pipetting.

3. Pipet up and down to mix, then briefly centrifuge the tubes.

4. Transfer 4.5 pL of the RT reaction mix into the appropriate number of wells of a MicroAmp™ Optical
96-Well Reaction Plate, as shown in Figure 7 on page 174.

sample 1A Sample 18 SAmple 2A Sample 28 Sample 3A SAmple 38

Figure 7 96-well sample plate map (each square represents one sample well).

Note: Each RNA sample is processed in two wells: one for Pool A and one for Pool B. Each
96-well plate can process 48 samples.

5. Add 100 ng of total RNA (recommended amount) in 3 pL of solution to each well containing RT
Reaction Mix.

You can use 3 pL of water for the No Template Control (NTC) reactions.

6. Depending on the number of RT reactions, mix the reactions in one of these ways.

* Pipet each mixture up and down a few times, then seal the plate using MicroAmp™ Clear
Adhesive Film.

or

* Seal the plate using MicroAmp™ Clear Adhesive Film or MicroAmp™ Optical 8-Cap Strips, then
invert the plate a few times.

Note: Do not use MicroAmp™ Optical Adhesive Film to seal the plate. This film may be difficult to
remove after a run in the thermal cycler.

7. Centrifuge the plate briefly to collect the contents at the bottom of the wells, then incubate the
plate on ice for 5 minutes.

Run the RT reactions

1. Set up the run method in a thermal cycler using the following conditions.
* Ramp speed or mode—9,700 using Std or max ramp speed.
* Reaction volume (uL)—7.5 (enter 8 pL if your instrument accepts only whole number values)
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* Thermal cycling conditions:

Stage Temperature Time
Cycle (40 cycles) 16°C 2 minutes
42°C 1 minute
50°C 1 second
Hold 85°C 5 minutes
Hold 4°C Hold

2. Load, then run the plate.

If needed, you can store the RT product (cDNA) at —-25°C to —15°C for up to 1 month.

Preamplify the cDNA with Megaplex™ PreAmp Primers

Set up the preamplification reactions

In this step, specific cDNA targets are preamplified to increase the quantity of desired cDNA before
performing the PCR.
Each preamplification reaction has a final volume of 25 pL and contains:

e 2.5 pL of RT product (cDNA) from “Run the RT reactions” on page 174

e 22.5 uL of preamplification reaction mix, containing Megaplex™ PreAmp Primers Pool A or Pool B

and 2X TagMan™ PreAmp Master Mix

Use Megaplex™ PreAmp Primers Pools A or Pool B corresponding to the Megaplex™ RT Primers
Pool used for reverse transcription.

- Thaw the Megaplex™ PreAmp Primers on ice and mix by inverting a few times. Centrifuge briefly to
collect the contents at the bottom of the tubes.

2. Mix the 2X TagMan™ PreAmp Master Mix by swirling the bottle.

3. Prepare preamplification reaction mix, one for Pool A and one for Pool B, by combining the
following in each of two 1.5-mL microcentrifuge tubes.

Preamplification reaction mix components Volume for 1 reaction | Volume for 3 reactions!!!
2X TagMan™ PreAmp Master Mix 12.5puL 42.4 yL
Megaplex™ PreAmp Primers(10X), Pool A or Pool 25puL 8.4 uL
B2l
Nuclease-free water 7.5 L 25.3 uL
Total 225 L 76.1 pL

' Includes 12.5% excess for volume loss from pipetting.
21 Use Pool A in one tube, and Pool B in the other.

4. Pipet up and down to mix, then centrifuge the tubes briefly.
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Pipet 2.5 pL of each RT product into a well of a MicroAmp™ Optical 96-Well Reaction Plate. (Two
wells per RNA sample, one for the Pool A RT product and the other for the Pool B product.)

Dispense 22.5uL of preamp reaction mix into each well of the 96-well plate containing the
corresponding RT product (pool A or pool B).

Depending on the number of preamplification reactions, mix the reactions in one of these ways.

* Pipet each mixture up and down a few times, then seal the plate using MicroAmp™ Clear
Adhesive Film or MicroAmp™ Optical 8-Cap Strips.
or

* Seal the plate using MicroAmp™ Clear Adhesive Film or MicroAmp™ Optical 8-Cap Strips, then
invert the plate a few times.

Centrifuge the plate briefly to collect the contents at the bottom of the wells, then incubate the
plate on ice for 5 minutes.

Run the preamplification reaction

Set up the run method with the following conditions.

Ramp speed or mode—9,700 using Std ramp speed
Reaction volume (uL)—25
Thermal-cycling parameters:

Stage Temp Time
Hold 95°C 10 min
Hold 55°C 2 min
Hold 72°C 2 min
Cycle (12 cycles) 95°C 15 sec
60°C 4 min
Holdl 99.9°C 10 min
Hold 4°C Hold

[ Required for enzyme inactivation.

Dilute the preamplification products

1.

2.

176

Remove the 96-well plate from the thermal cycler, then briefly centrifuge the plate.

For each preamplification reaction, add 156 pL of 0.1 X TE pH 8.0 to one well of a new 96-well
plate.

Transfer 4 pL of each preamplification reaction to a well containing 0.1 X TE buffer (final dilution: 1
to 40).
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Preamplify the cDNA with Megaplex™ PreAmp Primers

4. Depending on the number of preamplification reactions, mix the diluted products in one of these
ways.
* Pipet up and down a few times, then seal the plate using MicroAmp™ Clear Adhesive Film.
or

® Seal the plate using MicroAmp™ Clear Adhesive Film or MicroAmp™ Optical 8-Cap Strips, then
invert the plate a few times.

5. Centrifuge the plate briefly to collect the contents at the bottom of the wells, then place the plate
on ice.

If needed, you can store the preamplified product (diluted or undiluted) at 4°C for up to 12 hours, or
at —-25°C to -15°C for up to 1 week.

Proceed to Chapter 15, “Prepare the OpenArray™ 384-well Sample Plate”.
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In this chapter, you use a 8- or 12-channel pipette to transfer the nucleic acid samples from the 96-well
reaction plates to OpenArray™ 384-well Sample Plate formats. The plates are described in detail in
Appendix B, “Plate information”.

You also track the sample locations from the 96-well reaction plates to the appropriate locations in the
384-well sample plates. The workflow for preparing the 384-well sample plate varies, depending on the
experiment type.

Workflow

Prepare the OpenArray™ 384-well Sample Plate

- Track the samples (page 179)

- Prepare PCR reaction mix A and B (page 180)

Transfer the PCR reaction mix (page 180)
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Required materials

IMPORTANT! For the SDS of any chemical not distributed by Thermo Fisher Scientific, contact the
chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer,
and observe all relevant precautions.

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

ltem Source
96-well reaction plates, containing preamplified cDNA samples | User supplied (see “Required materials” on
page 171)
2X TagMan™ OpenArray™ Real-Time PCR Master Mix, 1.5 mL 4462159
MicroAmp™ Optical 96-Well Reaction Plate 4316813
MicroAmp™ Clear Adhesive Film 4306311
OpenArray™ 384-well Sample Plate 4406947
OpenArray™ 384-Well Plate Seals 4469876
Fine-tip marker MLS

Track the samples

Track the samples from the 96-well reaction plates to the 384-well sample plates. For OpenArray™
AccuFill™ Software v2.0, samples are tracked in the OpenArray™ AccuFill™ Software. The samples are
tracked in the Map Plates tab.

For more information about OpenArray™ AccuFill™ Software v2.0, see QuantStudio™ 12K Flex
OpenArray™ AccuFill™ System User Guide (Pub. No. MAN0025669).

1. Proceed to transfer the samples as shown in Figure 2 on page 180. You do not need to enter
sample information from the 96-well sample plates at this time.

You can edit the sample information directly in the QuantStudio™ 12K Flex Software before starting
the run. See Chapter 17, “Perform the instrument run”.

2. Use a fine-tip marker to label the 384-well sample plate.
a. Label the 384-well sample plate with a unique identifier.

b. Mark the sections of the OpenArray™ 384-well Sample Plate to transfer samples from the
96-well reaction plates with the diluted preamplification product.
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Prepare PCR reaction mix A and B

Note: All volumes include 12.5% excess volume to accommodate the loss that occurs during
pipetting.

1. If the diluted preamplification products were stored frozen, thaw the 96-well reaction plate
completely on ice. Mix by inverting the sealed plate a few times or by gently vortexing, then
centrifuge the plate briefly.

2. Mix the TagMan™ OpenArray™ Real-Time PCR Master Mix by swirling the bottle.

3. For each sample, pipet 22.5 L of master mix into each of two adjacent wells (one for Pool A and
one for Pool B) of a clean 96-well reaction plate.

4. For each sample, pipet:
e 22.5 L of diluted Pool A preamplification product into one well of each pair.

e 22.5 uL of diluted Pool B preamplification product into the other well.

5. Seal the 96-well reaction plate with adhesive film, vortex gently to mix, then centrifuge the plate
briefly.

Note: If needed, you can store the sealed 96-well reaction plate at 4°C for up to 12 hours.

Transfer the PCR reaction mix

The PCR reaction mix is transferred as shown in Figure 8 on page 180.

1 2 3 4 3 6 7 8 9 10 11 12
Sample 1A Sample 1A Sample 1B Sample 1B SAmple 2A SAmple 2A Sample 2B Sample 2B Sample 3A Sample 3A SAmple 3B SAmple 3B

=

w

Sample 1A Sample 1A Sample 1B Sample 1B SAmple 2A SAmple 2A Sample 2B Sample 2B Sample 3A Sample 3A SAmple 3B SAmple 3B

Z |Sample 1A Sample 1A Sample 1B Sample 1B SAmple 2A SAmple 2A Sample 2B Sample 2B Sample 3A Sample 3A SAmple 3B SAmple 38

()

Sample 1A Sample 1A Sample 1B Sample 1B SAmple 2A SAmple 2A Sample 2B Sample 2B Sample 3A Sample 3A SAmple 3B SAmple 38

Figure 8 384-well sample plate map (eight wells per sample-pool combination).

1. Transfer 5 pL of PCR reaction mix A to the following 8 wells of the 384-well sample plate: A1, A2,
B1, B2, C1, C2, D1, and D2.

2. Transfer 5 pL of PCR reaction mix B to the following 8 additional wells of the 384-well sample
plate: A3, A4, B3, B4, C3, C4, D3, and DA4.

3. Cover the sample plate with foil, vortex gently to mix, then centrifuge for 1 minute at 1,000 x g to
eliminate bubbles.

4. (Optional) Place the sample plate on ice, in the dark, for up to 1 hour.

Proceed to Chapter 16, “Prepare the OpenArray™ Plate”.

180 QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide



Prepare the OpenArray™ Plate

B OWOTK I OW .. 181
B Required materials ... ... e e 181
B Prepare for sample transfer . ... ... i e e 183
B Transferthe samples . ... i e e e e e 185
B Seal the OpenArray ™ Plate . .. ...ttt et e e 191
B Guidelines for high-throughput loading ........... i e e e 194

In this chapter, you use the QuantStudio™ 12K Flex OpenArray™ AccuFill™ System to transfer the
nucleic acid samples from the OpenArray™ 384-well Sample Plate to the OpenArray™ Plate. The
workflow is the same for all OpenArray™ Plate formats.

Workflow

Prepare the OpenArray™ Plate

- Prepare for sample transfer (page 183)

. Transfer the samples (page 185)

Seal the OpenArray™ Plate (page 191)

Required materials

IMPORTANT! For the SDS of any chemical not distributed by Thermo Fisher Scientific, contact the
chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer,
and observe all relevant precautions.
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Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

ltem Source
Custom miRNA OpenArray™ panels See Appendix A,
“Ordering information”.
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System 4471021
QuantStudio™ 12K Flex OpenArray™ Accessories Starter Kit 4469586

The accessories kit contains:
* OpenArray™ Case Lid (6 lids)
* OpenArray™ Plugs (6 plugs)
* OpenArray™ Carriers (2 carriers)

* OpenArray™ Immersion Fluid and OpenArray™ Immersion Fluid Tip (6
syringes)

* OpenArray™ AccuFill™ System Tips (1 box of 384 tips)
* OpenArray™ 384-well Sample Plate (10 plates)
* OpenArray™ 384-Well Plate Seals (10 seals)

QuantStudio™ 12K Flex OpenArray™ Plate Press 2.0 A24945
Foil seals MLS
Bleach (10%) MLS
Ethanol MLS
Fine-tip marker MLS
Razor blade MLS
Powder-free gloves MLS
Laboratory-grade wipes MLS
Safety glasses MLS
Tweezers or forceps (for removing foil sections from the 384-well sample plate) MLS
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The following materials require special storage conditions.

Item

Storage

Custom miRNA OpenArray™
panels

Frozen, unopened

Store at —20°C until the expiration date provided on
the product label.

Thawed, unopened

Store at room temperature for up to 24 hours.

Thawed, opened

Store at room temperature for up to 1 hour.

Loaded and
sealed, pre-run

Store at room temperature, protected from light, for
up to 1 hour.

QuantStudio™ Immersion Fluid Unopened Store at room temperature until the expiration date
provided on the product label.

Opened Store at room temperature. Do not store any
remaining immersion fluid; use the amount required,
then discard the remainder.

OpenArray™ AccuFill™ System Unopened Store at room temperature until the expiration date
Tips printed on the cardboard box.
Opened Store at room temperature. Use tips within one

week.

Prepare for sample transfer

Guidelines for handling the OpenArray™ Plate

IMPORTANT! Wear powder-free gloves while preparing the OpenArray™ Plate.

* Hold the OpenArray™ Case by the edges.

* Do not touch the through-holes of the OpenArray™ Plate.

* Load and seal an OpenArray™ Plate within one hour after opening the package.

¢ If you drop a loaded OpenArray™ Plate, discard it in the appropriate waste container.

* Do not reinsert an OpenArray™ Plate if it becomes dislodged from the case.
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Prepare the equipment and plates

Ensure that the OpenArray™ 384-well Sample Plate, the OpenArray™ AccuFill™ System Tips, and
OpenArray™ Plate holder are completely clean and dry.

1. Remove an OpenArray™ Plate from the freezer, but do not open the packaging. Allow the plate to
thaw at room temperature (approximately 15 minutes).

2. Prepare a syringe containing OpenArray™ Immersion Fluid.
a. Remove the cap from the syringe containing OpenArray™ Immersion Fluid.

b. Remove the cap and attach the tip to the syringe. Place the assembly on a clean surface.

@ OpenArray™ Immersion Fluid
(2 Cap (remove)
@ Syringe tip (attach)

3. Score or cut the foil seal of the OpenArray™ 384-well Sample Plate into the 8 sections shown
below, then place the plate on ice to keep the samples cold.
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Prepare the plate setup files

OpenArray™ AccuFill™ Software v2.0 allows the transfer of samples without a sample plate file. The
QuantStudio™ 12K Flex Instrument requires a sample plate file if the real-time PCR run is started with a
TPF file or an EDT file.

For each OpenArray™ Plate being prepared, note the following.
* (Recommended) Use a plate setup file (CSV or TPF) to transfer samples using the OpenArray™
AccuFill™ Software.
— OpenArray™ 384-well sample information file (CSV). See “Track the samples” on page 179

— OpenArray™ Plate setup file (TPF). See “(Optional) Use an OpenArray™ Plate setup file” on
page 167.

* (Optional) If you created a CSV file in the OpenArray™ AccuFill™ Software (see “Track the samples”
on page 179), you can import the sample information in this file directly into the QuantStudio™ 12K
Flex Software before starting the run, or after the run is complete.

Transfer the samples

Start the system

Note: If the samples were tracked immediately before this section, the system might be on (see “Track
the samples” on page 179). The sample tracking and sample transfer functions are both done with
OpenArray™ AccuFill™ Software if OpenArray™ AccuFill™ Software v2.0 is used.

IMPORTANT! To safely operate the instrument, keep the deck clear and have enough room in the
waste bin to eject the used pipette tips. See “Set up the system” on page 186.

The instrument does not initiate a self-test immediately after starting the software. A self-test is initiated
the first time that one of the following items is clicked after starting the software:

¢ Full Run
* Quick Run
* Service » Diagnostics

The other features in the software can be accessed after starting the software without a self-test.

1. Ensure that the instrument door is closed.

2. Power on the instrument, if it is off.

3. Start the OpenArray™ AccuFill™ Software (EH).
The software checks the computer and connections as the system starts.

Proceed to set up the system (see “Set up the system” on page 186).
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Set up the system

IMPORTANT! To safely operate the instrument, keep the deck clear and have enough room in the
waste bin to eject the used pipette tips.

1. Open the instrument door, empty the waste bin, then place the waste bin back on the instrument
deck.

CAUTION! Wear appropriate personal protective equipment while handling the waste bin.

2. Ensure that the sample plate holder and the OpenArray™ Plate holders are empty.

3. Place the sample plate in the sample plate holder on the instrument deck, with the notch to the
left. Do not stack sample plates.

4. Place each OpenArray™ Plate in an OpenArray™ Plate holder.

5. Replace the tip boxes, if necessary.
Each tip box contains 384 tips, divided into 8 sections.

When setting up a run, the status of the tip boxes is confirmed in the software. A full tip box is
recommended when starting a run.

6. Remove the cover from each tip box.
Ensure that the tip box covers are removed from the instrument deck.

IMPORTANT!
. Do not reuse tips.

. Use tips within one week of opening the box.
. Discard any unused tips within one week.

7. Close the instrument door.

The system is ready to start a run. A self-test is initiated the first time that one of the following items is
clicked after starting the software:

¢ Full Run
* Quick Run
* Service » Diagnostics

Verify the run setup and start the run

1. Click each tip box section so that the status on the Verify and start run pane matches the
physical tip box in the instrument.

We recommend starting the run with full tip boxes. The instrument does not start the run if there
are not enough tips on the deck.
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Update the state of the tip boxes
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(1) Section of the tip box that is full.
@ Section of the tip box that is empty.

2. (Optional) Click Auto-fill tip boxes.
The status of all sections of the tips boxes is set to full.

3. Select the first section of the sample plate to be used to fill the OpenArray™ Plate.

Select the first section of the sample plate if multiple plates are filled during a run. The software
selects the total number of sections that correspond with the total number of plates.

In the following example, section 5 was selected. The group of sections 5, 6, 7, and 8 is highlighted
by the software because four plates are being filled.

The position box displays the color that corresponds to the section of the sample plate.

Select the sample platelarea to begin OpenArray plate name and position

o, (M e

ENEEEEEEEEER FI-B75

==lllllllll= ENEEEEEEEEER H
FTB76

— a7

@ Sample plate section (section 5, 6, 7, and 8 are highlighted).

(2 Corresponding plates.

4. Remove the foil from the appropriate sections of the sample plate, then click the checkbox to
confirm.

Remove the foil only from the sections of the sample plate that are used to load a single
OpenArray™ Plate.

Note: Do not remove the foil from all the sections of the sample plate at once.

5. Close the instrument door.
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6. Click Start Run.
The run does not begin under any of these conditions.
* The waste bin is not in position.
* The sample plate is not in position.
* The plates are not in position.

* There are more plates on the instrument deck than are defined in the experiment setup.

The Deck screen is displayed.

For a description of the run progress, see QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User
Guide (Pub. No. MAN0025669).

IMPORTANT! Each OpenArray™ Plate must be prepared for PCR immediately after it is filled (see “Seal
the TrueMark™ OpenArray™ Plate” on page 43).

Remove the OpenArray™ Plate from the OpenArray™ AccuFill™ Instrument

After an OpenArray™ Plate is filled, the Remove plate and foil dialog box is displayed (see Figure 9).

Remove plate & foil X
Step 1 Step 2
Remove OpenArray Plate 1 and promptly seal the plate Confirm foil is removed from highlighted plate

with the adhesive lid, and fill with immersion fluid.

(-]
E
3

= |

ENEEEEEEENEN EEEEEEEEEEEE
ENEEEEEEEEEN EEEEEEEEEEEN
ENEEEEEEEEEN EEEEEEEEEEEE
2 FTB75 (1]} HEN EEEEEEEEEEEN

o
—

Figure 9 Remove plate and foil dialog box.

@ OpenArray™ Plate to remove from the instrument.
@ Confirm foil is removed from highlighted plate section checkbox.

Remove each OpenArray™ Plate immediately after it has been filled, even if the run was set up to fill
multiple plates.

After the last OpenArray™ Plate in the run is filled, the Remove plate dialog box is displayed (see
Figure 10).
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Remove plate X

Remove OpenArray Plate 2 and promptly seal the plate with
the adhesive lid, and fill with immersion fluid.

Figure 10 Remove plate dialog box

@ OpenArray™ Plate to remove from the instrument

1. Open the instrument door and remove the OpenArray™ Plate that is indicated by the blue box in
the dialog box.

IMPORTANT! Remove the OpenArray™ Plate immediately, to avoid evaporation within the plate.

One of the following dialog boxes is displayed:
* The Remove plate and foil dialog box.
* The Remove plate dialog box (after the last OpenArray™ Plate is filled).

2. Seal the case and fill the OpenArray™ Plate with immersion fluid.

3. (For Remove plate and foil dialog box only) Remove the foil seal from the next section of the
sample plate, then select the checkbox to confirm that the foil is removed from the section of the
plate that is highlighted.

Note: Remove the foil only from the next section of the sample plate. Do not remove the foil from
all sections of the sample plate.

4. Close the instrument door.
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5. Click Done.
The run does not proceed under any of the following conditions:
* The waste bin is not in position
* The sample plate is not in position
* The plates are not in position

* There are more plates on the instrument deck than are defined in the experiment setup
The instrument proceeds to load the next OpenArray™ Plate.
6. Repeat step 1 to step 5 for each OpenArray™ Plate to be loaded.
After all of the plates have been loaded, the Deck screen displays Run completed successfully.
Empty the waste bin before performing another run.

A loaded TPF is generated for each OpenArray™ Plate. The loaded TPF file corresponds to the original
TPF file that was imported for the run. The files are exported to the folder that was designed in the
Preferences.

Note: Some workflows might not generate a loaded TPF file. For more information about the workflows
available for the OpenArray™ AccuFill™ Software v2.0, see QuantStudio™ 12K Flex OpenArray™
AccufFill™ System User Guide (Pub. No. MAN0025669).
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Seal the OpenArray™ Plate

IMPORTANT! Throughout this procedure, handle the OpenArray™ Plate and the OpenArray™ Case only
by the edges.

Note: The OpenArray™ Case consists of the sealed OpenArray™ Plate and the OpenArray™ Lid.

1.

Place the newly loaded OpenArray™ Plate in the QuantStudio™ 12K Flex OpenArray™ Plate Press
2.0.

Ensure that the barcode is facing left and the serial number is facing right.

From the OpenArray™ Lid, remove the clear protective film from the inside of the lid (D and the red
adhesive-protective strip ) from around the edge of the lid.

Figure 11 OpenArray™ Lid

@ Protective film on inside of the lid (remove before sealing)

@ Red adhesive-protective strip (remove before sealing)

@ Protective film on the outside of the lid (remove before running)
@ Notched end (align with serial number on plate)

Place the lid in the Plate Press using the alignment pins of the Plate Press for orientation.

IMPORTANT! The notched end of the case lid must be oriented towards the furthest back
right-side of the Plate Press.

@ OpenArray™ case lid
(® Notched end of lid
(3 Serial number of plate
@ OpenArray™ Plate

@ Barcode of plate

@ Alignment pins
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. Seat the lid on the OpenArray™ Plate with the lid adhesive against the plate.

. Engage the press mechanism until the green flashing light changes to a steady green light (after

20 seconds).
The status light turns solid green, indicating that the case is sealed.

Note: Do not apply additional pressure onto the Plate Press during its actuation.

- Disengage the press and carefully remove the OpenArray™ Case.

. Prepare the immersion fluid. Remove the cap, insert the accompanying syringe tip, and prime the

syringe by ejecting a small amount of immersion fluid onto a paper towel to ensure no air gap
remains in the newly attached pipette tip.

IMPORTANT! If the syringe is not primed, the direct burst of air and fluid can negatively affect the
assay(s) at the end of the array.

- While holding the case upright by its edges at a 15-30 degree angle so that the port is at the
highest point of the array, insert the prepared syringe tip into the port in the case.
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9. Slowly inject the OpenArray™ Immersion Fluid until the case is filled, which should take about 10
seconds to fill. Minimize the creation of additional air bubbles when you dispense the fluid. Leave a
small air bubble as shown below.

IMPORTANT! If injected too quickly, the fluid can flush out the samples that are suspended in the
through-holes.

Overfilling the array and/or not leaving a small bubble may cause a leak during the PCR run.

10. While holding the case vertically, remove the syringe tip, insert the screw end of the OpenArray™
plug into the port of the case, then rotate clockwise until the black handle breaks off.

Note: Ensure that you are screwing the plug in at the same angle the case base is at. If it is off, it
can cause the plug to break off prematurely.

IMPORTANT! To avoid leaking of immersion fluid, hold the case vertically and rotate the plug
slowly to avoid cross-threading.

If the plug handle breaks off prematurely, use a Phillips #0 screwdriver to complete this step. Do
not overtighten. If plastic or adhesive remains attached to the screw due to premature breakout of
the plug handle, remove it with forceps prior to loading it into the instrument.

11. If needed, clean the case with the lint-free cloth included with the OpenArray™ Plate or a laboratory
wipe that has been thoroughly sprayed with ethanol, then dry the case with a clean laboratory

wipe.

The plate is ready for PCR.

Note: For microRNA experiments, you can store loaded and sealed OpenArray™ Plate formats at room
temperature, protected from light, for up to 1 hour.
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Guidelines for high-throughput loading

194

For optimal efficiency during and after loading large numbers (more than 6) of OpenArray™ Plates, follow
these guidelines.

To help avoid mistakes when entering sample information in the OpenArray™ AccuFill™ Software,
load the OpenArray™ Plates in alphanumeric order (according to the OpenArray™ Plate serial
number).

Seal each OpenArray™ Plate immediately after loading is completed, while the other OpenArray™
Plates are loaded.

IMPORTANT! To avoid evaporation, seal the OpenArray™ Plate with the QuantStudio™ 12K Flex
OpenArray™ Plate Press 2.0, add the OpenArray™ Immersion Fluid, plug the case, then place the
case in a vertical position.

Use the OpenArray™ Carriers to transport up to four loaded OpenArray™ Plates to the QuantStudio™
12K Flex Instrument.

After loading is complete, you can use a large bin to properly discard any used OpenArray™
AccuFill™ System Tips.

For cleaning procedures, see QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User Guide
(Pub. No. MAN0025669).
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In this chapter, you run the QuantStudio™ 12K Flex TrueMark™ OpenArray™ Plate formats on the
QuantStudio™ 12K Flex Real-Time PCR System. During the run, the system performs thermal cycling (if
the experiment includes ampilification) and collects fluorescence data. The workflow is the same for all
OpenArray™ Plate formats.
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Workflow

Perform the instrument run

- Prepare the QuantStudio™ 12K Flex Software (page 196)

Load the TrueMark™ OpenArray™ Plate into the instrument
(page 199)

. Run the OpenArray™ Plate formats (page 199)
(Optional) Monitor experiments (page 203)
Unload the OpenArray™ Plate from the instrument (page 207)

(Optional) Transfer experiment results (page 207)

Prepare the QuantStudio™ 12K Flex Software

(Optional) Select OpenArray™ block run preferences

Preferences provide user-access to the settings that govern how the QuantStudio™ 12K Flex Software
functions. This section summarizes only those preferences that apply to experiments with OpenArray™
Plate formats.

For detailed information about the preferences, see the QuantStudio™ 12K Flex Software Help (click €
or press F1).

1. Double-click EJ (QuantStudio™ 12K Flex Software shortcut) to start the software.

2. In the toolbar, click Tools » Preferences, then select the OpenArray tab.
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3. Complete the tab, as needed.

Settings Description

Setup Folder Define the absolute path to the default folder from which the software
imports experiment setup files. The Import dialog box opens to the import
folder when invoked from the software.

Experiment Folder Define the absolute path to the default folder to which the software reads or
writes experiment files. The Open and Save dialog boxes open to the data
folder when invoked from the software.

Passive Reference Define the dye to use as the passive reference. The default is set to None.
While the software requires a selection, a passive reference dye is

not used to normalize fluorescence signals collected during OpenArray™
experiments.

Default Browse File Type | Define the file type that the Import, Open, and Save dialog boxes select by

list default when invoked from the software.

Apply experiment If selected, the software applies the Run Method defined in the selected
template (EDT) to all experiment template (EDT) to all OpenArray™ experiments. For more
OpenArray experiment | information about OpenArray™ experiment templates, see the software
checkbox help.

Always include (Genotyping experiments only) If selected, the software adds an

Amplification stage for | Amplification stage to the Run Method for all OpenArray™ genotyping
Genotyping experiment | experiments.

checkbox If deselected, you must perform amplification on another instrument. For
more information about Run Method settings, see the software help.

Always include Pre- (Genotyping experiments only) If selected, the software adds a Pre-Read
Read stage for stage to the Run Method for all OpenArray™ genotyping experiments. For
Genotyping experiment | more information about Run Method settings, see the software help.
checkbox

4. Click OK to save your changes and close the Preferences dialog box.

IMPORTANT! You must restart the software for preference changes to take effect.

Access the Instrument Console

The Instrument Console displays every QuantStudio™ 12K Flex Real-Time PCR Instrument discovered
on a network, divided into groups. A group is a way to organize your instruments. By default, there are
two groups.

®* On the Network—All instruments available on the network.

* My Instruments —Instruments you have selected to monitor.

To start and monitor a run on an instrument, you must move the instrument from the On the Network
group to the My Instruments group or a custom group that you create.

To access the Instrument Console and enable monitoring of a networked instrument:
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1. Double-click Bl (QuantStudio™ 12K Flex Software shortcut) to start the software.

2. On the Home tab, from the Tools menu, select Instrument Console.
If you do not see an instrument, click Refresh in the Instrument Console toolbar.

¥ . e Growp  Delte csignto Gro @) FosmrassiLo2 (2]
P— - EEEET netrument Status: READY
e -

READY Uniform...|09-01-201.... [ADMINIST.... Expired
@ Dye
On the Network (4) 8 Normal...
[} [} g g
285800002 00 P~ soyderons ToalGdesforBock o |
onIE onINE ONINE ONLINE TotalDegreesforBock [0 |
Block Type |384-Well Block.

3. If needed, move an instrument from the On the Network group to a group that can be monitored:

a. Click the instrument of interest, then click Assign to Group in the Instrument Console
toolbar.

b. Select the My Instruments group or a personal group in the drop-down list.

Note: Alternatively, you can select the icon of the instrument that you want to add to the My
Instruments list, then click Add to My Instruments. Similarly, click Remove from My Instruments

to remove an instrument from the My Instruments list. You can also drag and drop the instrument icon
into My Instruments or into the group created by you.

The instrument is now monitored. The status is indicated by an icon in the upper right corner. For
detailed information about the Instrument Console, see the QuantStudio™ 12K Flex Software Help
(click € or press F1).
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Enable or change the notification settings

You can configure the QuantStudio™ 12K Flex Software to alert you by email when the QuantStudio™
12K Flex Real-Time PCR Instrument begins and completes a run, or if an error occurs during a run.

Note: For details on using the notification settings feature, see QuantStudio™ 12K Flex Real-Time PCR
System v1.6 or later Maintenance and Administration Guide (Pub. No. MAN00O18832).

Load the TrueMark™ OpenArray™ Plate into the instrument

VAN CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the sample block
&= temperature can reach 100°C. Allow it to cool to room temperature before handling.

IMPORTANT! Wear powder-free gloves when you handle the OpenArray™ Plate.

IMPORTANT! The instrument should be loaded and unloaded only by operators who have been
warned of the moving parts hazard and who have been adequately trained.

1. Open the plate adapter on the instrument. Touch & on the QuantStudio™ 12K Flex Real-Time PCR
Instrument touchscreen, or click Open Door in the Instrument Console of the QuantStudio™ 12K
Flex Software, to allow the plate adapter to come out from the instrument side.

2. Remove the clear protective film from the outside of the OpenArray™ Case (sealed plate + lid).

3. Place the OpenArray™ Plate or plates on the plate adapter.
* Ensure that each plate is properly aligned in the plate adapter.
* Ensure that the plate barcode is facing up and toward the front of the instrument.

4. Close the plate adapter on the instrument. Touch & on the instrument touchscreen, or click
Close Door in the Instrument Console of the software, to retract the plate adapter back into the
instrument.

Run the OpenArray™ Plate formats

You can run TrueMark™ OpenArray™ Plate formats in two ways.
® “Start a run from the software” on page 200

e “Start a run from the instrument touchscreen” on page 202

Note: The starter kit experiments in this guide run OpenArray™ Plate formats from the QuantStudio™
12K Flex Software.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the
QuantStudio™ 12K Flex Real-Time PCR Instrument is in operation.
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Start a run from the software

There are different ways to create and run an OpenArray™ experiment (EDS) from the QuantStudio™ 12K
Flex Software.

* (Recommended) Use a template file (EDT). See “Use a template file” on page 200.
* Use an OpenArray™ setup file (TPF). See “Use an OpenArray™ Plate setup file” on page 201.
¢ Use the Batch Experiment Setup Utility. See the QuantStudio™ 12K Flex Software Help (click €

or press F1).
Use a template file

You can use a template file (EDT) to create a new OpenArray™ experiment, then import the sample
and assay information for the OpenArray™ Plate or plates before starting the run, or after the run is
complete.

1. Double-click B (QuantStudio™ 12K Flex Software shortcut) to start the software.

2. On the Home tab, in the Experiment menu, select = Create From Template.

3. Navigate to and select the template file (EDT) that you want to use, then click Open.
A new experiment is created using the setup information from the template.

Note: To access the templates, navigate to the templates folder located at

<...>:\Program Files (x86)\Applied Biosystems\QuantStudio 12K Flex
Software\templates

where <. . .> is the installation drive. The default installation drive is C: if the software is installed
by the customer. The default installation drive is D: if the software is installed by a Thermo Fisher
Scientific field service engineer.

4. In the Experiment Properties screen, scan the OpenArray™ Plate barcode or type the OpenArray™
Plate serial number.

5. In the Samples screen, do either of the following.

* (Recommended) Click Import above the sample table, navigate to and select the OpenArray™
sample information file (CSV) that you want to use, then click Select File

* In the sample table, click in a cell in the Sample Name column, then enter a new name.

6. From the open experiment, select File » Import Plate Setup.
a. Click Browse, navigate to and select the plate setup file that you want to use.

MicroRNA Source File (TPF)—Corresponds to the plate setup file associated with miRNA
OpenArray™ Plate formats.

Note: Use the EDT template file supplied with the QuantStudio™ 12K Flex Software. See
“Plate setup file (TPF)” on page 167.

b. Click Select, then click Start Import.
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c. If your experiment already contains plate setup information, the software asks whether to
replace the plate setup with the data from the file. Click Yes to replace the plate setup
information.

7. Select File » Save As, enter a file name, select a location for the experiment file (EDS), then click
Save.

8. Click Start Run.

Use an OpenArray™ Plate setup file

The OpenArray™ AccuFill™ Software integrates the sample information into an OpenArray™ Plate setup
file (TPF). You can save the newly created Loaded_tpf files to the OpenArray™ Plate File Input Folder
that you selected in the Preferences dialog box of the OpenArray™ AccuFill™ Software. Configure this
location in the QuantStudio™ 12K Flex Software preferences to upload the integrated plate setup file
into the QuantStudio™ 12K Flex Software, then run the file.

Note: You can import a CSV file into the QuantStudio™ 12K Flex Software before starting the run, or
after the run is complete.

1. Double-click El

(QuantStudio™ 12K Flex Software shortcut) to start the software.

2. In the Home tab, in the Run menu, screen, click & | OpenArray.

f x|

Load the reaction plate into the instrument. Select the setup files, €l
oy (7]

Select Instrument

FOSMIRAJS1L02

Setup OpenArray Run
ERTED RunType: WA

Reagent Type: N/A

OpenArmay 1: * Setup Fie : * Experment Fie Location :
* Experiment File Name

OpenArmay 2 * Setup Fie :

OpenArmay 3: * Setup Fie :

OpenArmay 4 * Setup Fie :

Note: Be sure to add an instrument to My Instruments in the Instrument Console before you
run experiment. See “Access the Instrument Console” on page 197. If no instrument is selected, a
warning appears.

%]

i ) There are no instruments available.
\/ Go to the Instrument Console and add at least one instrument to My Instruments.

3. In the Select Instrument pane, select the instrument that you want to use to run the experiment.
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4. Complete the Setup OpenArray Run pane.

¢ Click Get Plate IDs to import the barcode of the OpenArray™ Plate formats that you want to
run.

* (Optional) Click Confirm Plate Centers to view the center of the OpenArray™ Plate formats
that you want to run. For each plate image in the Confirm OA Plate Centers dialog box, click
Continue if the red box is aligned to the center of the plate. If the box is not in the center of
the plate, click OK, eject the carrier, rearrange the plates, then click Get Plate IDs

* (Optional) Click Browse, then navigate on your computer to and select the appropriate
OpenArray™ Plate setup files (TPF).

Note: When the setup file is selected, Experiment File Location and Experiment

File Name are populated. To set the default Experiment File Location, go to

Tools » Preferences » OpenArray » Experiment Folder. In the Setup OpenArray Run pane,
to select another location for the experiment file, then click Browse. You can also enter an
experiment file name of your choice.

Depending on the number of OpenArray™ Plate formats loaded in the instrument, the barcode of
those plates is populated.

IMPORTANT! If the QuantStudio™ 12K Flex Real-Time PCR Instrument does not detect a
barcode, repeat the barcode read.

5. Click Start Run.

Start a run from the instrument touchscreen

202

There are three ways to start a run from the QuantStudio™ 12K Flex Real-Time PCR Instrument.

From existing experiments. See “Start a run on the instrument touchscreen from an existing
experiment” on page 202.

From templates. See “Start a run on the instrument touchscreen from a template” on page 203.
From shortcuts. See “Start a run on the instrument touchscreen from a shortcut” on page 203.

Start a run on the instrument touchscreen from an existing experiment

1.

Touch the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen to activate it.
If the touchscreen is not at the Main Menu screen, touch g (Home).

In the Home screen, touch Run OpenArray Plates.
The instrument retrieves the barcodes and scans for existing experiments with the same barcodes.

If experiments with the same barcode cannot be found, touch Source Input to select a template to
use.

Touch ks (Start Run Now) to start the run.

IMPORTANT! If the instrument does not detect a barcode, repeat the barcode read. If the
barcode is detected incorrectly, type the correct barcode number on the instrument touchscreen.
Do not proceed if a barcode is not detected by the instrument.
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Start a run on the instrument touchscreen from a template

1. Touch the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen to activate it.

Note: If the touchscreen is not at the Main Menu screen, touch 3 (Home).

2. In the Home screen, touch (View Templates).

3. Inthe View Templates screen, touch & (Folders) to display the folders containing the template
files.

4. Touch any of the folders to display the templates in that folder.

5. In the View Templates screen, select the desired template, then touch kasuid (Start Run).

The instrument retrieves the barcodes and creates new experiments based on the template for
each plate found.

6. Touch kaaiad (Start Run Now) to start the run.

Start a run on the instrument touchscreen from a shortcut

1. Touch the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen to activate it.
If the touchscreen is not at the Main Menu screen, touch EJ (Home).

2. In the Home screen, touch any of the shortcuts that have been set to an OpenArray™ template.

The instrument retrieves the barcodes and creates new experiments based on the template for
each plate found.

3. Touch ki (Start Run Now) to start the run.

(Optional) Monitor experiments

You can monitor an OpenArray™ experiment run in three ways.

* From the Run screen of the QuantStudio™ 12K Flex Software, while the experiment is in progress.
See “Monitor an experiment from the software Run screen” on page 204.

* From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor an experiment
started from another computer or from the QuantStudio™ 12K Flex Real-Time PCR Instrument
touchscreen). See “Monitor an experiment from the Instrument Console” on page 204.

* From the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen, in the same way that you
run the experiment. See “Start a run from the instrument touchscreen” on page 202.

Note: If there is loss of connection during an experiment, remove and then add the instrument to the
My Instruments list, or restart the QuantStudio™ 12K Flex Software. You may then resume monitoring
the experiment.
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Monitor an experiment from the software Run screen

To monitor the Amplification Plot of the experiment that you are running, in the QuantStudio™ 12K Flex
Software, from the Run Experiment Menu, click Amplification Plot.

Monitor an experiment from the Instrument Console

1. Double-click E}

(QuantStudio™ 12K Flex Software shortcut) to start the software.
2. In the Home tab, in the Tools menu, click Instrument Console.

3. In the Instrument Console, select the icon of the instrument that you are using to run the
experiment, then click Manage Instrument or double-click the instrument icon.

You must add the instrument to a group that can be monitored before you can manage it. See
“Access the Instrument Console” on page 197.

4. In the Instrument Manager, click Monitor Run to access the Run screen.

You can view the progress of the run in real time from the Run screen. During the run, periodically view
the Amplification Plot (see “Monitor the Amplification Plot” on page 204) available from the software
for potential problems.

Task Action

To stop the run ® In the software, click STOP RUN.
* In the Stop Run dialog box, click one of the following:
— Stop Immediately to stop the run immediately.

— Stop after Current Cycle/Hold to stop the run after the current cycle or
hold.

— Cancel to continue the run.

To view amplification Select Amplification Plot.

data in real time See “Monitor the Amplification Plot” on page 204.

Monitor the Amplification Plot

To view data in the Amplification Plot, click Amplification Plot from the Run Experiment menu, select
the Plate Layout tab, then select the wells to view. You can view up to four OpenArray™ experiments
per run. Click the different tabs to view the Amplification Plot for each experiment.

Use the Amplification Plot to view sample amplification as the instrument collects fluorescence data
during a run. If a method is set up to collect real-time data, the Amplification Plot shows the data for
the wells selected in the Plate Layout tab. The plot contrasts normalized dye fluorescence (ARn) and
cycle number.
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The Amplification Plot is useful for identifying and examining abnormal amplification, including:
* Increased fluorescence in negative control wells.

* Absence of detectable fluorescence at an expected cycle (determined from previous similar
experiments run using the same reagents under the same conditions).

Note: If you notice abnormal amplification or a complete absence of signal, troubleshoot the error
as explained in the QuantStudio™ 12K Flex Software Help (click € or press F1).

Monitor an experiment from the instrument touchscreen

The QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen displays the barcodes (or Plate
IDs) of the TrueMark™ OpenArray™ Plate formats for the run, the date and time at which the run started,
the time remaining in the run, and other information.

Task Action

To display the experiment names in the run | Touch Experiment View.

To show the Amplification Plot for the run Touch the Plot View, then touch Experiment View to
return to the previous screen.

To display the time elapsed and the time Touch the (® Time View tab, then touch Experiment

remaining in the run View to return to the previous screen.
To stop the run Touch @ STOP to stop the run immediately.
View the Events Log Touch the status bar to display the events log.
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(¢} Time View Plot View Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 59.5 °C
Reaction Volume: 20 pL. Heated Cover (Set Point): 105.0 °C (105.0 °C)

Stage / Step / Cycle: 2/2/5

01:11:22

© Remaining Time Elapsed Time

December 082011 - 12:06AM o

Error occurred during run. Details: Holdtime 60 s exceeded. Actual Holdtim...

Plot view

The Plot View displays the Amplification Plot in real time.

@ Time View Plot View ]  Experiment View

E m m Linear W AR V¥ FAM v

Subarray: A1
2,000

1,500

1,000 -
©
<

500

0

-500 -

January 30 2012 - 10:15AM o

You can change the plot using the drop-down menus that are available on the Plot View tab.

Touch... To...
TR Change the data displayed on the y-axis. Select either R (reporter) or AR (baseline-
corrected reporter).
For OpenArray™ experiments, the data is not normalized.
FAM v | Change the reporter dye displayed in the plot. Only the dyes that are used in your
experiment are shown.
0 View the run events that occurred during the run. Touch € again to close the event list.
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Unload the OpenArray™ Plate from the instrument

Completed runs

After a run is complete, perform the next step.

* [f you started the run from the QuantStudio™ 12K Flex Software, close the run and reopen
the EDS file to display the Ampilification Plot (for gene expression experiments) or the Allelic
Discrimination Plot (for genotyping experiments). See Chapter 18, “Analyze the experiment
results”.

¢ [f you started the run from the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen, see
“(Optional) Transfer experiment results” on page 207.

Unload the instrument

When the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen displays the Home screen,
unload the TrueMark™ OpenArray™ Plate from the instrument.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the sample block
temperature can reach 100°C. Allow it to cool to room temperature before handling.

1. Touch & on the instrument touchscreen, or click Open Door in the Instrument Console of the
QuantStudio™ 12K Flex Software.

2. Remove the OpenArray™ Plate from the plate adapter.

3. Touch & or click Close Door to retract the plate adapter back into the instrument.
If the instrument does not eject the plate, remove the plate.
a. Power off the instrument.

b. Wait for 15 minutes, then power on the instrument and eject the plate.

c. If the instrument does not eject the plate, power off and unplug the instrument, then open the
access door.

d. Wearing powder-free gloves, reach into the instrument and remove the plate from the heated
cover, then close the access door.

(Optional) Transfer experiment results

If you started a run from the QuantStudio™ 12K Flex Real-Time PCR Instrument touchscreen, transfer
the experiment data to the computer for analysis after the run is complete. You can transfer the
experiment results two ways.

* “Download the experiment from the instrument over the network” on page 208

* “Transfer the experiment from the instrument to the computer with a USB drive” on page 208
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Download the experiment from the instrument over the network
1. In the QuantStudio™ 12K Flex Software, select Instrument » Instrument Console.

2. From My Instruments list, select the instrument icon of the QuantStudio™ 12K Flex Real-Time
PCR Instrument that you just used to run the experiment.

3. Click Manage Instrument.
4. In the Instrument Manager, click Manage Files.
5. In the Experiments panel, select the experiment to download, then click Download.

6. In the Save dialog box, select the folder to hold the experiment results, then click Save, then
navigate to the experiments folder location.
<...>:\Applied Biosystems\QuantStudio 12K Flex Software\User
Files\experiments\
where <. . .> is the installation drive. The default installation drive is C: if the software is installed
by the customer. The default installation drive is D: if the software is installed by a Thermo Fisher
Scientific field service engineer.

Transfer the experiment from the instrument to the computer with a USB
drive

1. If not already connected to the QuantStudio™ 12K Flex Real-Time PCR Instrument, connect a USB
drive to the USB port.

2. Touch the instrument touchscreen to activate it.
3. If the touchscreen is not at the Main Menu, touch EJ (Home).

4. In the Main Menu, touch [ (Collect Results) to save the data to the USB drive.
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5. Select one or multiple experiments (by touching them). Then touch g (Save to USB) to copy
selected experiments to the USB drive.

Note: If your instrument cannot find the USB drive, remove the USB drive, then try again. If the
instrument still does not recognize the USB drive, try another USB drive.

6. Touch EJ (Home) to return to the Main Menu.

7. Remove the USB drive from the instrument, then connect it to one of the USB ports on your
computer.

8. In the computer desktop, use the Windows™ Explorer to open the USB drive.

9. Copy the example experiment file to:
<...>:\Applied Biosystems\QuantStudio 12K Flex Software\User
Files\experiments\

where <. . .> is the installation drive. The default installation drive is C: if the software is installed
by the customer. The default installation drive is D: if the software is installed by a Thermo Fisher
Scientific field service engineer.
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Analyze the run data

This section includes general information and instructions about how to analyze the example
experiments provided with the QuantStudio™ 12K Flex Software. For specific instructions see “Analyze
microRNA experiment results” on page 218.

View the data from the EDS file. If the default analysis settings are not suitable for your experiment,
you can modify the data. You can also modify the project files, publish data, and export data for
downstream analysis using the ExpressionSuite™ Software and TagMan™ Genotyper Software.

View the results

After an experiment run, you close the run and reopen the EDS file to display the Amplification Plot
(for gene expression or miRNA experiments) or the Allelic Discrimination Plot screen (for genotyping
experiments).

Note: For auto-analysis of data, after a run, go to Tools » Preferences » Experiment and select the
Auto Analysis checkbox. By default, Auto Analysis is always enabled. To reanalyze the data, select all
the wells in the plate layout, then click Analyze

Change analysis settings

Analysis settings are different for each experiment type. If the default analysis settings in the
QuantStudio™ 12K Flex Software are not suitable for your own experiment, you can change the settings
in the Analysis Settings dialog box, then reanalyze your experiment. You can save the changed
analysis settings to the Analysis Settings Library to use them in other experiments.

Use the Analysis Settings Library dialog box to apply a filter to reduce the number of setting protocols
that are displayed. Access the Analysis Settings Library from the Tools menu.
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Ill !!.)féle

Select analysis settings or delete analysis settings. Apply a filter to reduce the number of analysis settings displayed. p )

Enter a fitter query, then click "Apply Fiter."

[ oo i ] \

IF ‘Ana\ysws Seftings v‘ = v ‘

Experiment Type Comments Created On Last Modified

| Analysis Settings

Flag Gene Expression

01-19-2012 16:16:02 SGT

01-19-2012 16:16:47 SGT

Pre-PCR SNP Genotyping

01-19-2012 16:39:00 5SGT

01-19-2012 16:39:14 SGT

Bad passive ref SNP Genotyping

01-19-2012 16:40:27 SGT

01-19-2012 16:40:40 SGT

1. From the Experiment Menu, select Analysis.

2. On the Analysis screen, click Analysis Settings.

3. In the Analysis Settings dialog box, change the analysis settings according to your requirement.
4. Click Save to Library to save the changes to the Analysis Settings Library.

To import the analysis settings that you have previously saved to the Analysis Settings Library, in the
Analysis Settings dialog box, click Load from Library.

Display wells

To display specific wells in the analysis plots, select the wells in the Plate Layout tab.
* To select specific well type, use the Show in Wells drop-down menu.
— For gene expression and miRNA experiments, select Sample Color or Target Color.
— For genotyping experiments, select Sample Color or Assay Color.
* To select a single well, click the well in the Plate Layout tab.

* To select multiple wells, click and drag over the desired wells, press Ctrl-click, or press Shift-click
in the Plate Layout tab.

* To select all wells, click the upper left corner of the Plate Layout tab.

This example shows the Plate Layout tab for a gene expression experiment.
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Expand view of a plot or wells

* (Click »| to expand the plot view, on the left side of the screen.
* Click 4| to expand the Targets, Samples, and Subarrays view on the right side of the screen.
¢ Click # to expand the Plate Layout or Well Table view on the lower half of the screen.

* (Click ¥ to expand the Plots and Targets, Samples, and Subarrays view on the upper half of the
screen.

* C(Click % to expand and collapse the Plot or Plate Layout view.

Edit plot properties

Use the Plot Properties dialog box on the Analysis screen to edit plot settings, such as the font and
color of the plot text, and the labels on the x-axis and y-axis.

1. Click [ on the Analyze screen (the icon appears above the plot).

2. In the Plot Properties dialog box, edit the settings under the General, X Axis, and Y Axis tab.

* (Click the X Axis tab to edit the x-axis label text, font, or color; select the tick marks and tick
mark labels to display; and select the range to display.

* C(Click the Y Axis tab to edit the y-axis label text, font, or color; select the tick marks and tick
mark labels to display; and select the range to display.

3. Click OK.
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Publish the analyzed data

Task Click
Save a plot as an image file. i
Print a plot. =)
Copy a plot to the clipboard.
Print a report.
Export data. B=
Task Go to Then
Print the plate layout. | File » Print Select the background color, then click Print.
Create slides. File » Send to PowerPoint | Select the slides for your presentation, then click Create
Slides.
Print a report. File » Print Report Select data for the report, then click Print Report.

(Optional) Export an experiment

Use the Export feature to export experiment data from the QuantStudio™ 12K Flex Software. You can
export experiment data in the QuantStudio™ 12K Flex format (TXT or XLSX) or RDML format (no file
selection).
You can export the following experiment data in a comma-separated file format (CSV).

* Sample setup data

¢ Raw data

* Amplification data

* Multicomponent data

® Results
You can also export plate images collected during the run as TIF files to use them for troubleshooting.
To export plate images, first create an export folder on your hard drive. In the Export screen, click
Browse, navigate to the folder that you created, then click Export QC Images. You can view the
images using a public domain software program such as Imaged (http://rsb.info.nih.gov/ij/). See

QuantStudio™ 12K Flex Real-Time PCR System v1.6 or later Maintenance and Administration Guide
(Pub. No. MAN0018832) for more information on QC Images.

If you selected the Auto Export option before running an experiment, the data is automatically exported
to the location that you specified. If you did not select the Auto Export option, the analyzed data is not
exported automatically.
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1. Open the experiment file that contains the data to export, then from the Experiment Menu, click
E7 Export.

2. Select the format for exported data.
¢ QuantStudio 12k Flex format—Supports TXT and XLSX data.
* RDML format (Real Time Data Markup Language)—Supports only XML type of data.

3. Select to export all data in one file or in separate files for each data type.
¢ All data types are exported in one file.
- If you select the XLS format, a worksheet is created for each data type.
— If you select the TXT format, the data are grouped by data type.

¢ Each data type is exported in a separate file. If you select three different data types (for
example, Results, Amplification, and Multicomponent) to export, three separate files are
created. From File Type, select the export file type (XLS, XLSX, or TXT) to export.

Note: You cannot use an exported XLS or XLSX file when importing plate setup information.

4. Select Yes to include or No to exclude bookmarked data from analysis in the export set.

The Filter Bookmark Data feature lets you include only the data bookmarked during analysis in
the export set.

5. (Optional) Select the Open file(s) when export is complete checkbox to open the file when export
is complete.

6. Enter a file name and location.
a. In Export File Name, enter a name for the export file.
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b. In Export File Location accept the default, or click Browse if you do not want to save the
export file in the default export folder.

Note: To set up the export file location, go to Tools » Preferences, then select the Export
tab. You can select the Use Last File Location or Use Default Folder checkbox.

T Startup W

SMTP Settings W

[ Non-OpenArray® T OpenArray® T
Print

Global Notification Settings

Experiment Display Format.

@ Select the default exportlocation

® Use Default Folder C:\Applied Biosystems\QuantStudio 12K Flex Software\User Files\experiments

Restore Defaults || Apply

7. Select the type of data to export.
Type of data Data to export
Sample setup Well, sample name, sample color, and target name of samples in the plate.
Raw data Raw fluorescence data for each filter, for each cycle.

Amplification data Amplification results, such as dCt values, R, or AR.

Multicomponent data | Fluorescence data for each dye, for each cycle.

Results Results information, such as Cy values, Rn, or calls.

Results data are not available for export until the run status is complete and
the data are analyzed.

The completed Export screen for a microRNA experiment should look like this.
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[ Auto Export Format :|QuantStudio 12KFlex - Export Data To: @ One Fle O Separate Fies Fiter Bookmark Data : O Yes @ No Open file(s) when export is complete

Export Fie Location: |C:\Applied Biosystems\Demo Software\User Files\experiments

Export File Name: [Human miRNA Panel Starter Kit Example_QuantStudio_export

[ sample Setup [J rawData ] amplification [ multicomponent

Skip Empty Wels Skip Omitted Wells

Select Content well Well Position | Sample Name | Target Name | Task Reporter Quencher CRT Crt Mean
[ Al Fields — 1ALal Bran1-A
wer 2A122 Brain1-A hsa-miR409-5p_... UNKNOWN FAM NFQ-HGB
34123 Brain1-A hsa-miR424 INKNOWN FAM NFQ-MGB
Wel Postion 44124 Brani-A hsa-miR-30b. NKNOWIN FAM NFQ-HGB
5A135 Brain1-A hsa-miR-202_A_0... UNKNOWN FAM NFQ-MGB
Sample Name 6A136 Brain1l-A hsa-miR-485- UNKNOWN FAM NFQ-MGB
7ALa7 Brain1-A hsa-miR484 INKNOWN FAM NFQ-MGB
Target Name 8A138 Brain1-A hsa-miR-3803p_.... UNKNOWN FAM NFQ-MGB
sk 9ALbL Brain1-A hsa-miR453, INKNOWN FAM NFQ-MGB
104162 Brainl-A hsa-miR485-5p_.. UNKNOWN FAM NFQ-HGB
Reporter 11A163 Brain1-A U6 rRNA_A_OOL... UNKNOWN FAM NFQ-HGB
12A1b4 Brain1-A hsa-miR 44 NKNOVUN FAM NFQ-HGB
Quencher 13 A1b5 Brainl-A hsa-miR-302b_A. FAM NFQ-MGB
14 A1b6 Brain1-A hsa-miR411 FAM NFQ-HGB
@®RT 15A107 Brainl-A hsa-miR-324- FAM NFQ-MGB
16A18 BrainL-A hsa-miR-30c_ FAM NFQ-HGB
Gt Mean 17 Alcl Brainl-A FAM NFQ-MGB
. 18A1C2 Brain1-A FAM NFQ-HGB
1913 Brain1-A FAM NFQ-MGB
Automatic (it Threshold 20Ale4 Branl-A hsa-mR412. FAM NFQ-HGB
1 Crt Threshold v & ] >

Start Export || Save Export Set As || Load Export Set Il Delete Export Set || Export QC Images

8. (Optional) After you have defined the export properties or after moving the table headings order,
you can save those export settings as an export set by clicking Save Export Set As. Later you can
import the heading order into another file by clicking Load Export Set. You can also delete export
settings by clicking Delete Export Set.

9. (Optional) Click Export QC Images to export quality control (QC) images in experiment files (EDS).

QC images include calibration images, a barcode image, and images taken during PCR. You can
view the images to check sample loading and assay spotting. View PCR images to validate your
data.

10. Click Start Export.
The exported file, when opened in Notepad, should look like this.

B Human miRNA Panel Starter Kit Example_QuantSt - Notepad

Fle Edt Format View Help

- Barcode = GGX32 A
* Block Type = openArray Block

* Chemistry = TAQMAN

* Comment = NA

* Date Created = 2012-01-24 15:06:51 PM SGT

* Experiment File Name = C:\Docs\OAExamples\HuBrain 3 5amp1e miRNA run. eds

* Experiment Name = Human miRNA Panel Starter Kit Example

* Experiment Run End Time = Not Started

* Experiment Type = Gene Expression

* Instrument Name = spyder012

* Instrument Serial Number = spyder012

* Instrument Type = Quantstudio 12K Flex

* passive Reference =

* Quantification Cycle Method = Crt

* signal smoothing on = true

* stage/ Cycle where Analysis is performed = stage 2, step 6

* User Name = NA

[Results]

well well position Sample Name Target Name Task Reporter Quencher CRT crt Mean Crt sp Automatic
crt Threshold — crt Threshold Automatic Baseline Baseline start

1 Alal ainl-a

2 Ala2 Brainl-A hsa-miR-409-5p_A_002331 UNKNOWN FAM NFQ-MGB
3 ala3 Braini-a hsa-miR-424_A_000604 UNKNOWN FAM NFQ-MGB
1 Alad Braini-a hsa-miR-30b_A_000602 UNKNOWN FAM NFQ-MGB
5 Alas Braini-a hsa-miR-29a_A_002112 UNKNOWN FAM NFQ-MGB
6 Ala6 Braini-a hsa-miR-485-3p_aA_001277 UNKNOWN FAM NFQ-MGB
7 Ala7 Braini-a hsa-miR-484_a_001821 UNKNOWN FAM NFQ-MGB
8 Alasg Braini-A hsa-miR-380-3p_A_000569 UNKNOWN FAM NFQ-MGB
9 Albl Braini-A hsa-miR-453_A_002318  UNKNOWN FAM NFQ-MGB
10 Alb2 Brainl-aA hsa-miR-485-5p_A_001036 UNKNOWN FAM NFQ-MGB
11 A1b3 Brainl-A U6 rRNA_A_001973 UNKNOWN FAM NFQ-MGB
12 Alb4 Braini-a hsa-miR-449_A_001030  UNKNOWN FAM NFQ-MGB
13 A1bS Braini-a hsa-miR-302b_A_000531  UNKNOWN FAM NFQ-MGB
14 Alb6 Braini-a hsa-miR-411_A 001610 UNKNOWN FAM NFQ-MGB
15 Alb7 Braini-A hsa-miR-324-5p_A_000539 UNKNOWN FAM NFQ-MGB
16 Alb8 Braini-a hsa-miR-30c_A_000419  UNKNOWN FAM NFQ-MGB
17 Alcl Braini-A hsa-miR-381_A_000571 UNKNOWN FAM NFQ-MGB
18 Alc2 Braini-A hsa-miR-376b_A_001102  UNKNOWN FAM NFQ-MGB
19 Alc3 Brainl-aA hsa-miR-296-3p_A_002101 UNKNOWN FAM NFQ-MGB
20 Alcd Brainl-A hsa-miR-412_A_001023 UNKNOWN FAM NFQ-MGB
21 ALCS Braini-a hsa-miR-429_A_001024 UNKNOWN FAM NFQ-MGB
22 ALcE Braini-a hsa-miR-450a_A_002303  UNKNOWN FAM NFQ-MGB
23 Alc7 Brainl-a hsa-miR-455_A_001280  UNKNOWN FAM NFQ-MGB
24 AlcS8 Braini-A hsa-miR-302c_A_000533  UNKNOWN FAM NFQ-MGB
25 Aldl Braini-a hsa-miR-204_A_000508  UNKNOWN FAM NFQ-MGB
26 Ald2 Brainl-A ath-miR159a_A_000338 UNKNOWN FAM NFQ-MGB
27 Ald3 Braini-a hsa-miR-145_A7002278  UNKNOWN FAM NFQ-MGB
28 Aldd Braini-a hsa-miR-154_A_000477 UNKNOWN FAM NFQ-MGB
29 ALdS Brainl-A hsa-miR-132_A_000457 UNKNOWN FAM NFQ-MGB
30 A1d6 Braini-a hsa-miR-140-3p_A_002234 UNKNOWN FAM NFQ-MGB
3 ALd7 Braini-a RNuAAJLomDsA UNKNOWN FAM NFQ-MGE

32 Alds Braini-a hsa-miR-15a_A_000389  UNKNOWN FAM NFQ-MGB v
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Perform downstream analysis (secondary analysis)

You can perform downstream analysis of experiments that have been run on any real-time PCR system
with the ExpressionSuite™ Software and TagMan™ Genotyper Software. Use the ExpressionSuite™
Software and TagMan™ Genotyper Software to efficiently analyze, edit, and conduct a study of a large
number of gene expression or miRNA experiments and genotyping experiments, respectively.

* Import data from the QuantStudio™ 12K Flex Software project files, then manage the data in a
database.

® Search the database for assays using specific search criteria.

* FEasily view data in a variety of ways (plots, statistics, status codes, and so on).
* Edit data (your edits are saved to the database).

* OQverlay data from multiple plates.

* Export data.

ExpressionSuite™ Software and TagMan™ Genotyper Software are available for download from the
Thermo Fisher Scientific website.

For more information about the TagMan™ Genotyper Software, see the TagMan™ Genotyper Software
Getting Started Guide (Pub. No. 4448637).
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Analyze microRNA experiment results

In this section, you use the example experiment files provided with the QuantStudio™ 12K Flex Software
to analyze the experiment results.

Workflow

Analyze microRNA experiment results

Access the example experiment file (page 219)
Assess amplification results on the Ampilification Plot (page 219)

Identify well problems using the Well Table (page 221)

Confirm accurate dye signal using the Multicomponent Plot
(page 222)

Determine signal accuracy using the Raw Data Plot (page 223)

Review the flags in the QC Summary (page 224)

(Optional) Adjust parameters for reanalysis of your own experiments
(page 226)

(Optional) Export the analyzed data (page 229)
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Access the example experiment file

1.

3.

Double-click B (QuantStudio™ 12K Flex Software shortcut) to start the software.

In the Home tab, in the Experiment menu, click Open, then browse to the Gene Expression
examples folder.

<...>:\Program Files (x86)\Applied Biosystems\QuantStudio 12K Flex
Software\examples\Gene Expression, where <. ..> is the installation drive. The default
installation drive is C: if the software is installed by the customer. The default installation drive is
D: if the software is installed by a Thermo Fisher Scientific field service engineer.

Open the Human miRNA Panel Starter Kit Example.eds file.

Assess amplification results on the Amplification Plot

The Ampilification Plot displays amplification of all samples in the selected wells. View the
Amplification Plot for the example experiment to evaluate the quality of the amplification curve and to
check for outliers.

Three plots are available.

AR vs Cycle—AR is the magnitude of fluorescence signal generated by the reporter at each cycle
during the PCR amplification. This plot displays AR as a function of cycle number. Use this plot to
identify and examine irregular amplification and to view Cgy values for the run.

R vs Cycle—R is the fluorescence signal from the reporter dye. This plot displays R as a function
of cycle number. Use this plot to identify and examine irregular amplification.

Cgt Vs Well—Cgt is the PCR cycle number at which the fluorescence meets the threshold in the
amplification plot. This plot displays Cgt as a function of well position. Use this plot to locate
outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

View the Amplification Plot

1.

From the Experiment Menu, select Analysis » Amplification Plot.
If no data are displayed, click Analyze.

Display the Brain2-A wells in the Amplification Plot.
a. Click the Plate Layout tab.

b. Click Show in Wells » Sample Color.

The Plate Layout screen should look like this.
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3. Update the Amplification Plot.
Menu Selection
Plot Type AR vs Cycle (default)
Graph Type Log (default)
View Target Color (default)
Show Unselection (default)

4. View the Cgr values.

a. Click View » Show Cgr.

b. Verify that the Crr value reported matches its occurrence (the triangle icon) on the plot.

Z0
Cycle

5. Repeat from steps 2 for the Brain1-B, Brain3-B, Brain2-B, Brain3-A, and Brain1-A wells.
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Identify well problems using the Well Table

The Well Table displays the following information for each well in the reaction plate.
* The sample name, target name, task, and dyes.
* The calculated threshold cycle (Crt) and quantity values.
* Flags.

Example experiment values and flags
Review the Well Table to evaluate the Cgt precision of the replicate groups and AMPSCORE values.

The software produces the AMPSCORE flag if the amplification in the linear region is below a certain
threshold, corresponding to the score set in the analysis settings. For robust amplification, AMPSCORE
values should be >1.24.

View the Well Table

To show or hide columns in the Well Table, select or deselect respectively the column name from the
Show in Table menu.

1. From the Experiment Menu, select Analysis » Amplification Plot, then click the Well Table tab.
2. From the Group By menu, select Replicate.

3. Look at the Amp Score column to check for amplification in the linear region of the replicate
groups.

In the example experiment, the Amp Score have the expected value of =1.24.

Plate Layout Well Table

©Expand Al 8 Collapse Al

= Sample ... Target... | Task Dyes Crr Car Mean Car 5D | Jamp Score=!| [ROXSig...  Comme...
B Brain2-A - RNU48_A_001006
300 ASH ] Bran2-A FAMAVFQ-... 14.737 14.754 0.033 1340
132 Bef O Bran2A  RNU4 NKNOWN ~ FAM-NFQ-.. 14.779 14754 0.033 1341
1836 Csf4 O Bran2-A  RNU4 NKNOWN ~ FAM-NFQ-... 14.768 14754 0.033 1344
2604 Dsfs O Bran2-A  RNU4B_A_... UNKNOWN FAMAVFQ-.. 14.772 14.754 0.033 1347
364 A6 | Bran2-A  RNU48_A_... UNKNOWN FAMANFQ-... 14.738 14754 0.033 1352
1900 Cof4 [a] Bran2-A  RNU4B_A_... UNKNOWN FAMAVFQ-.. 14.703 14.754 0.033 1352
1068 B5f4 O Bran2-A N FAMAVFQ-... 14.804 14754 0.033 1353
2668 D6f4 [u] Bran2-A  RNU4S_A_... UNKNOWN _FAM-NFQ-... 14.728 14.754 0.033 1.357
B Brain2-A - U rRNA_A_001973
1867 C6b3 ] Bran2-A UG RNA_A... UNKNOWN FAMANFQ-... 11.903 11.870 0.055 1243
3B A6b3 O Bran2-A UG RNA_A...UNKNOWN FAMAVFQ-.. 11.820 11.870 0.055 1251
2571 Dsb3 | Bran2-A UG RNA_A...UNKNOWN FAMAVFQ-.. 11.790 11870 0.05 1263
1035 B5b3 O Bran2A UG RNA_A...UNKNOWN FAMNFQ-... 11.806 11870 0.055 1263
267 Asb3 O Bran2-A  USRNA_A...UNKNOWN FAMAVFQ-.. 11.914 11.870 0.055 1.265
1099  B6b3 [u] Bran2-A UG RNA_A..UNKNOWN FAMAVFQ-.. 11.916 11870 0.0s5 1271
2635 Deb3 [u] Bran2-A UG RNA_A...UNKNOWN FAMAVFQ-.. 11.870 11.870 0.055 1273
1803 C5b3 [&] Bran2-A UG RNA_A... UNKNOWN _FAM-NFQ-... 11.934 11.870 0.055 1274
282 Asd2 3] Bran2-A  ath-mR15.. UNKNOWN FAMAVFQ-... Undeterm.. 0.000
1818 Csd2 O Bran2-A  ath-mR1S.. UNKNOWN FAMAVFQ-.. Undeterm. 0.000
2650 D62 O Bran2A  ath-mRiS.. UNKNOWN FAMANFQ-... Undetem.. 0.000
46 Aed2 O Bran2-A  ath-mR1S.. UNKNOWN FAMAVFQ-.. Undeterm. 0.134
1114 Bed2 [u] Bran2-A  ath-mRIS.. UNKNOWN FAM-NFQ-... Undetermi.. 0.562
1882 Ced2 [u] Bran2-A  ath-mR1S.. UNKNOWN FAMAVFQ-.. Undeterm. 0.680
2586 Dsd2 O Bran2-A  ath-mRIS.. UNKNOWN FAMNFQ-.. Undeterm.. 0712
1050 B5d2 0 Bran2-A_ ath-mRIS... UNKNOWN _FAMANFQ-... Undetem... 0.783
B Brain2-A - hsa-let-7a_A_000377
1843 [m] hsa-let-72_... UNKNOWN _ FAM-NFQ-...
B Brain2-A - hsa-et-7b_A_002619 v

Assess the well table in your own experiments

When you analyze your own microRNA experiment, look for Amp Score values in the replicate groups
(Amp Score values). If needed, omit outliers.
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Confirm accurate dye signal using the Multicomponent Plot
The Multicomponent Plot displays the complete spectral contribution of each dye in a selected well
over the duration of the PCR run.
In the microRNA example experiment, you review the Multicomponent Plot for:
* FAM™ dye (reporter)
* Spikes, dips, and/or sudden changes
¢ Amplification in the negative control wells

View the Multicomponent Plot
1. From the Experiment Menu, select Analysis » Multicomponent Plot.

If no data are displayed, click Analyze

2. Display the unknown and standard wells one at a time in the Multicomponent Plot.
a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent Plot.

If you select multiple wells, the Multicomponent Plot displays the data for all selected wells
simultaneously.

3. Click View » Dye Color.

4. Click [E Show a legend for the plot (default).
This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. Check the FAM™ dye signals.

In the microRNA example experiment, the FAM™ dye signal increases throughout the PCR process,
indicating normal amplification.
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Tips for confirming dye accuracy in your own experiment

When you analyze your own experiment, look for these results.

* Reporter dye—The reporter dye fluorescence level should display a flat region corresponding to the
baseline, followed by a rapid rise in fluorescence as the amplification proceeds.

* Irregularities in the signal—There should not be any spikes, dips, and/or sudden changes in the
fluorescent signal.

* Negative Control wells—There should not be any amplification in the negative control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot displays the raw fluorescence signal (not normalized) for each optical filter for the
selected wells during each cycle of the real-time PCR.

In the microRNA example experiment, you review the Raw Data Plot screen for a stable increase in
signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data Plot

1. From the Experiment Menu, select Analysis » Raw Data Plot.
If no data are displayed, click Analyze.

2. To display all wells in the Raw Data Plot, click the upper left corner of the plate layout in the Plate
Layout tab.

3. Click [E Show a legend for the plot (default).

The legend displays the color code for each row of the reaction plate (see the legend in the Raw
Data Plot).
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This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 80.

In the example experiment, the stable increase in signal from filter 1 corresponds to the FAM™ dye
filter.

3.000
2.800
3.700
2.600
3.500

Amplhude

Tips for determining signal accuracy in your own experiment

When you analyze your own microRNA experiment, look for the following conditions in each filter.

Characteristic signal growth.
No abrupt changes or dips.

Review the flags in the QC Summary

224

The QC Summary displays a list of the QuantStudio™ 12K Flex Software flags, including the flag
frequency and location for the open experiment.

Review the QC Summary in the microRNA example experiment for any flags triggered by the
experiment data. There are no flags in the example experiment.

1.

From the Experiment Menu, select Analysis » QC Summary.
If no data are displayed, click Analyze.

Review the Flags Summary.

A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment.
If the frequency is >0, the flag appears somewhere in the experiment. The well position is listed in
the Wells column.

In the example experiment, there are 0 flagged wells.

In the Flag Details table, click each flag with a frequency >0 to display detailed information about
the flag.

(Optional) For those flags with frequency >0, click the troubleshooting link to view information
about correcting the flag.

The QC Summary for the microRNA example experiment looks like this.
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Flag: Description Freguency Wells <

>
OFFSCALE Fluorescence is offscale 0
HIGHSD High standard deviation in replicate group 0
NOAMP No amplfication 0
INOSIGNAL No signal in well 0
EXPFAIL Exponential algorithm failed 0
BLFAIL Baseline algorithm failed 0
THOLDFAIL Thresholding algorithm failed [t]
CTFAIL Cr algorithm failed 0

A

P
Plate Layout Well Table
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Possible flags

The flags listed below may be triggered by the microRNA experiment data.

Flag Description

Preprocessing flag

OFFSCALE |Fluorescence is off scale.

Primary analysis flags

BADROX Bad passive reference signal.

NOAMP No amplification.

NOISE Noise higher than others in plate.

SPIKE Noise spikes.

NOSIGNAL | No signal in well.

EXPFAIL Exponential algorithm failed.

BLFAIL Baseline algorithm failed.

THOLDFAIL | Thresholding algorithm failed.

CTFAIL Cr algorithm failed.

AMPSCORE | Amplification in the linear region is below a specific threshold, corresponding to the score set
in the analysis settings.
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(continued)

Flag Description

Secondary analysis flags

OUTLIERRG | Outlier in replicate group.

AMPNC Amplification in the negative control.

HIGHSD High standard deviation in replicate group.

The AMPNC, BADROX, NOISE, SPIKE, OUTLIERRG, and AMPSCORE flags, by default, are not in use
for the microRNA experiment.

For the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL flags are not

reported, but they appear in the QC Summary (by default, a 0 is displayed in the Frequency column for
each flag).

(Optional) Adjust parameters for reanalysis of your own experiments

The Analysis Settings dialog box displays the analysis settings for the threshold cycle (Cgy), and flags
options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own

experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your
experiment.

View the analysis settings

1. From the Experiment Menu, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab.
® Cy Settings
* Flag Settings

The Analysis Settings dialog box for the microRNA example experiment looks like this.
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—Data Step Selecti
Select the step and stage to use for CT analysis. Only stage fstep combinations for which data suitable for CT analysis have been collected are displayed.
Stage 2, Step 6 &
Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings W

3. View and, if necessary, change the analysis settings.
See “Adjust analysis settings” on page 227.

You can save the changes to the analysis settings to the Analysis Settings Library for later use.
See “Change analysis settings” on page 210.

4. Click Apply Analysis Settings to apply the current analysis settings.
If needed, click Revert to Default Analysis Settings to return to the default analysis settings.

Adjust analysis settings

Adjust Ct settings

Use the Data Step Selection feature to select one stage/step combination for Ct analysis when there is
more than one data collection point in the run method.

Adjust flag settings

Use the Flag Settings tab to adjust flag settings.

* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the QuantStudio™ 12K Flex Software.

1. In the Flag Settings tab, in the Use column, select the checkboxes for flags to apply during
analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying
the flag.

If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the
appropriate setting.
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3. In the Reject Well column, select the checkboxes if you want the software to reject wells with the
flag.

After you have rejected the flagged wells, analysis results depend on factors such as the
experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments
using the Standard Deviation calculations may change the result of Cgt SD. For some flags,
analysis results calculated before the well is rejected are maintained.

4. Click Apply Analysis Settings.
If the run status is complete, the data are reanalyzed.
The Flag Settings tab looks like this:

Cr Settings Flag St 5

@ Configure the fiags and filtering. In this panel you can enable, disable, and configure fiags, and indicate if a wellis to be rejected when a fiag is raised.

: Flag Description Use Attribute Condition Value Reject Well
|AMPNC |Amplification in negativ... O cr < + [35.000

BADROX Bad passive reference ... O Bad passive reference ... |> v (0.600

OFFSCALE Fluorescence is offscale [m|
HIGHSD High standard deviatio... Cr standard deviation > w |0.500 O
|NoAMP No amplification Amplification algorithm ...[< v (0.100

NOISE Noise higher than oth... O Reltive noise > w [4.000

SPIKE Noise spikes O Spike algorithm result > w [1.000

|NOSIGNAL No signal in well [m]
|QUTLIERRG Outlier in replicate group O

EXPFAIL Exponential algorithm f... O
BLFAIL Baseline algorithm failed O
THOLDFAIL Thresholding algorithm... O
CTFAIL Cr 2lgorithm failed O
/AMPSCORE IAMP Score O AMP Score > w |700.000

Improve Cgr precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all. These wells
typically produce Cgr values that differ significantly from the average for the associated replicate wells.
If included in the calculations, these outliers can result in erroneous measurements. To enable Cgt
precision, omit the outliers from the analysis.

In the OpenArray™ gene expression example experiment, there are 0 outliers. Use these steps to
remove these wells from analysis.

1. From the Experiment Menu, select Analysis » Amplification Plot.
If no data are displayed, click Analyze.

2. In the Amplification Plot, select Plot Type » Cgr vs Well.
3. Select the Well Table tab.

4. In the Well Table, identify outliers.
a. Select Group By » Replicate..
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b. Look for outliers in the replicate group (ensure that they are flagged).

c. Select the Omit checkbox next to outlying well or wells.

well N | omit Flag Sample ...| Target... | Task Dyes CRT CRT Mean| CRT SD | Amp Sc... ROXSig... Comme...

B Brain -A - is-mR411_A_001610 &
14 ALb6 =l Brainl-A  hsa-mR41... UNKNOWN FAM-NFQ-... 18.654 18.654. 1315
= Brain -A - lisa-mR412_A_001023

20 Alc =1 Brainl-A _hsa-mR41.. UNKNOWN _FAMAIFQ-... Undetermi... 0.000
E Brain -A - isa-mR422a_A_002297

71 A7 | O] Branl-A hsa-mR42... UNKNOWN _FAM-NFQ-... 20.633 1.202
B Brain -A - lisa-miR423-5p_A_002340

70 A26 | O] Branl-A__hsa-mR42... UNKNOWN _FAM-NFQ-... 21.912 1.283

B Brain A - lisa-mR424_A_000604

Brainl-A__hsa-mR-42... UNKNOWN _FAM-NFQ-... 26.013
E Bran A - l15-mR425-5p_A_001516

Brainl-A hsa-mR42... UNKNOWN  FAM-NFQ-... 19.751
-A - hisa-mR429_A_001024

Branl-A hsa-mR42... UNKNOWN _FAM-NFQ-... 27.288
B Brain -A - lis-mR-431_A_001979

Branl-A __hsa-mR-43... UNKNOWN _FAM-NFQ-... Undetermi...
E Brain A - lisa-mR433_A_001028

Brainl-A_hsa-mR-43... UNKNOWN _FAM-NFQ-... 20.531
= Brain -A - lisa-miR448_A_001029

Branl-A _hsa-mR-44... UNKNOWN _FAM-NFQ-... 27.408
-A - lisa-mR449_A_001030

Branl-A _hsa-mR44... UNKNOWN _FAM-NFQ-... 29.039
E Brain -A - li5-mR-440b_A_001608

Branl-A___hsa-mR-44... UNKNOWN _FAM-NFQ-... 26.876
= Brain A - lisa-mR450a_A_002303

Braini-A hsa-miR-45... UNKNOWN _FAM-NFQ-... 30.800
B Brain -A - lisa-mR450b-3p_A_002208

3 Ala3

1541 Clas

= Bran

21 Al

1548 Clb4

1539 Cla3

1545  Clb1

= Bran

12 Alb4

1555 Clc3

22 Alch

1608 C228 =l Branl-A  hsa-mR4S... UNKNOWN _FAM-NFQ-... Undeterm..
= Brain -A - isa-miR450b-5p_A_002207
874 B2R2 m Branl-A  hsa-mR45... UNKNOWN FAM-NFQ-... Undetermi... X ~l

5. With the outlying well or wells removed from the analysis, click Analyze to reanalyze the
experiment data.

Note: You can also omit undesirable wells in an experiment from the Plate Layout screen. To omit
a well from the Plate Layout screen, right-click the well, then select Omit.

(Optional) Export the analyzed data

1. Open the microRNA example experiment file that you analyzed in Chapter 17, “Perform the
instrument run”.

2. In the Experiment Menu, click E= Export.

Note: To export data automatically after analysis, select the Auto Export checkbox during
experiment setup or before running the experiment. Auto export is unchecked for the example
experiment.

3. In the top of the screen, select QuantStudio 12K Flex format.

4. Complete the Export screen.

Field or selection Entry
Export Data To One File
Filter Bookmark Data No
Export File Location <...>:\Applied Biosystems\QuantStudio 12K Flex
Software\experiments
Export File Name Human miRNA Panel Starter Kit Example_QuantStudio_export
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(continued)

Field or selection

Entry

File Type (*.txt)

Content checkboxes.

Select Data to export/ Select Select the All Fields checkbox or select a specific set of

The completed Export screen should look like this.

[ Auto Export Format : ‘Quantstudmlz}(ﬂex 4 Export Data To: @ One File O Separate Fies Fiter Bookmark Data : O Yes & No

Open file(s) when export is complete

Export Fie Location: |C:\applied Biosystems\Demo Software\User Files\experiments

Export Fie Name: [Human miRNA Panel Starter Kit Example_QuantStudio_export

[ sample Setup [ Raw Data [ ampification [ multicomponent

Skip Empty Wels B Skip Omitted \

File Type:

) () &

Select Content well Well Position | Sample Name | Target Name | Task Reporter Quencher CRT
Al Fields - 1A1a1 Brani-A
wet 2A1a2 Branl-A hsa-mR<409-50_... UNKNOV/N FAM NFQ-MGB
! 3A1a3 Branl-A UNKNOWN FAM NFQ-MGB
Well Postion 4A124 Branl-A UNKNOWN FAM NFQ-MGB
5A135 Branl-A UNKNOWN FAM NFQ-MGB
Sample Narme 6 AL36 Branl-A UNKNOWN FAM NFQ-MGB
7A137 Branl-A UNKNOWN FAM NFQ-MGE
] Target Name 8A128 Brani-A UNKNOWN FAM NFQ-MGB
Tk 9Alb1 Brani-A UNKNOWN FAM NFQ-HGB
10 A1b2 Brain1-A UNKNOWN FAM NFQ-MGB
Reporter 11 A1b3 Branl-A UNKNOWN FAM NFQ-MGB
12 Alb4 Branl-A UNKNOWN FAM NFQ-MGB
Quencher 13 A1bS Branl-A UNKNOWN FAM NFQ-MGB
14 A1b6 Branl-A UNKNOWN FAM NFQ-MGB
GRT 15 A1b7 Brani-A UNKNOWN FAM NFQ-MGB
ot Hean 16 A1b8 Branl-A UNKNOWN FAM NFQ-MGB
17 Alc Branl-A _A_0... UNKNOWN FAM NFQ-MGB
atso 18A1C2 Branl-A hss-mR-376b_A, FAM NFQ-MGB
19A1c3 Branl-A hsa-miR-206-3p. FAM NFQ-MGE
Automatic Crt Threshold 20 Alcd Brani-A hsa-mR412_A_D... UNKNOWN FAM NFQ-MGB
1 Crt Threshold ¥ @

Crt Mean

Start Export [ Save Export Set As [l Load Export Set || Delete Export Set [If Export QC Images

5. Click Start Export.
When opened in Notepad, the exported file should look like this.

Human miRNA Panel Starter
File Edit Format View Help

Example_QuantStudio_export.txt - Notepad

[+ Barcode =

* Block Typs - cpenArray Block

* Chemistry = TA(

* Comment = NA

* pate Created = 2012-01-24 15:06:51 PM SGT

* Experiment File Name = C:\Docs\OAExamples\HuBrain 3 sample miRNA run.eds
* Experiment Name = Human miRNA Panel starter Kit Example

* Experiment Run End Time = Not Started

* Experiment Type = Gene EXpression

* Instrument Name = spyder012

* Instrument Serial Number = spyder012

* Instrument Type = Quantstudio 12K Flex

« Passive REFarence =

* quantification cycle Methcd cre

* signal smoothing on = tr

= stage/ Cycle where Ana"\ysﬁ is performed = stage 2, Step 6

user Name = NA

[uesu]ts]

waﬂ Fusﬂ.wn sample Name Target Name Task, Reporter Quencher CRT Crt Mean
(r( Threshol cre Threshngd Automatic Baseline Baseline start
1 Alai Brainl-A
2 Ala2 Brainl-A hsa-miR-409-5p_A_002331 UNKNOWN FAM NFQ-MGE
3 Ala3  Braini-a 5a-miR-424_A_000604 UNKNOWN FAM NFQ-MGB
4 Alad Brainl-A hs a-miR-30b_A_000602 UNKNOWN FAM NFQ-MGE
5 Ala5  Brainl-A sa-miR-29a_A_002112 UNKNOWN FAM NFQ-MGB
6 Alaé Brainl-A hsa-m’ R 435 39A001277 UNKNOWN FAM NFQ-MGB
7 Ala7  Brainl-a sa-miR-484_A_ UNKNOWN FAM NFQ-MGE
8 Alas Brainl-A 5@~ R 380- BP_A_OOOSGQ UNKNOWN FAM NFQ-MGE
9 Albl  Brainl-a hsa-miR-453_A_00 UNKNOWN FAM NFQ-MGB
10 Aalb2 Braini-a 5a-miR-485-! Sp.A_oalOaG UNKNOWN FAM NFQ-MGE
11 Alb3  Brainl-a U6 FRNA_A_0019 UNKNOWN FAM NFQ-MGB
12 Alb4 Brainl-aA ISa-miR- 449JL0010}0 UNKNOWN FAM NFQ-MGB
13 Alb5 Brainl-A 5a-miR-302b_A_000531  UNKNOWN FAM NFQ-MGB
14 Alb6  Brainl-a hsa-mir-411_A_001610  UNKNOWN FAM NFQ-MGE
15 Alb7  Brainl-A 5a-miR-324-5p_A_000539 UNKNOWN FAM NFQ-MGE
16 Alb8 Brainl-a hsa-mir-30c_A_000419 UNKNOWN FAM NFQ-MGB
7 Alcl  Braini-a sa-miR-381_A_000571  UNKNOWN FAM NFQ-MGE
18 Alc2 Brainl-a hsa-miR-376b_A_001102  UNKNOWN FAM NFQ-MGB
19 Alc3 Brainl-a hsa-miR-296-3p_A_002101 UNKNOWN FAM NFQ-MGB
20 Alcd Brainl-A 5a-miR-412_A_001023 UNKNOWN FAM NFQ-MGB
21 AlcS Brainl-a hsa-mir-429_a_001024 UNKNOWN FAM NFQ-MGB
22 Alct Brainl-A sa-miR-450a_A_002303 UNKNOWN FAM NFQ-MGEB
23 Alc7 Brainl-a hsa-miR-455_A_001280  UNKNOWN FAM NFQ-MGB
24 AlcB Brainl-a hsa-mir-302c_A_000533 UNKNOWN FAM NFQ-MGE
25 Aldl  Brainl-a 5a-miR-204_A_000508  UNKNOWN FAM NFQ-MGB
26 Ald2 Brainl-A ath-mir159a_A_000338 UNKNOWN FAM NFQ-MGB
7 Ald3  Brainl-a UNKNOWN FAM NFQ-MGE
28 Aldd Braini-a UNKNOWN FAM NFQ-MGB
29 Alds  Brainl-A UNKNOWN FAM NFQ-MGE
30 Ald6 Brainl-a hsa-mirR-140-3p_A_002234 UNKNOWN FAM NFQ-MGB
31 Ald7 Brainl-A RNUMJA 001094  UNKNOWN FAM NFQ-MGB
32 AldS  Brainl-A hsa-miR-15a_A_000389  UNKNOWN FAM NFQ-MGE

FEX

Crt D Automatic
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How to order

Order materials and accessories at thermofisher.com.

Product availability and pricing might vary according to your region or country. Online ordering through
the Thermo Fisher Scientific website is not available in all countries. Contact your local Thermo Fisher
Scientific representative for help.

Starter kits and other kits

Cat. No. Kit Storage conditions

Starter kits!'!

4469604 | QuantStudio™ 12K Flex OpenArray™ Gene Upon receipt, store the frozen, unopened kits
Expression Starter Kit at -20°C.

4469605 | QuantStudio™ 12K Flex OpenArray™ Genotyping
Starter Kit

Other kits

4469620 | QuantStudio™ 12K Flex OpenArray™ Practice Kit —20°C or ambient temperature

M A QuantStudio™ 12K Flex OpenArray™ Accessories Starter Kit, Part no. 4469586, is included with each experiment starter kit order.
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Appendix A Ordering information

General equipment and reagents for starter kits

General equipment and reagents for starter kits

232

ltem Source
ProFlex™ 2 x Flat PCR System 4484078
Qubit™ 2.0 Fluorometer Q32866
Powder-free gloves MLS
DNase-free, sterile-filtered water MLS
RNase-free water MLS
0.1x TE pH 8.0 MLS
Bleach (10%) MLS
Ethanol MLS
Lint-free wipes MLS
Fine-tip marker MLS
Foil seals MLS
Razor blade MLS
Safety glasses MLS
Tweezers or forceps MLS
Disposable transfer pipettes MLS
Pipettes, P10 to P1000 MLS
Pipette tips, 10 to 1000 pL MLS
Incubator MLS
Centrifuge with plate adaptor MLS
Vortexer MLS
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Appendix A Ordering information
OpenArray™ Plate formats

OpenArray™ Plate formats

Note: A QuantStudio™ 12K Flex OpenArray™ Accessories Kit (Cat. No. 4469576) is included with
10-pack array orders.

OpenArray™ Plate Cat. No. Storage

TagMan™ OpenArray™ Real-Time PCR 4471113 Custom Format 16 Upon receipt, store the frozen,
Plate with Genotyping Assays 4471114 Custom Format 32 unopened plates at —20°C.
4471115 Custom Format 64
4471116 Custom Format 128
4471117 Custom Format 192

4471118 Custom Format 256

TagMan™ OpenArray™ Real-Time PCR 4471119 Custom Format 18
Plate with Gene Expression Assays 4471120 Custom Format 56
4471121 Custom Format 112
4471122 Custom Format 168
4471123 Custom Format 224

TagMan™ OpenArray™ Real-Time PCR 4471124 Format 18

Plate with Inventoried Gene Expression 4471125 Format 56

Assays
4471126 Format 112
4471127 Format 168
4471128 Format 224
TagMan™ OpenArray™ Loading Plate, 4471227

QuantStudio™ 12K Flex

Reagents

Note: For reagent shelf-life expiration date, see the package label.

Use the following reagents with the QuantStudio™ 12K Flex Real-Time PCR System.

QuantStudio™ 12K Flex reagent Source

TagMan™ OpenArray™ Real-Time PCR Master Mix 5mL 4462164
1.5mL 4462159

TagMan™ OpenArray™ Genotyping Master Mix 1 x 5.0 mL for 10 arrays 4404846
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Consumables (accessories)

Consumables (accessories)

Note: For consumable shelf-life expiration date, see the package label.

Use the following consumables with the QuantStudio™ 12K Flex Real-Time PCR System.

QuantStudio™ 12K Flex consumable Part number
OpenArray™ AccuFill™ System Tips Box of 384 4457246
10 boxes of 384 4458107
OpenArray™ 384-well Sample Plate 10 plates 4406947
OpenArray™ 384-Well Sample Plates, Barcoded 10 plates 4453929
OpenArray™ 384-Well Plate Seals 10 seals 4469876

234 QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide


https://www.thermofisher.com/order/catalog/product/4457246
https://www.thermofisher.com/order/catalog/product/4458107
https://www.thermofisher.com/order/catalog/product/4406947
https://www.thermofisher.com/order/catalog/product/4453929

Plate information

MicroAmp™ Optical 96-Well Reaction Plate . ..............oiiiiiii i 235
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IMPORTANT! Be sure to track where the samples are in each sample plate. For each sample plate, we

recommend creating a sample information file (CSV) in the OpenArray™ Sample Tracker Software.

MicroAmp™ Optical 96-Well Reaction Plate

The MicroAmp™ Optical 96-Well Reaction Plate is a 96-well reaction plate for thermocycling. The
96-well reaction plates are used for nucleic acid sample preparation and to transfer the nucleic acid
samples to an OpenArray™ 384-well Sample Plate.

A non-optical 96-well reaction plate can also be used.
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Appendix B Plate information
OpenArray™ 384-well Sample Plate

OpenArray™ 384-well Sample Plate

The OpenArray™ 384-well Sample Plate is divided into eight areas. Each area is 12 wells x 4 wells (48
wells). During each load, the QuantStudio™ 12K Flex OpenArray™ AccuFill™ System transfers samples
from one area of the OpenArray™ 384-well Sample Plate to a single OpenArray™ Plate (see “OpenArray™
Plate” on page 236).

Plate Area 4 (detail)
Columns 13-24

Columns 1-12 Columns 13-24

/A 2 4 ] B 10 12 14 18 1B 20 2 ) %%%SEESEE%ES
SEPEWE S Plate area 1 - Plate area 2 Rows E-H S SR DD LD OO
» Oooooooooooo
ST N Plate area 3| Plate area 4 |
VIR . Platearea Plate area 6
SNV EN « Platearea 7 Plate area 8
N

IMPORTANT! The way that you set up the 384-well sample plates depends on the format of the
OpenArray™ Plate that you will be transferring the samples to. For more information on each format,
see “Available plate formats for gene expression experiments” on page 238, “Available formats for
genotyping experiments” on page 240, and “Panels for microRNA profiling experiments” on page 245.

OpenArray™ Plate

An OpenArray™ Plate is a 63-mm x 19-mm mid-density reaction plate. There are 3072 reaction through-
holes in the plate. Individual through-holes can accommodate a 33-nL reaction volume. Hydrophilic and
hydrophobic coatings allow reagents to be held within the through-holes.

As shown in the following figure, the OpenArray™ Plate is divided into 48 subarrays. Each subarray
consists of 64 through-holes. Depending on the OpenArray™ Plate format being used, an entire
subarray is loaded from one or more wells in the QuantStudio™ 12K Flex OpenArray™ AccuFill™ System.
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Appendix B Plate information
OpenArray™ Plate

1 2 3 4 5 6 7 8 9 10 11 12

O

a |O0000000
b 88888888 Each subarray has
c
O0000000 holes.
f 00000000 .
g\ | 0000 OO+ For example, this
h \OOOOOOO0O is A1g7.
12345678

Available OpenArray™ Plate formats

Each through-hole in an OpenArray™ Plate contains a single assay. The number of assays in the
OpenArray™ Plate and the number of samples that you can load in the plate depend on the format
that you select. For more information on each format, see “Available plate formats for gene expression
experiments” on page 238, “Available formats for genotyping experiments” on page 240, and “Panels
for microRNA profiling experiments” on page 245.

Include no template controls

We strongly recommend that you include at least one no template control (NTC) for each OpenArray™
Plate, especially when preparing plates for genotyping experiments. NTCs serve as negative controls,
and are also useful in data analysis. When adding NTCs to the 96-well sample plate, place one NTC
in each section of the sample plate to ensure that the NTCs are plated in the correct location in the
OpenArray™ Plate. Also follow this procedure for any positive controls, for example, CEPH DNA.
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OpenArray™ Plate formats for gene expression experiments

OpenArray™ Plate formats for gene expression experiments

Available plate formats for gene expression experiments

The table provides a list of OpenArray™ Plate formats that are available for use in gene expression

experiments.
OpenArray™ Plate format Part no. No. of preloaded assays Maximum no. of samples
Format 18 4471124 18 (in triplicate) 48
Format 56 4471125 56 48
Format 112 4471126 112 24
Format 168 4471127 168 16
Format 224 4471128 224 12

Recommended arrangements

When loading the 384-well sample plate for gene expression experiments, we recommend the following
arrangements.

OpenArray™ Plate Recommended loading

Format 18 and Format 56 | Load samples 1 to 48 in one area of the sample plate.

Sample plate

Phlem1 ' Plate arca 2
| S———
4 —
| f—
v

=

~—

Sample 1
Sample 48

(P T T[T T T TTTT]
HEEEEEEEEEER
HAEEEEEEEEEE
EEEEEEEEEE

OpenArray plate

Subarray A1

Subarray D12
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(continued)

Appendix B Plate information
OpenArray™ Plate formats for gene expression experiments

OpenArray™ Plate

Recommended loading

Format 112

Load samples 1 to 24 in one area of the sample plate, in duplicate.

Sample plate

SRS EETER Y Plate area 2
’ [ St
U —
Yate area 4

-

’ e area 6

[u—

[
. \asa &
[
N
3 0
\

Sample 1
— Sample 24

Subarray A1

Subarray B1

Subarray C12

OpenArray plate Subarray D12

Format 168

Load samples 1 to 16 in one area of the sample plate, in triplicate.

Sample plate

Plateana1  Plate area 2
L
R

=

Subarray A1 Subarray A2 Subarray A3

Sample 1 Sample 1
{copy 1) (copy 2}
N

Sample 16

OpenArray plate

AN
Samplo 16 | Sample 16 | Sample 16
{copy 1) {copy 2)

Subarray D10 Subarray D11 Subarray D12
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OpenArray™ plates for genotyping experiments

(continued)

OpenArray™ Plate

Recommended loading

Format 224

Load samples 1 to 12 in one area of the sample plate, in quadruplicate.

Subarray Al

Subarray B1

Subarray C1

Subarray D1

Sampie 1
(copy 1)

SBampie 1

Sample plate

" Plate area 1 |‘Phhalnl2

e

G

I
]
i’
t

late area 4
L——
e area &

[
v

1area 8
pu——
Do

;
: \

Subarray A12

Subarray B12

Subarray C12

- HEEEEEEEE

Sai 1 e 12

=+ | [ HHEEEEEEEEN 2 ... o
ol | | [ [ [ | [ [ ]| |

L

EEEEEEEEEN |

OpenArray plate

OpenArray™ plates for genotyping experiments

Available formats for genotyping experiments

The table provides a list OpenArray™ genotyping plate formats that are available for use in real-time

genotyping experiments.

OpenArray™ Plate Part no. No. of preloaded assays Maximum no. of samples
Format 16 4471113 16 144
Format 32 4471114 32 96
Format 64 4471115 64 48
Format 128 4471116 128 24
Format 192 4471117 192 16
Format 256 4471118 256 12

240
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Appendix B Plate information
OpenArray™ plates for genotyping experiments

Recommended arrangements

When loading the 384-well sample plate for genotyping experiments, we recommend the following

arrangements.
OpenArray™ Plate Recommended loading
Format 16 * For sample load 1, load samples 1 to 48 in one area (section 1) of the sample plate.
* For sample load 2, load samples 49 to 96 in one area (section 2) of the sample
plate.
* For sample load 3, load samples 97 to 144 in one area (section 3) of the sample
plate.
Sample 1 Sample 49

Iilllllllll-
0 o

Sample 9%

O0rICTEmE

[m| O
[m| od
od |
-a0ac EIEILILIIJEJULIEIFJEIEIEIEIEI
= 1000000 00000000000000000
- 000000 0000000C0000000000
« 000000 00000000C000000000
-000000000000000000000000
= 000000000 00000000000000
- LOO0O0OO00O0000000000GOO00000
8 5, J

| [T
1 I
1 Sample 144
Loadl Load 3 Load 2
Sample 1
Subarray Al e 4
[elelolete] i I

Sample 97

OpenArray Plate
Subarray D12
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OpenArray™ plates for genotyping experiments

(continued)
OpenArray™ Plate Recommended loading
Format 32 * For sample load 1, load samples 1 to 48 in one area (section 1) of the sample plate.

* For sample load 2, load samples 49 to 96 in one area (section 2) of the sample
plate.

Sample Plate

Sampie 49

Sample 08

Subarray A1

OpenArray Plate

Sample 48
! Subamay D12
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Appendix B Plate information

rEww

OpenArray™ plates for genotyping experiments

OpenArray™ Plate

Recommended loading

Format 64

Load samples 1 to 48 in one area of the sample plate.

Sample plate

yﬂ_ * Plate area 2
| ER——
J [
’

Aate arca 4
[ —

tearca 6
[u—

4
rarea B
[a—

DO

i
i
f
b
r
I A
Sample 1
Sample 48

N

Subarray A1 ‘ Cobogh '

N~—

AIEEEEEEEEEE
EEEEEEEEEEEE
EEEEEEEEEEER
EEEEEEEEREE

OpenArray plate

Subarray D12

Format 128

Load samples 1 to 24 in one area of the sample plate, in duplicate.

Sample plate

Subarray A1

Subarray B1

OpenArray plate

Subarray C12

Subarray D12
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Appendix B Plate information
OpenArray™ plates for genotyping experiments

(continued)

OpenArray™ Plate

Recommended loading

Subarray C1

Subarray D1

Format 192 Load samples 1 to 16 in one area of the sample plate, in triplicate.
Sample plate

e ()
"' |
Plate area 3 Hate area 4
B L SE—
i Plate are: - tearsa b

L L
?J Plate are: P 'kms
i ¥

Subarray A1 Subarray A2 Subarray A3
Sample 16
Sample 1 Bample 1 Sample 1
{copy 1) (copy 2)
AN
AN
OpenArray plate
Sample 16 | Sample16 | Sample 16
{copy 1) (copy 2)
Subarray D10 Subarray D11 Subarray D12
Format 256 Load samples 1 to 12 in one area of the sample plate, in quadruplicate.

Sample plate

4

§y Plate area i \\Pﬂnmz
o are

Subarray A1 Subarray A12

Subarray B1 Subarray B12

Sample 1
(copy 1)
Sample 1
(copy 2)

Sample 1

Sample 12
feopy 1)
Sample 12
{copy 2)

Sample 12
{copy 3)

Subarray C12

Subarray D12

OpenArray plate
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Custom miRNA OpenArray™ panels

Custom miRNA OpenArray™ panels

Panels for microRNA profiling experiments

Panels for microRNA profiling are ordered as custom miRNA OpenArray™ panels.

Recommended arrangements

When loading the 384-well sample plate for microRNA experiments, we recommend the following

arrangements.

OpenArray™ Plate

Recommended loading

Format 18 and Format 56

Load samples 1 to 48 in one area of the sample plate.

Sample plate

Subarray A1 ‘ b ’

~—

P T T T T T T 11T
HEEEEEEEEEER
HEEEEEEEEEEN
([ [ [ [ [ [ [ [ ][

OpenArray plate

Subarray D12

Format 112

Load samples 1 to 24 in one area of the sample plate, in duplicate.

Sample plate

Subarray A1

Subarray B1

Subarray C12

OpenArray plate Subarray D12
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(continued)

OpenArray™ Plate

Recommended loading

Format 168

Load samples 1 to 16 in one area of the sample plate, in triplicate.

Sample plate

Platem1 ' Plate area 2
] Lt
T

=

o
{H
[

Subarray A1

Subarray A2

Subarray A3

Sample 16

OpenArray plate

N
Sample 16 | Sample 16 | Sample 16
{copy 1) (copy 2)

Subarray D10 Subarray D11

Subarray D12

Format 224

Load samples 1 to 12 in one area of the sample plate, in quadruplicate.

Sample plate

o
g —
Tlate area 4
/ e
! Mo area 6
P 2 areas N
:
—
’ D
Subarray A1 Bamglo 1 a . Subarray A12
s M e
Sampio 1 Samplo 12
Subarray B1 Subarray B12
Sampio 1 Samplo 12
Subarray C1 Subarray C12
Sample 1
Subarray D1 {copy 3) fcopy 3) Subarray D12

OpenArray plate
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PCR good laboratory practices

Follow good laboratory practices when preparing samples for PCR amplification.

Wear a clean lab coat (not previously worn while handling amplified PCR products or used during
sample preparation) and clean gloves.

Change gloves whenever you suspect that they are contaminated.
Maintain separate areas and dedicated equipment and supplies for these activities.
— Sample preparation
— PCR setup
— PCR ampilification
— Analysis of PCR products
Never bring amplified PCR products into the PCR setup area.
Open and close all sample tubes carefully. Try not to splash or spray PCR samples.
Keep reactions and components capped as much as possible.
Use a positive-displacement pipette or aerosol-resistant pipette tips.
Clean laboratory benches and equipment periodically with 10% bleach solution.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.

248 QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide


http://thermofisher.com/support

Appendix D Safety
Chemical safety

Chemical safety

/W\. WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
&~ read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with

sufficient ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer

cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

AVERTISSEMENT ! PRECAUTIONS GENERALES EN CAS DE MANIPULATION DE PRODUITS
CHIMIQUES. Pour minimiser les risques, veiller a ce que le personnel du laboratoire lise attentive-
ment et mette en ceuvre les consignes de sécurité générales relatives a I'utilisation et au stockage
des produits chimiques et a la gestion des déchets qui en découlent, décrites ci-dessous. Consulter
également la FDS appropriée pour connaitre les précautions et instructions particulieres a respecter :

. Lire et comprendre les fiches de données de sécurité (FDS) fournies par le fabricant avant de
stocker, de manipuler ou d’utiliser les matériaux dangereux ou les produits chimiques. Pour obtenir
les FDS, se reporter a la section « Documentation et support » du présent document.

. Limiter les contacts avec les produits chimiques. Porter des équipements de protection appropriés
lors de la manipulation des produits chimiques (par exemple : lunettes de slreté, gants ou véte-
ments de protection).

. Limiter I'inhalation des produits chimiques. Ne pas laisser les récipients de produits chimiques
ouverts. lls ne doivent étre utilisés qu’avec une ventilation adéquate (par exemple, sorbonne).

. Vérifier régulierement I’absence de fuite ou d’écoulement des produits chimiques. En cas de fuite
ou d’écoulement d’un produit, respecter les directives de nettoyage du fabricant recommandées
dans la FDS.

. Manipuler les déchets chimiques dans une sorbonne.
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Biological hazard safety

. Veiller a utiliser des récipients a déchets primaire et secondaire. (Le récipient primaire contient les
déchets immédiats, le récipient secondaire contient les fuites et les écoulements du récipient pri-
maire. Les deux récipients doivent étre compatibles avec les matériaux mis au rebut et conformes
aux exigences locales, nationales et communautaires en matiére de confinement des récipients.)

. Une fois le récipient a déchets vidé, il doit étre refermé hermétiquement avec le couvercle fourni.

. Caractériser (par une analyse si nécessaire) les déchets générés par les applications, les réactifs et
les substrats particuliers utilisés dans le laboratoire.

. Vérifier que les déchets sont convenablement stockés, transférés, transportés et éliminés en res-
pectant toutes les réglementations locales, nationales et/ou communautaires en vigueur.

. IMPORTANT ! Les matériaux représentant un danger biologique ou radioactif exigent parfois une
manipulation spéciale, et des limitations peuvent s’appliquer a leur élimination.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.

Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2020-P.pdf

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
www.who.int/publications/i/item/9789240011311
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Documentation and support

Related documentation

Document Pub. No.

QuantStudio™ 12K Flex Real-Time PCR System v1.6 or later Maintenance and Administration Guide | MAN0O18832

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Plate Quick Reference 4478673

QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User Guide MANO0025669

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers
* Product support information
- Product FAQs
- Software, patches, and updates
— Training for many applications and instruments
® Order and web support
* Product documentation
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at
www.thermofisher.com/support.
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